END USER LICENCE AGREEMENT

You should carefully read the following terms and conditions. You will accept them by opening the license agreement folder. You should return the complete software package including the media, the license agreement, the user manuals, and any associated documentation intact to your supplier within seven days of receipt if you do not agree with these terms and conditions. Your supplier will credit the license fee charged to or paid by you.

The media, the license agreement, the user manuals, and any associated documentation as well as any and all derivatives thereof (the “Software”) is supplied under license from Uniplex Software, Inc., 715 Sutter St., Folsom, California 95630 (“Uniplex”) or a Uniplex distributor, dealer, reseller, or other supplier (“Supplier”) upon the following terms which you will be deemed to have accepted upon opening the license agreement folder.

All copyrights and other intellectual property rights in the Software are owned absolutely by Uniplex or authorized licensors to Uniplex. You may not load the Software onto a computer or use the Software in any manner without the express license of Uniplex or your Supplier on the terms set out below. You are granted a non-exclusive, non-transferable license to use the Software on these conditions in consideration of the license fee:

- To use the Software on the single computer under your control for which the Software was licensed and within the user limitations established by the Uniplex license key accompanying this Agreement.
- To make one copy of the Software (not including the user manuals and associated documentation) solely for security backup purposes, provided that you reproduce all copyright notices, trademarks, legends, and logos on the backup copy and maintain an accurate record of its location.

CONDITIONS OF USE: The Software is copyrighted by Uniplex and authorized licensors to Uniplex. You may not:

- Use the Software or any part of it on a computer of a type or for an additional number of users other than that for which the Software was licensed.
- Make copies of the Software except one copy for security back-up purposes in accordance with this Agreement.
- Make copies of the Software user manuals or any associated documentation.
- Loan, rent, assign, lease, sublicense, transfer, or otherwise provide, electronically or otherwise, the Software or any copy or part of it to anyone else.
- Remove any copyright notice, trademark, legend, logo, or product identification from the Software or the backup copy.
- Reverse engineer, disassemble, reverse translate, or in any way attempt to derive the source code or perform any act that is not expressly permitted by a law made pursuant to the European Council Directive on the Legal Protection of Computer Programs and then only if indispensable to achieve the interoperability of an independently-created program and only after first contacting Uniplex and being advised that the required information is not available.

TERM: This Agreement is effective when you open the license agreement folder which contains the key number and the activation directions to enable full operation of the Software. The license granted under this Agreement shall terminate automatically if you are in breach of or fail to comply with any term or condition herein. You must destroy all copies of the Software, completely discontinue use of the Software from all systems, and certify to Uniplex or to your Supplier that they have been so destroyed upon such termination. You will not be entitled to any refund of money or other consideration paid by you.

LIMITED 90 DAY WARRANTY. Your Supplier will replace any defective media free of charge for a period of 90 days from the date on which you receive the Software. You must notify the Supplier of any material physical defect in the media on which the Software is recorded as soon as you discover the defect. This replacement will only be provided if you have returned the license activation form and if you return the defective media post paid to your Supplier stating your name and address and enclosing proof of your license such as an invoice copy. This is your sole remedy in the event of a media defect. This warranty shall not apply in the event that the Software media is lost or stolen or has been damaged by accident, misuse, neglect, or unauthorized use or modification.

LIABILITY. Uniplex, authorized licensors to Uniplex, and your Suppliers make no representations or warranties, whether express or implied (by statute or otherwise), relating to the performance, quality, merchantability, or fitness for a particular purpose of the Software or otherwise and all such representations or warranties are hereby specifically disclaimed and excluded except as expressly provided above for media.

You alone are able to determine whether the Software will meet your requirements. The entire risk as to its performance is with you and, except to the extent provided in the warranty section above, should the Software prove defective, you alone must assume the entire cost of all necessary servicing, repair, or correction and any incidental or consequential damages. Uniplex, authorized licensors to Uniplex, or your Suppliers will in no event be liable for direct, indirect, special, incidental, or consequential damages (including loss of profits or business) resulting from any defect and/or use of the Software, even if Uniplex or any such entity has been advised of the possibility of such damage, whether due to Uniplex’s or to any such entity’s negligence, breach of contract, misrepresentation, or otherwise.

Notwithstanding the above, if there should arise any liability on the part of Uniplex or any such entity, by reason of the licensing or use of the Software or otherwise, whether due to Uniplex’s or to any such entity’s negligence, breach of contract, misrepresentation, or otherwise, such liability shall be of no force or effect unless in writing and signed by an authorized manager of Uniplex.

You shall indemnify Uniplex, authorized licensors to Uniplex, and your Suppliers against all claims by third parties (other than claims alleging breach by the Software, as supplied, of a third party’s copyright, patent, or other intellectual property rights) arising from possession or use of the Software by you or by anyone using it with your consent.

UPDATE POLICY. Uniplex or your Supplier may at their sole discretion advise you of and license your use of Software updates and new releases at the current prices for such Software updates and new releases. You must complete and return the license activation form to Uniplex to be advised of such updates and new releases. Any such updates and new releases will be licensed subject to the terms and conditions of this Agreement or of a new agreement provided by Uniplex or by your Supplier.

GENERAL: This Agreement shall be governed by and interpreted in accordance with the laws, other than those of laws rules, of the State of California, United States of America.

You acknowledge that you have read this Agreement, agree to be bound by its terms and conditions, and agree that it is the complete and exclusive statement of the agreement between you and Uniplex which supersedes any previous proposal or agreement, whether oral or written, relating to the subject matter of this Agreement, by opening the license agreement folder.

Any representations, modifications, or amendments to this Agreement shall be of no force or effect unless in writing and signed by an authorized manager of Uniplex.

Either party’s failure or delay in enforcing any provision hereof will not waive that party’s rights.

The remainder of this Agreement shall remain valid and enforceable according to its terms if any provision of this Agreement is found invalid or unenforceable pursuant to any judicial decree or otherwise.

Uniplex may assign or transfer its rights and obligations under this Agreement without your prior consent. You may not transfer your rights under this Agreement to another party without prior consent in writing and signed by an authorized manager of Uniplex.

The Informix products contained in this Uniplex product are licensed for use only with the Uniplex product.

U.S. Government Restricted Rights Notice

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software Clause at DFARS 252.227-7013. Uniplex Software, Inc., 715 Sutter St., Folsom, California 95630.

rev. 07/20/99
Copyright Notices

Copyright © 1981-1999 Uniplex Software, Inc. Unpublished. All rights reserved. Software provided pursuant to license. Use, copy, and disclosure restricted by license agreement.

IXI Deskterm copyright © 1988-1993 The Santa Cruz Operation, Inc. Word for Word copyright © 1986-1998 Inso Corporation. All rights reserved. Multi-lingual spelling verification and correction program and dictionaries copyright © 1984-1997 Soft-Art, Inc. All rights reserved. Portions derived from the mimelite library written by Gisle Hannmyr (gisle@oslonett.no) and used with permission. Portion copyright © 1981-1993 Informix Software, Inc.


Restricted Rights Legend

Use, duplication, or disclosure by the U.S. Government or other government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the rights in Technical Data and Computer Software clause at DFARS 252.227-7013. Uniplex Software, Inc., 715 Sutter Street, Folsom, California 95630. Computer software and related documentation shall not be delivered to any branch, office, department, agency, or other component of the U.S. Government unless accompanied by this Restricted Rights Legend or alternatively, unless licensed expressly to the U.S. Government pursuant to FAR 52.227-19, unpublished—rights reserved under U.S. copyright laws.

Notice

The information in this document is subject to change without notice. Uniplex Software, Inc. makes no warranty of any kind in regard to the contents of this document, including, but not limited to, any implied warranties of merchantability or fitness for a particular purpose. Uniplex Software, Inc. shall not be liable for errors in this document or for incidental or consequential damages in connection with the furnishing, performance, or use of it.
Use This Information When Reordering

Software : 9.00  
Language Version : American/British English  
Operating System : Unix  
Product Name : IIP Plus User Guide  
Product Code : D900IIPGD

Additional Information

Document Revision : 3.2 (mxw) February 27, 2000  
WWW Version : IIPlus-1V900-P.pdf (vol 1 - print)  
IIPlus-1V900-V.pdf (vol 1 - view)

On-line versions of all Uniplex documentation are available on our Web site as PDF files for viewing/printing at:

http://www.uniplex.com/ubs/documentation.htm

Check the on-line versions for unpublished updates and corrections. Please e-mail us if you have any comments or corrections regarding Uniplex documentation:

documentation@uniplex.com

stating the Product Code and the Document Revision shown above.

Licensing Notice

An end-user license and unique license key must accompany each copy of Uniplex software. The Uniplex software you are using may be pirated if you have not received an end-user license and an official Uniplex license key package. Uniplex Software will prosecute any company or individual found to be improperly using Uniplex software.
The five volume Uniplex V9 user guide set supersedes the V8.00 user guides plus the V8.10 User Guide Supplement. Additional supplementary and technical documentation is provided on-line with the software. The printed manuals include:

<table>
<thead>
<tr>
<th>Guide Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume 1</td>
<td></td>
</tr>
<tr>
<td>Volume 2</td>
<td></td>
</tr>
<tr>
<td>Uniplex II Plus User Guide</td>
<td>Database Forms, Database Query, Key Recorder, integration, menu maps, desk maps, ring menus, glossary, and topic index.</td>
</tr>
<tr>
<td>Volume 3</td>
<td></td>
</tr>
</tbody>
</table>
ABOUT THIS GUIDE

About this Guide

Version Information

Some of the material in these guides will not apply to users of Uniplex releases prior to V9.00. Please contact your Uniplex supplier or Uniplex directly for information about upgrading to the current release. Users upgrading from V8.00 or earlier should consult the File Manager chapter for information about a new method for carrying out all folder and file-related operations.

Useful Shortcut Keys

These shortcut keystrokes can be used throughout Uniplex:

<table>
<thead>
<tr>
<th>Cut and Paste</th>
<th>Insert</th>
<th>Quick Movements</th>
<th>External Windows</th>
<th>Format Paragraph</th>
<th>Hard Return</th>
<th>Help</th>
<th>F1...F9</th>
<th>F11...F19</th>
</tr>
</thead>
<tbody>
<tr>
<td>mark top left</td>
<td>Esc (</td>
<td>Ctrl t</td>
<td>F9 or Esc xd</td>
<td>Ctrl fp</td>
<td>Esc Return</td>
<td>Esc h</td>
<td>Esc 1...9</td>
<td>Esc Esc 1...9</td>
</tr>
<tr>
<td>mark lower right</td>
<td>Esc )</td>
<td></td>
<td>F12 or Esc xu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>paste insert</td>
<td>Esc 'l</td>
<td></td>
<td>Esc xs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>paste overlay</td>
<td>Esc 'o</td>
<td></td>
<td>Esc xp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Ctrl x</td>
<td>top of screen/list</td>
<td>Esc Ctrl t</td>
<td>save and continue</td>
<td>Esc Return</td>
<td>Esc f</td>
<td></td>
<td></td>
</tr>
<tr>
<td>line/row</td>
<td>Ctrl w</td>
<td>next screen/page</td>
<td></td>
<td>save and exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>work/cell</td>
<td>Ctrl c</td>
<td>previous screen/page</td>
<td></td>
<td>save to new file</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>character</td>
<td></td>
<td>start of line</td>
<td></td>
<td>Esc w</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td>end of line</td>
<td></td>
<td>save</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td></td>
<td></td>
<td>to new file</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>External Windows</td>
<td></td>
<td></td>
<td></td>
<td>Esc sx</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>access Desk popup</td>
<td>F9 or Esc xd</td>
<td></td>
<td>F12 or Esc xu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>access Utility popup</td>
<td>Esc xs</td>
<td></td>
<td>Esc xp</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>switch processes</td>
<td>Esc f</td>
<td>save and continue</td>
<td>Esc w</td>
<td>save</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>list processes</td>
<td></td>
<td>save and exit</td>
<td>Esc e</td>
<td>exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

F10 | Esc 0
F20 (X/Open prefix) | Esc Esc 0
The Uniplex User Guide Set

Uniplex II Plus User Guide
Volume 1
Introduction
Chapter 1: Getting to Know Uniplex
Chapter 2: Filing Your Work
Chapter 3: Word Processor
Chapter 4: Sketch Pad

Volume 2
Chapter 5: File Manager
Chapter 6: Printing
Chapter 7: Spreadsheet

Volume 3
Chapter 8: Database Forms
Chapter 9: Database Query
Chapter 10: Key Recorder
Chapter 11: Integration
Appendix A: Menu Maps
Appendix B: Desk Maps
Appendix C: Word Processor Ring Menus
Appendix D: Spreadsheet Ring Menus
Glossary
Topic Index
About this Guide

Advanced Office System User Guide

Volume 4

Chapter 1: Electronic Mail
Chapter 2: Time Manager
Chapter 3: Card Index
Chapter 4: Personal Organizer
Chapter 5: Report Writer
Chapter 6: Formfill
Chapter 7: Printing
Chapter 8: Integration
Appendix A: Menu Maps
Appendix B: Desk Maps

Glossary
Topic Index

Advanced Graphics System User Guide

Volume 5

Chapter 1: Presentation Graphics
Chapter 2: Presentation Editor
Chapter 3: Printing
Chapter 4: Integration
Appendix A: Menu Maps
Appendix B: Desk Maps
Appendix C: Integrating Clip Art

Glossary
Topic Index
# TABLE OF CONTENTS

## Volume One

### Introduction

### Chapter 1 - Getting to Know Uniplex

- Overview ................................................................. 1-1
- Menus ................................................................. 1-5
- Forms ................................................................. 1-12
- Softkeys ........................................................... 1-14
- Uniplex Applications ........................................ 1-19
- Common Commands ........................................ 1-20
- General Utilities .............................................. 1-21
- Help ................................................................. 1-22
- Uniplex Windows ............................................ 1-23
- Index ................................................................. 1-29

### Chapter 2 - Filing your Work

- Overview ................................................................. 2-1
- Create a New Document or File ................................ 2-2
- Folders ................................................................. 2-4
- Index ................................................................. 2-9

### Chapter 3 - Word Processor

- Overview ................................................................. 3-1
  - Access the Word Processor ........................................ 3-4
  - Help ................................................................. 3-6
- Worked Example .................................................. 3-9
- Basic Word Processing .......................................... 3-27
  - Create a Document ............................................. 3-29
  - Screen Components .......................................... 3-30
  - Command Menu ............................................. 3-34
  - Edit an Existing Document ............................... 3-36
  - Move the Cursor ............................................. 3-37
  - Enter Text ....................................................... 3-43
  - Insert Text ....................................................... 3-47
  - Delete Text ....................................................... 3-52
  - Undo a Command ............................................ 3-57
  - Redraw the Screen .......................................... 3-57
  - Check Spelling ............................................... 3-58
  - Dictionary Management ................................... 3-70
  - Save and Name a Document ............................ 3-74
  - Printing ......................................................... 3-78
<table>
<thead>
<tr>
<th>TABLE OF CONTENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume One</td>
</tr>
<tr>
<td>--------------------</td>
</tr>
<tr>
<td>Document Preview ................................................. 3-84</td>
</tr>
<tr>
<td>Change Your Work ..................................................... 3-91</td>
</tr>
<tr>
<td>Rulers ................................................................. 3-93</td>
</tr>
<tr>
<td>Convert Case .......................................................... 3-119</td>
</tr>
<tr>
<td>Hard Characters ...................................................... 3-122</td>
</tr>
<tr>
<td>Headers and Footers .................................................. 3-123</td>
</tr>
<tr>
<td>Numbering ............................................................... 3-130</td>
</tr>
<tr>
<td>Change Page Length ................................................... 3-144</td>
</tr>
<tr>
<td>Cut and Paste .......................................................... 3-146</td>
</tr>
<tr>
<td>Merge ..................................................................... 3-155</td>
</tr>
<tr>
<td>Box Drawing ............................................................ 3-159</td>
</tr>
<tr>
<td>Line Drawing ........................................................... 3-164</td>
</tr>
<tr>
<td>Effects ................................................................. 3-166</td>
</tr>
<tr>
<td>Repeat Last Command .................................................. 3-172</td>
</tr>
<tr>
<td>Advanced Word Processing .......................................... 3-175</td>
</tr>
<tr>
<td>Thesaurus .............................................................. 3-177</td>
</tr>
<tr>
<td>Glossaries ............................................................... 3-182</td>
</tr>
<tr>
<td>Search and Replace .................................................... 3-187</td>
</tr>
<tr>
<td>Calculator ............................................................... 3-193</td>
</tr>
<tr>
<td>Footnotes ............................................................... 3-196</td>
</tr>
<tr>
<td>Non-printing Remarks .................................................. 3-205</td>
</tr>
<tr>
<td>Bookmarks .............................................................. 3-207</td>
</tr>
<tr>
<td>Set Line Spacing ....................................................... 3-209</td>
</tr>
<tr>
<td>Keep Lines Together .................................................... 3-212</td>
</tr>
<tr>
<td>Change Ruler Pitch ..................................................... 3-216</td>
</tr>
<tr>
<td>Abandon Global Commands .......................................... 3-218</td>
</tr>
<tr>
<td>Index ................................................................. 3-219</td>
</tr>
<tr>
<td>Table of Contents .......................................................... 3-232</td>
</tr>
<tr>
<td>Clear Current Document .............................................. 3-243</td>
</tr>
<tr>
<td>Browse Non-Uniplex Documents .................................... 3-245</td>
</tr>
<tr>
<td>Import/Export Non-Uniplex Documents ........................... 3-246</td>
</tr>
<tr>
<td>Operating Modes ....................................................... 3-248</td>
</tr>
<tr>
<td>Windows ................................................................. 3-259</td>
</tr>
<tr>
<td>Fonts ................................................................. 3-262</td>
</tr>
<tr>
<td>Mail Merge ............................................................. 3-267</td>
</tr>
<tr>
<td>Index ................................................................. 3-283</td>
</tr>
<tr>
<td>Chapter 4 - Sketch Pad</td>
</tr>
<tr>
<td>Overview ................................................................. 4-1</td>
</tr>
<tr>
<td>Use the Sketch Pad ..................................................... 4-4</td>
</tr>
<tr>
<td>Index n ................................................................. 4-17</td>
</tr>
</tbody>
</table>
Introduction
Introduction

Welcome to Uniplex II Plus!

Uniplex is an *integrated* office system. It combines the three main office tools—Word Processor, Financial Spreadsheet, and Information Database—with innovative features such as Key Recorder and External Windows which let you repeat complex tasks at the touch of a button and switch between applications instantly.

Integration is one of the most important features of Uniplex. Each application provides features and capabilities equal to any standalone product and there is total integration between them, plus complete consistency of commands and operations. You can quickly and simply switch between tasks while using Uniplex.

For example, with Uniplex you can create a financial budget using your Spreadsheet (with no worries about checking the calculation). You can transfer a section of key data from the spreadsheet to a report prepared using the Word Processor. Finally, you can send the report individually to twenty recipients whose full name and address details are retrieved from storage in the Relational Database.

The File Manager lets you find any document or file wherever it is stored in the system. Even if you don’t remember the name you gave the document you can ask Uniplex to search for all the documents created on a particular day or created by a certain individual.

Uniplex can also perform all the usual office chores like filing, typing, scheduling meetings, sending memos, searching for information, and producing financial forecasts.

With Uniplex all of this can be achieved with maximum efficiency and the minimum of duplicated work.
INTRODUCTION

Introduction

Uniplex has been designed so it is easy to learn and easy to use. The same commands are used consistently throughout the product, regardless of which element you are using. The extensive and consistent use of softkeys and ring menus means complex operations can be carried out with one keystroke by following the on-screen prompts.

You can display relevant help at any point while using Uniplex.

Uniplex is a business tool that has been designed for real business use. Although it can be used by one person very efficiently, its real benefits can be seen when used by whole departments or complete organizations. Uniplex links people to information and improves corporate communications at all levels. It is a true multi-user design; the more people using it, the more efficiently the system operates.

The Uniplex Advanced Office System can further expand and enhance the full power of Uniplex. With the Advanced Office System, you gain access to an Electronic Mail system, a sophisticated Time Manager, and a Report Writer, in addition to a wide range of office tools (for example, a calculator and a clock).

If you regularly need to present information to clients or other members of your organization, Uniplex Advanced Graphics System will enable you to make a professional, exciting impact. You can create high-resolution 3D graphics to illustrate sales trends, profits, and so on. You can enhance these graphics using the Presentation Editor to add a variety of text, color, and special effects.
Uniplex II Plus has the following set of applications:

- **Word Processor**

  You can create and edit all types of documents using the Word Processor. There is a comprehensive set of editing commands and print effects. You can draw boxes, work in multi-columns, and automatically create indexes and contents. In addition, there is a spelling corrector and thesaurus.

- **Spreadsheet**

  The spreadsheet provides a powerful range of mathematical, statistical, and financial functions, plus macro programming.

- **Database**

  The database facility provides unlimited capacity for storing and retrieving information. You can either use the friendly forms interface, Database Forms, or the more sophisticated ANSI standard SQL language, Database Query. The database is fully relational.

  You can create your own forms for use with the database using Customized Forms.

- **Filing Information**

  Uniplex provides several features for filing and retrieving documents and files you create. You can attach summary information to a file to help you find it quickly using File Manager.

  The description of selecting files and folders is given numerous times throughout the Uniplex documentation. You should be aware that when you press ↓ to select a file or folder, File Manager opens in the appropriate select mode. Also, when saving a new file from within an application, you can press ↓ to open File Manager in Create File mode.
Introduction

- **Printing**
  
  You can print the documents and files you create with Uniplex on any type of printer, including laser printers with proportionally spaced fonts, to produce professional results.

In addition to this wide range of applications, Uniplex has a number of facilities that provide total integration between the applications:

- **External Windows**
  
  External Windows let you use more than one Uniplex application at the same time. You can switch between applications simply and quickly. You can be working at one task and switch to a different task by pressing a couple of keys.

  It is just as easy to switch back to the original task. This is particularly useful if you want to perform several different Uniplex tasks in succession. In this way, you can save valuable time. In addition, you can keep the context in which you are working. For example, you can retrieve information from the Database while you work in the Word Processor or Spreadsheet.

- **Key Recorder**
  
  Key Recorder lets you record sequences of keystrokes you make and subsequently reuse them. This means you can repetitively perform long or complicated sequences of keystrokes by pressing only a couple of keys. In addition, you can store sequences of commands which perform a common task in a standardized way.
Together with External Windows and Key Recorder, Uniplex provides a totally integrated and consistent approach in the following ways:

- You use the same commands whichever application you are in. For example, you use the same commands to edit a document as you use to edit a spreadsheet.

- You use the same softkeys to perform common tasks in the different applications. For example, you use the same softkey to quit from the Word Processor as you use to quit from Database Forms.

- You can use the cut and paste facility in the same way throughout the product to simply and easily transfer information between applications. For example, you can transfer data from the Database to the Spreadsheet, perform calculations on it, then transfer the results of the calculations to a report created using the Word Processor.
INTRODUCTION

Using this Guide

Purpose of this Guide

The Uniplex User Guide is intended for anyone who wants to use Uniplex II Plus. It contains instructions for those people new to Uniplex and the more experienced Uniplex user.

Organization of each Chapter

Each chapter in this guide is organized as follows:

Table of Contents
The beginning of each chapter contains a detailed table of contents.

Overview
The overview provides an introduction to the purpose and major features of the application.

How to Access the Application
This section provides the instructions to access the application.

Worked Example
The worked example section leads you through a typical session of using the application. It provides detailed instructions for each stage of the session.

Reference
The remainder of each chapter describes the full functionality of the application. The sections are organized into logical task units.

Index
A comprehensive index is included at the end of each chapter.
Organization of the Chapters

The Uniplex II Plus User Guide (Volumes 1-3) is organized into the following chapters:

1. Getting to Know Uniplex
   The basic features of Uniplex. Read this chapter if you are new to Uniplex.

2. Filing Your Work
   Store your work on the system. Read this chapter if you are new to Uniplex.

3. Word Processor
   Use the Word Processor to create and edit all types of documents.

4. Sketch Pad
   Draw simple diagrams.

5. File Manager
   Create, delete, move, and copy files and documents. Attach summary information to enable you to find files and documents easily.

6. Printing
   Print your work in a variety of ways.

7. Spreadsheet
   Use the Spreadsheet.

8. Database Forms
   Use databases with the forms interface.

9. Database Query
   Manipulate databases using the SQL database language.

10. Key Recorder
    Record a series of keystrokes and play them back, enabling you to repeat complex tasks at the touch of a button.

11. Integration
    Use the consistent command structure and integration facilities of Uniplex.

Appendices
Maps of the Uniplex menus, ring menus, and Desk/Utility popups.
## INTRODUCTION

### Using this Guide

#### Conventions Used in this Guide

The following conventions are used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uniplex</td>
<td>Used throughout this guide as an abbreviation of Uniplex II Plus.</td>
</tr>
<tr>
<td>Text Like This</td>
<td>Output from Uniplex as seen on a terminal.</td>
</tr>
<tr>
<td>Text Like This</td>
<td>Enter this text exactly as shown.</td>
</tr>
<tr>
<td>Text Like This</td>
<td>Enter the appropriate parameter in this position in the command line (also shows notes and new terms).</td>
</tr>
<tr>
<td>✝</td>
<td>A short note or additional information.</td>
</tr>
<tr>
<td>Press a Key</td>
<td>Press and release the appropriate key.</td>
</tr>
<tr>
<td>Pick and Point</td>
<td>Move between items with the arrow keys until the required option is highlighted, then press RETURN.</td>
</tr>
<tr>
<td>Press ESC key</td>
<td>Press the ESC key and then press key (i.e., ESC e). Do not press RETURN.</td>
</tr>
<tr>
<td>Press CTRL key</td>
<td>Hold down the CTRL key and press key (i.e., CTRL x). Do not press RETURN.</td>
</tr>
<tr>
<td>Press Fx</td>
<td>Press the appropriate function key.</td>
</tr>
</tbody>
</table>
### Convention | Meaning
--- | ---
[parameter] | An optional expression in a command line or sequence, for example:

```sql
create database [with log in "filename"]
```

The clause within the square brackets is optional, but requires a valid file name between the quotation marks; you can enter:

```sql
create database
```

or

```sql
create database with log in "db.log"
```

... Additional parameters or values can be entered, for example:

```sql
create table tablename (column_name, ...)
```

You can enter more than one column name, separated by commas, for example:

```sql
create table table1 (col1, col2, col3)
```

{param|param} | Shows the list of available options (parameters) in a command, for example:

```sql
grant privilege to {public|user_list}
```

You can enter:

```sql
grant connect to public
```

or

```sql
grant connect to john, karen
```
Chapter 1
Getting to Know Uniplex
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>1-1</td>
</tr>
<tr>
<td>Computers in the Office</td>
<td>1-1</td>
</tr>
<tr>
<td>Use the Terminal</td>
<td>1-1</td>
</tr>
<tr>
<td>Cursor</td>
<td>1-1</td>
</tr>
<tr>
<td>RETURN or ENTER Key</td>
<td>1-1</td>
</tr>
<tr>
<td>Arrow Keys</td>
<td>1-2</td>
</tr>
<tr>
<td>CTRL and ESC Keys</td>
<td>1-2</td>
</tr>
<tr>
<td>Function Keys</td>
<td>1-3</td>
</tr>
<tr>
<td>Access the Computer</td>
<td>1-3</td>
</tr>
<tr>
<td>Start Uniplex</td>
<td>1-4</td>
</tr>
<tr>
<td>Menu Changes</td>
<td>1-5</td>
</tr>
<tr>
<td>Select Options</td>
<td>1-8</td>
</tr>
<tr>
<td>Select File Names</td>
<td>1-9</td>
</tr>
<tr>
<td>Leave a Menu</td>
<td>1-10</td>
</tr>
<tr>
<td>Access Popup Menus</td>
<td>1-10</td>
</tr>
<tr>
<td>Forms</td>
<td>1-12</td>
</tr>
<tr>
<td>Softkeys</td>
<td>1-14</td>
</tr>
<tr>
<td>Home Softkey Menu</td>
<td>1-15</td>
</tr>
<tr>
<td>Move around Softkey Menus</td>
<td>1-16</td>
</tr>
<tr>
<td>Standard Function Keys</td>
<td>1-17</td>
</tr>
<tr>
<td>Uniplex Applications</td>
<td>1-19</td>
</tr>
<tr>
<td>Common Commands</td>
<td>1-20</td>
</tr>
<tr>
<td>General Utilities</td>
<td>1-21</td>
</tr>
<tr>
<td>Help</td>
<td>1-22</td>
</tr>
<tr>
<td>Uniplex Windows</td>
<td>1-23</td>
</tr>
<tr>
<td>Start Uniplex Windows</td>
<td>1-23</td>
</tr>
<tr>
<td>Help</td>
<td>1-25</td>
</tr>
<tr>
<td>Stop Uniplex Windows</td>
<td>1-26</td>
</tr>
<tr>
<td>Index</td>
<td>1-29</td>
</tr>
</tbody>
</table>
Overview

This chapter describes the basic features of Uniplex. It is a good idea to read this chapter before you start to use the product if you are new to computers or to Uniplex. This is an overview of the flexibility, ease-of-use, and sophistication of the system. Read the Introduction for a review of the types of tasks you can perform with Uniplex.

Computers in the Office

A computer can help you with many tasks in the office. An office automation system is a collection of programs that help you carry out your job more efficiently and work with others better.

Use the Terminal

You need to understand how to use your keyboard and terminal before beginning to use Uniplex. Try to identify the following functions on your terminal and keyboard.

Cursor

You will see a small flashing block or underscore on the screen of your terminal. This is known as the cursor. The cursor shows the current position on the screen. You move the cursor using the arrow keys (see below).

RETURN or ENTER Key

The RETURN or ENTER key is normally positioned to the right of the keyboard, beside the character keys. Most such keys are labeled ENTER, but a RETURN key performs the same function. It can be labeled in one of the following ways:

RETURN    RETN    ENTER    CARRIAGE RETURN    CR

When you are instructed to press RETURN, press and release the RETURN key on your terminal.
Overview

◇ Arrow Keys

The arrow keys are normally positioned to the right of the RETURN key, or above the character keys. They are generally labeled with illustrations of the cursor direction they represent:

← Left Arrow Key       Move cursor to the left.

→ Right Arrow Key      Move cursor to the right.

↑ Up Arrow Key         Move cursor up.

↓ Down Arrow Key       Move cursor down.

When you are instructed to use the arrow keys, press and release the arrow key for the direction in which you want to move.

◇ CTRL and ESC Keys

The CTRL and ESC keys are normally positioned outside the main character keys and labeled as follows:

Esc    DO    ESCAPE

Ctrl   CTRL   CONTROL

When you are instructed to press the ESC key together with another key, for example press ESC e, press the Escape key and release it, then press the other key.

When you are instructed to press the CTRL key together with another key, for example press CTRL x, hold down the CTRL key and press the other key at the same time.
Function Keys

These are normally positioned above the main characters and are sometimes labeled F1, F2, and so on. When you are instructed to press a function key, for example press F1, press and release the appropriate function key.

You use the function keys to select options from the softkey menus. See the later section, Softkeys, for more details.

If you do not have any function keys on your keyboard, press ESC and then the corresponding number of the function key. For example, press ESC 1 for F1, ESC 2 for F2, and so on.

Access the Computer

To start to use Uniplex, you need the following:

- **Terminal.** You use a terminal to work with a computer. Make sure you have access to a terminal and that this terminal is set up correctly. See your System Administrator for details.

- **Login.** Before you begin to use Uniplex, you must login to the computer. This means you identify yourself to the computer by entering your user name. The System Administrator sets up user names for everyone who needs access to the computer. Your user name can either be your first or last name or a mixture of both. Sometimes you need a password in addition to your user name to access the computer.

  The computer uses your user name to verify that you are allowed access and allocates the space in which you work. See the chapter, Filing your Work, for details of how you store your work on the computer. See the System Administrator if you are not sure how to login to your system.

When you have made sure your terminal is set up correctly and you have logged in, you are ready to begin to use Uniplex.
overview

start uniplex

Your System Administrator can set up Uniplex in different ways. This can affect the way you start Uniplex. However, the normal way to start using Uniplex is:

- Enter `uniplex` and press RETURN.

Uniplex displays the following:

<table>
<thead>
<tr>
<th>APPLICATIONS</th>
<th>PERSONAL OPTIONS</th>
<th>UTILITIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Word Processor</td>
<td>T - Time Manager</td>
<td>P - Printing</td>
</tr>
<tr>
<td>2 - Spreadsheet</td>
<td>M - Mail</td>
<td>C - Change Folder</td>
</tr>
<tr>
<td>3 - Database Forms</td>
<td>O - Personal Organizer</td>
<td>! - Shell Command</td>
</tr>
<tr>
<td>4 - Database Query</td>
<td>I - Card Index</td>
<td></td>
</tr>
<tr>
<td>5 - Sketchpad</td>
<td></td>
<td>F - File Manager</td>
</tr>
<tr>
<td>6 - Screen Builder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 - Formfill</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 - Report Writer</td>
<td>R - Rapid Menu</td>
<td>H - Help</td>
</tr>
<tr>
<td>9 - Graphics</td>
<td>A - System Admin.</td>
<td>Q - Quit</td>
</tr>
</tbody>
</table>

If the Uniplex Advanced Graphics System is not installed on your computer this menu does not contain the Graphics option. If the Uniplex Advanced Office System is not installed on your computer this menu does not contain the Personal Options, Report Writer, or Formfill.

See the System Administrator for details of how the system is set up if a Uniplex menu does not display.
Menus

Uniplex is a *menu-driven* system. You select the different options, functions, and features of the system from lists on the screen. The lists are called *menus*.

Uniplex menus are organized so that you can easily find the appropriate options. For example, all the Electronic Mail commands and options are grouped together in the Electronic Mail menu; all the Database Forms options are grouped together in the Database Forms menu. Uniplex has five types of menus:

- **Full Screen Menus.** These take up the entire screen and are the usual way of accessing Uniplex applications. The Main menu is a full screen menu. So is the Spreadsheet menu, as shown below:

  ![Spreadsheet Menu](image)

- **Popup Desk Menus.** Popup Desk menus interrupt the current task to access another application. You select these while you are using any Uniplex application and the menu *pops up*, temporarily overwriting part of the screen. You can return to the original task at any time.
Menus

For example, the Utility Popup is shown below:

<table>
<thead>
<tr>
<th>Uniplex UTIL: Page 1 of 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 = List Files</td>
</tr>
<tr>
<td>2 = View Clipboards</td>
</tr>
<tr>
<td>3 = Clock</td>
</tr>
<tr>
<td>4 = File Manager</td>
</tr>
<tr>
<td>5 = Calculator</td>
</tr>
<tr>
<td>6 = Phone &amp; Address list</td>
</tr>
<tr>
<td>7 = Card Index</td>
</tr>
<tr>
<td>8 = Personal Organizer</td>
</tr>
<tr>
<td>9 &gt; Next Page</td>
</tr>
<tr>
<td>0 &gt; Previous Page</td>
</tr>
<tr>
<td>ESC Q to Quit</td>
</tr>
</tbody>
</table>

See the chapter, Integration, for details of using the Popup Desk menus.

- **Ring Menus.** Ring menus list the options you can carry out on a particular screen. Uniplex displays these at the top of the screen. For example:

<table>
<thead>
<tr>
<th>Enter: select find edit print</th>
<th></th>
</tr>
</thead>
</table>
GETTING TO KNOW UNIPLEX

Menus

- Softkey Menus. Softkey Menus list the tasks you can perform using the function keys on the keyboard. They are displayed on the bottom line of the screen (see the section, Softkeys). For example:

```
F1=Enter  F2=Redraw  F4=Quit  F8>More
```

- Drop Down Menus. The File Manager's ring menu is always displayed. Most File Manager actions can be accessed from it. There are four drop down menus (File, View, Applications, and Help), each containing items relating to its title. For example, the File drop down menu:

```
<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Applications</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>New</td>
<td>Actions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>--&gt;</td>
<td>Delete...(Ctrl-X)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rename...</td>
<td>Find</td>
<td>--&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Properties...</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Quit</td>
<td></td>
</tr>
</tbody>
</table>
```

See the File Manager chapter for more details.
Menus

Menu Changes

The Uniplex menus have been updated to remove those options which are now redundant due to the functionality of the new File Manager.

Some File Manager operations may not work as described if there is a local Uniplex menu file that was not upgraded during installation of a new Uniplex release. Ask the System Administrator for advice if this occurs.

The Word Processing menu has changed most significantly. The following illustrates the options that were previously available from this menu and those that are now available.

Previous Word Processing Menu

<table>
<thead>
<tr>
<th>WORD PROCESSOR</th>
<th>GENERAL</th>
<th>UTILITIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Create Document</td>
<td>5 - Delete Document</td>
<td>P - Printing</td>
</tr>
<tr>
<td>2 - Edit Document</td>
<td>6 - Copy Document</td>
<td>L - List Files</td>
</tr>
<tr>
<td>3 - Mailshot</td>
<td>7 - Rename Document</td>
<td>C - Change Folder</td>
</tr>
<tr>
<td>4 - Build Index/TOC</td>
<td></td>
<td>F - File Manager</td>
</tr>
<tr>
<td></td>
<td>E - Easiletter</td>
<td>H - Help</td>
</tr>
<tr>
<td></td>
<td>M - Easimemo</td>
<td>Q - Quit</td>
</tr>
</tbody>
</table>

F1=Enter  F2=Redraw  F4=Quit  F8>More
Current Word Processing Menu

<table>
<thead>
<tr>
<th>APPLICATIONS</th>
<th>UTILITIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 – Create a Document</td>
<td>P – Printing</td>
</tr>
<tr>
<td>2 – Edit a Document</td>
<td>C – Change Folder</td>
</tr>
<tr>
<td>3 – Mailshot</td>
<td>F – File Manager</td>
</tr>
<tr>
<td>4 – Build Index/Contents</td>
<td>D – Dictionary Management</td>
</tr>
<tr>
<td>E – Easiletter</td>
<td>H – Help</td>
</tr>
<tr>
<td>M – Easimemo</td>
<td>Q – Quit</td>
</tr>
</tbody>
</table>

F1=Enter  F2=Redraw  F4=Quit  F8>More

Dictionary Management options are now accessed from the Word Processing menu.

Select Options

You select options from all four types of menus in the same way, using pick and point. To pick and point an option:

1. Move the highlight over the desired option with the arrow keys.

2. Press RETURN when the highlight is in position.

Uniplex invokes the selected option or task.

You can also select options from the full screen menus and popup menus. Type the letter or number displayed to the left of the option.

The option is highlighted and invoked as soon as you type in the number or letter. You do not need to press RETURN. For example, to select the Word Processor from the Main menu, type 1.
Menus

Select File Names

You are prompted to enter the name of the file, folder, or document to be used before carrying out certain tasks. For example, when you select Edit a Document from the Word Processing menu, Uniplex prompts for the name of the file you want to edit.

You can select a filename in the following way in addition to using the pick and point method:

1. Pick and point the required task from a Uniplex menu.

   Uniplex prompts for a folder, file, or document name.

2. Press the down arrow to invoke the File Manager which will display a list of the items in the current folder.

3. Type the initial letter of the desired item.

   The first item beginning with that letter is highlighted.

4. Press RETURN while the item is highlighted.

   The task related to the item selected is performed.

Leave a Menu

There are two ways of leaving a menu:

- Pick and point the Quit option on the menu.

- Press ESC q
Access Popup Menus

You can access Popup Desk menus while you are working on any Uniplex task. The menu appears on the screen, temporarily overwriting a portion of the current screen display and lets you access another application (for example, a calendar or calculator). You can easily return to the original task.

Uniplex has two different desk popups; Uniplex Desk and Desk Utilities. Uniplex Desk lets you access other Uniplex applications while you are in a different application. For example, you can access the database while you are working in the spreadsheet. The Desk Utilities menu groups together a selection of tools which you can use to help you in your work. For example, you can access a calculator, or list the documents you have in your current folder.

To access Uniplex Desk:

1. Press F9 or ESC xd from any Uniplex application.
2. Pick and point the desired option from the popup.

To access Uniplex Utilities:

1. Press F12 or ESC xu from any Uniplex application.
2. Pick and point the desired option from the menu.

You can use External Windows to move quickly between different applications. See the Integration chapter for details.
GETTING TO KNOW UNIPLEX

Forms

Many of the tasks you perform with Uniplex require specific instructions. For example, when you select the Print Using Form option, Uniplex prompts for the printer and print style to use. You indicate your choice through a series of pre-defined forms. For example, if you select Print Using Form, Uniplex displays the following:

<table>
<thead>
<tr>
<th>Name of Document</th>
<th>[chapter1.1___________]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer</td>
<td>[EPSON LASER___________]</td>
</tr>
<tr>
<td>Style</td>
<td>[Quality_______________]</td>
</tr>
<tr>
<td>Print from Page Number</td>
<td>[1_____] to [9999_]</td>
</tr>
<tr>
<td>Number of Copies</td>
<td>[1___]</td>
</tr>
<tr>
<td>Left hand margin indent</td>
<td>[0___]</td>
</tr>
</tbody>
</table>

Uniplex presents a prompt and a space for the input, know as a field, for each piece of information required. Uniplex carries out the related task using the information specified in these fields. You use the arrow keys to move from field-to-field on any form. There are three types of field:

- **Fixed Field.** A fixed field is automatically completed by Uniplex. For example, some forms display the created and revised dates of the file. You cannot change a fixed field.

- **Blank Field.** A blank field usually indicates that the information you enter will vary each time the form is displayed. Use the alphanumeric keys to enter your requirements. You can also use any of the standard editing keys, for example, the delete key.
o **Default Field.** Default fields are defined either by Uniplex or have been redefined by the System Administrator to suit your specific needs. There are two types of default field:

- **Input Field.** This type of field allows you to change the default entry by typing over the current option. For example, typing over the document name in the Edit a Document form.

- **Expandable Field.** An expandable field allows you to change from the default to another pre-defined entry. To select another option instead of the default, either:

  Use the SPACEBAR to scroll the display of a field to the one you require.

  or

  Press any key to display a pick and point list of the available options in each field.

Use the methods described previously to complete the form. Use the arrow keys to move from field-to-field. Some forms contain more than one screen of optional instructions. This is indicated by a message at the bottom of the current screen.

Press **ESC e** to confirm the details when the form is complete. The input is accepted and the desired action proceeds. The next time you re-display a form, all default entries are restored.
Softkeys

A series of keystrokes is needed to carry out many Uniplex tasks. For example, to cut some text from a document there are several steps to complete and each of these requires different keystroke sequences. Uniplex has a simple way of using its different functions without the need to remember the exact keystrokes or command sequences. These are known as the softkeys. They are always displayed on the bottom line of the screen. For example:

- F1 = Edit
- F2 = Name
- F3 = Abs
- F4 = Quit
- F5 = Goto
- F6 = Window
- F7 = Macro
- F8 = Calc

To select an option from a softkey menu, press the function key that corresponds to the number on the menu. Function keys are special keys on the keyboard. Generally, they are labeled F1, F2, and so on, and are often found at the top of the keyboard. Ask the System Administrator if you cannot find the function keys on your keyboard. The softkey options on the menu are made up of three parts:

<table>
<thead>
<tr>
<th>function key number</th>
<th>pointer</th>
<th>task name</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td></td>
<td>Edit</td>
</tr>
</tbody>
</table>

For example: F1 = Edit
where each of these parts means the following:

- **Function Key Number.** The name of the key on the keyboard you must press to use the function.
  
  For example: F1 or F2

- **Pointer.** Indicates what type of softkey it is:
  
  > This softkey takes you to another softkey menu.
  
  = This softkey carries out a task.

- **Task Name.** Name of the task the softkey carries out.
  
  For example: FILE or EFFECTS

For example:

- **F3> Edit**

  Uniplex displays the Edit softkey menu if you press Function Key 3. You can use the options from this menu to carry out editing tasks.

- **F4= Redraw**

  Uniplex redraws the screen at once if you press Function Key 4.

- **Home Softkey Menu**

  The softkey menu that Uniplex displays when you first access an application is referred to as the **Home softkey menu.** You can access all other options from this menu. You can return to the Home softkey menu from any other softkey menu by pressing F11 at any time. Uniplex returns you immediately to the Home softkey menu.
Softkeys

Move around Softkey Menus

Related options are grouped together in softkey menus. For example, all the Edit options are grouped together. The screen is not wide enough to display all the options available in many cases. Options are grouped together in a series of related menus when this is the case. For example, there are four related menus all containing Edit options.

A number at the left of the menu indicates that the current menu is part of a related series of menus. For example:

Edit 1:

You can think of related menus as having a ring-like structure. The following diagram represents this structure:

```
Edit 1 → Edit 2 → Edit 3 → Edit 4 → Edit 1
```

To move to the next menu in the structure:

- Press F8

  For example, if you are in Edit 3, pressing F8 moves you to Edit 4. If you are in Edit 4, pressing F8 moves you to Edit 1.

To move to the previous menu in the structure:

- Press F7

  If you are in Edit 3, pressing F7 returns you to Edit 2. If you are in Edit 1, pressing F7 returns you to the previous menu level.
**Softkeys**

There is a standard set of function keys that can be used at any time in any Uniplex application in addition to the softkey menus that are displayed on the screen. The following table describes the purpose of each of these keys:

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>F9</td>
<td>Uniplex Desk options. See <em>Access Popup Menus</em> for more details.</td>
</tr>
<tr>
<td>F10</td>
<td>Context-sensitive help from any application.</td>
</tr>
<tr>
<td>F11</td>
<td>Return to Home softkey menu. See <em>Home Softkey Menu</em> for details.</td>
</tr>
<tr>
<td>F12</td>
<td>Uniplex Desk Utilities. See <em>Access Popup Menus</em> for details.</td>
</tr>
<tr>
<td>F13</td>
<td>Switch to a different window. See the Integration chapter for more details.</td>
</tr>
<tr>
<td>F14</td>
<td>Uniplex Window menu.</td>
</tr>
<tr>
<td>F15</td>
<td>Key Recorder menu. See the Key Recorder chapter for details.</td>
</tr>
<tr>
<td>F16</td>
<td>Attached Key Tapes menu. See the Key Recorder chapter for details.</td>
</tr>
</tbody>
</table>
Softkeys

You can use softkeys as follows if there are only 8 function keys on the terminal or no function keys at all.

<table>
<thead>
<tr>
<th>Softkey</th>
<th>Key Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>ESC 1</td>
</tr>
<tr>
<td>F2</td>
<td>ESC 2</td>
</tr>
<tr>
<td>F3</td>
<td>ESC 3</td>
</tr>
<tr>
<td>F4</td>
<td>ESC 4</td>
</tr>
<tr>
<td>F5</td>
<td>ESC 5</td>
</tr>
<tr>
<td>F6</td>
<td>ESC 6</td>
</tr>
<tr>
<td>F7</td>
<td>ESC 7</td>
</tr>
<tr>
<td>F8</td>
<td>ESC 8</td>
</tr>
<tr>
<td>F9</td>
<td>ESC 9</td>
</tr>
<tr>
<td>F10</td>
<td>ESC 0</td>
</tr>
<tr>
<td>F11</td>
<td>ESC ESC 1</td>
</tr>
<tr>
<td>F12</td>
<td>ESC ESC 2</td>
</tr>
<tr>
<td>F13</td>
<td>ESC ESC 3</td>
</tr>
<tr>
<td>F14</td>
<td>ESC ESC 4</td>
</tr>
<tr>
<td>F15</td>
<td>ESC ESC 5</td>
</tr>
<tr>
<td>F16</td>
<td>ESC ESC 6</td>
</tr>
</tbody>
</table>
Uniplex Applications

The major components that make up Uniplex are known as applications. For example, the Spreadsheet is an application and so is the Word Processor. Generally, there are three types of Uniplex applications:

- **Forms Applications.** You use these applications by completing Uniplex forms with your requirements. Database Forms is a forms application. For example, you find information by making an entry in a form.

- **Command-line Applications.** You use these applications by entering commands on the command line. Database Query is a command-line application. You query the database by entering commands on the command line.

- **Key-sequence Applications.** You use these applications by pressing the appropriate key sequences. The Word Processor is a key-sequence application. For example, to effect some text, you press `ESC <`.

The following features provide a consistent way of using Uniplex despite these different types of applications:

- **Menu System.** Organized and used the same way throughout Uniplex.

- **Softkeys.** Provided in most applications.

- **Command Structure.** Uniplex uses the same command set in all applications. This means, for example, that you use the same commands to edit a piece of text created with the Word Processor or in an area of the Spreadsheet. You use the same commands to find a record stored in the database and to find a file using the File Manager.
Uniplex Applications

- **External Windows.** Lets you switch between two or more Uniplex tasks or applications quickly and efficiently. For example, you can work with the Word Processor or the Spreadsheet and have your calendar always at hand or you can work with two different word processing documents, transferring information between them.

- **Cut and Paste.** You can cut out a portion of text, data, or graphics from any Uniplex application and transfer it to a different application. For example, you can cut out the result of a database inquiry, perform calculations on it using the Spreadsheet, and incorporate it in a report using the Word Processor.

- **Uniplex Desk and Desk Utilities.** You can use the desk options to perform Uniplex tasks directly from another application. For example, you can find information in the Database while you are working in the Spreadsheet, or you can refer to your personal calendar while you are preparing a document.

◆ **Common Commands**

Uniplex has a common command set. This means that you can use the same commands to perform many common tasks from any application. Uniplex has common commands to perform these tasks:

- Move around the Screen
- Edit Text, Data, and Graphics
- Save Files
- Search for Files and Records
- Record and Play Back Keystrokes
- Switch between Processes
◆ General Utilities

Uniplex displays this list of utility options on most menus:

<table>
<thead>
<tr>
<th>UTILITIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>P - Printing</td>
</tr>
<tr>
<td>C - Change Folder</td>
</tr>
<tr>
<td>F - File Manager</td>
</tr>
<tr>
<td>H - Help</td>
</tr>
<tr>
<td>Q - Quit</td>
</tr>
</tbody>
</table>

You can use these options as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>Displays the Printing menu. See the <em>Printing</em> chapter for details.</td>
</tr>
<tr>
<td>Change Folder</td>
<td>Prompts for the name of the new folder. See the <em>File Manager</em> chapter for details.</td>
</tr>
<tr>
<td>File Manager</td>
<td>Invokes the File Manager subsystem to move, delete, copy, browse, protect, and convert files. See the <em>File Manager</em> chapter for details.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays the Help menu. See the <em>Help</em> section below for details.</td>
</tr>
<tr>
<td>Quit</td>
<td>Quits this menu and returns to the last menu accessed. The Quit option on the Main menu quits Uniplex.</td>
</tr>
</tbody>
</table>
Getting to Know Uniplex

Help

You can display help at any time while using Uniplex. Help is context-sensitive information that Uniplex shows on your screen. Help provides information about how to use Uniplex to complete any required task. To display Help:

- **Menu.** Pick and point the Help option.

- **Application.** Press `ESC h` or press `F10`.

Access Help about any command menu option while using the Word Processor or Spreadsheet:

1. Move the cursor to the appropriate command menu option.

2. Press `ESC h`

Uniplex displays a menu of the available help topics or displays a help screen depending on the application you are using. Pick and point the topic on which you need help if Uniplex displays a popup menu. When a Uniplex help screen is displayed, you can:

- Press `ESC q` to close Help and return to your task.

- Press RETURN to display the next page of Help (if available).

Whenever you are using Uniplex and aren’t sure what to do next or don’t understand the screen display, press `ESC h` or `F10` for Help.
Uniplex Windows

This chapter is only for those users who have an X Terminal or who use a PC running an X Terminal emulation. It describes how to use Uniplex within the X Window System environment. Running Uniplex in this fashion allows you to use all the usual Uniplex tools in a faster, more efficient way. You can use several applications simultaneously and switch from one to the other on the screen.

✎ You can now use the External Windows command to process switch between tasks. This feature was previously disabled when using Uniplex Windows.

This chapter covers starting and stopping Uniplex Windows and also how to access Uniplex Windows-specific Help. The help pages describe how to perform tasks with a mouse when running Uniplex tools. Use any Window Manager documentation you have received from the System Administrator in conjunction with this guide if you are running Uniplex Windows in one of the Motif desktop environments.

✎ File Manager tracks and responds to every movement of the mouse. Make sure that the mouse pointer is not positioned in the Tree List to avoid accidentally refreshing the File Manager lists.

Start Uniplex Windows

To start Uniplex Windows:

- In a shell window, type `uxwindows` and press Enter.

The Uniplex Main Menu opens in a window on your screen.
Uniplex Windows

Each time you start an application from the main menu, either a separate window opens with the application loaded inside or the application loads in the current window. This functionality is pre-defined for each Uniplex application. To start a Uniplex tool from the Uniplex Main Menu:

- Click on the menu option you require.

The following list shows the applications which open in separate windows:

- Spreadsheet
- Database Forms
- Screen Builder
- Form Fill
- Graphics
- Time Manager
- Mail
If your screen becomes cluttered, you can minimize any window, thereby freeing up your display area. Refer to the Window Manager documentation for details about minimizing windows.

Although these applications all open in separate windows, you can use the DESK (F9) and UTIL (F12) pop-up menus to start them in the current window. You can then use the External Windows commands to switch between applications within the same window.

When you have finished using a Uniplex tool, you close it in the usual way and the window disappears from the display. Uniplex Windows, however, remains running until you close the last active application. The Uniplex Windows exit procedure is described in Stop Uniplex Windows.

Help

If you are running the onGO Office Character Client with Uniplex Windows, not all the descriptions in the Help system are applicable.

Uniplex Windows provides you with on-line help. This help complements the specific help available within the Uniplex applications. To access Uniplex Windows help:

1. From the Uniplex Main Menu, choose the Help option.
   The Using Uniplex Help menu appears.

2. From the Help menu, choose Uniplex Windows.
   The Uniplex Windows-specific Help menu appears.

The help system offers information about using the mouse in the following Uniplex tools:

- Word Processor
- Spreadsheet
GETTING TO KNOW UNIPLEX

Uniplex Windows

- File Manager
- Time Manager

There is also a section called General Operations which describes the more common tasks you can perform with a mouse, such as confirming prompts and scrolling through field options.

3 Choose the option for which you want Help.

4 When you have finished using Help, press F4 (Esc q).

◊ Stop Uniplex Windows

When you exit from Uniplex Windows, you can choose to continue receiving notifications, for example, those that inform you about new mail, or you can exit from Uniplex Windows and not receive any Uniplex Windows notifications. To exit from Uniplex Windows:

1 Make sure that you have saved any work that you want to keep and then close all active Uniplex Windows tools.

This dialog box opens after the last active window is closed:
2 Do one of the following:

- Do not take any action to continue receiving notifications. You will continue to receive notifications until you close the dialog box by clicking on **Exit**.

- Click on **Exit** to leave Uniplex Windows and suppress notifications.

- Click on **Restart** to open the Uniplex Main Menu in a new window.

*The Exit Uniplex Windows dialog closes automatically when you next start a Uniplex tool by double-clicking on its icon if you are running Uniplex Windows on a desktop.*
Getting to Know Uniplex

Access
- Computer 1-3
- Help 1-22
- On-line Help
  - Uniplex Windows 1-25
- Popup Desk Menu 1-11
- Uniplex 1-4
- Utilities Popup Menu 1-11
- Applications 1-19
- Arrow Keys 1-2

Blank Field
  - Form 1-12

CARRIAGE RETURN Key 1-1
Change Folder
  - Utilities 1-21
Commands
  - Standard 1-20
Computer
  - Access 1-3
CTRL(control) Key 1-2
Cursor 1-1

Default Field
  - Form 1-13
Desk Popup Menu
  - (see Popup Desk Menu)
Direction Keys 1-2
Drop Down Menu 1-7

ENTER Key 1-1
ESC(ape) Key 1-2
Exit
  - Menu 1-10
  - Exit (see Stop)
Expandable Field
  - Form 1-13

Field
  - Form 1-12
File Manager
  - Changes 1-8
Utilities 1-21
  - Drop Down 1-7
File Name
  - Exit 1-10
Select 1-10

Fixed Field
  - Form 1-12
  - Blank Field 1-12
  - Default Field 1-13
  - Expandable Field 1-13
  - Field 1-12
  - Types 1-12
  - Fixed Field 1-12
  - Input Field 1-13
  - Function Keys 1-3
  - Standard 1-17

Help
  - Access 1-22
  - On-line 1-22
  - Uniplex Windows 1-25
  - Utilities 1-21
Highlight Menu Option 1-9
Home Softkey Menu 1-15

Input Field
  - Form 1-13

Key
  - Arrow 1-2
  - CARRIAGE RETURN 1-1
  - CTRL(control) 1-2
  - Direction 1-2
  - ENTER 1-1
  - ESC(ape) 1-2
  - Function 1-3
  - RETURN 1-1
  - Keyboard 1-1

Leave Menu 1-10
Login 1-3

Main Menu
  - Uniplex 1-4
Menu
  - Changes 1-8
  - Drop Down 1-7
  - Exit 1-10
  - Full Screen 1-5
Getting to Know Uniplex

Menu (continued)
Pick and Point 1-9
Popup 1-5
Quit 1-10
Ring 1-6
Select Options 1-9
Softkey 1-14, 1-7
Uniplex Main 1-4
Move
Between Softkey Menus 1-16
Office Automation 1-1
On-line
Help
Uniplex Windows 1-25
On-line Help 1-22
Password 1-3
Pick and Point 1-9
Popup Desk Menu
Access 1-11
Uniplex 1-11
Utilities 1-11
Popup Menus 1-5
Popup Menus
(see Popup Desk Menu)
Printing
Utilities 1-21
Quit
Menu 1-10
Utilities 1-21
RETURN Key 1-1
Ring Menu 1-6
Select
File Name 1-10
Menu Option 1-9
Softkey Option 1-14
Softkey 1-14
Corresponding Function Key 1-3
Home Menu 1-15
Menu 1-14, 1-7
Move Around 1-16

Softkey (continued)
Select Option 1-14
Start (see Access)
Stop
Uniplex Windows 1-26
Terminal 1-1, 1-3
Uniplex
Access 1-4
Main Menu 1-4
Menu
Changes 1-8
Popup Desk Menu 1-11
Utilities Popup Menu 1-11
Windows
Exit 1-26
Help 1-25
Start 1-23
User Name 1-3
Utilities
Change Folder 1-21
File Manager 1-21
General 1-21
Help 1-21
Printing 1-21
Quit 1-21
Chapter 2
Filing Your Work
## Filing Your Work

### Overview

2-1

### Create a New Document or File

2-2

- Name a Document or File
- Save a Document or File

### Folders

2-4

- Organize your Work in Folders
- Pathnames
- Create a Folder
- Move between Folders

### Index

2-9
Overview

All the work you do with Uniplex is stored in documents or files. Documents contain work you do using the Uniplex Word Processor. For example, letters and reports are stored in documents. Files contain work from other Uniplex applications. Files can contain calculations, graphics, data, or text. For example, work you do with the spreadsheet is contained in a file.

Documents and files can be any size. For example, a document can contain a single line of text or a complete manual. A file can contain one calculation or the annual budget for a large organization.
Create a New Document or File

Whenever you start a new piece of work, Uniplex automatically creates a new document or file for it. When you complete a piece of work, you ask Uniplex to save it. Once you have saved a document or file, you can find it again and resume work on it. It is easy to make changes and additions to your work using Uniplex.

Name a Document or File

Every time you save a new piece of work, Uniplex prompts for a name for the file or document. For example:

Enter document name (DOWNARROW for File Manager): [..........]

You use the names of documents and files to find them easily when you want to resume work on them. If possible, use names that reflect the contents of the file or document. For example, if the file contains finance information, you can call it finance.

Follow these rules when naming files and documents:

1. The file or document name must be no longer than 14 characters. You can use letters, numbers, or a combination of both.

2. The computer does not recognize an UPPER CASE and a lower case letter as being the same letter. For example, if you named a file sales and try to find it by entering SALES, Uniplex does not find it. It is advisable to use all UPPER case or all lower case consistently to avoid any confusion.

3. Do not use any spaces or these following characters in a document or file name:

   * (asterisk)   ? (question mark)
   , (comma)     / (slash)
Create a New Document or File

Save a Document or File

Every time you resume work on a document or file, Uniplex temporarily creates a new version of it. When you have finished work, you can save the updated version of a document or file. Uniplex overwrites the original with your new, updated version. Alternatively, you can quit from the updated version and leave the document or file in its original state.

You must make sure that you save all the work you want to keep. Even if you only make a few small changes to a file, you must remember to save the new version of the file.

Uniplex has several different ways of saving files. Use the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC e</td>
<td>Saves your work, and returns to the Uniplex menu. Use this command when you have finished a piece of work.</td>
</tr>
<tr>
<td>ESC s e</td>
<td>Saves your work, and returns to the Uniplex menu. Use this command when you have finished a piece of work.</td>
</tr>
<tr>
<td>ESC w</td>
<td>Saves your work, leaving you in the same task. Use this command when you are working in a large file or document. You should save work at frequent intervals when you are working in a large file or document to avoid losing valuable work, for example, if there is a power failure.</td>
</tr>
<tr>
<td>ESC s f</td>
<td>Saves your work, leaving you in the same task. Use this command when you are working in a large file or document. You should save work at frequent intervals when you are working in a large file or document to avoid losing valuable work, for example, if there is a power failure.</td>
</tr>
<tr>
<td>ESC s x</td>
<td>Saves your work and copies it to another file.</td>
</tr>
<tr>
<td>ESC q</td>
<td>Leaves your work without saving any changes. Use this command if you want to abandon a piece of work.</td>
</tr>
</tbody>
</table>

2-3
FILING YOUR WORK

Folders

All your files and documents are stored in folders. A folder is like a folder found in traditional filing cabinets. You can organize your folders so they contain pieces of work that are related to each other. For example, just like in a manual filing system you store all the personnel files in one place and all the finance files in a different place.

Organize your Work in Folders

Using folders means that you can organize all your files and documents and find them easily when you want to use them. When you start work, Uniplex places all the files and documents you create in a folder under your user name. Your user name is the name by which you access the computer system.

You can create additional folders with your user name and a folder name to store new files and documents. Folders can be part of another folder, in the way that a filing drawer is part of a cabinet. For example, the finance folder might have additional folders so that sales and purchasing information can be stored separately.

A folder structure might look like this:

```
/usr/steven

personal purchases sales

work social stock equip april may
```
In this example, your own folder is the equivalent of an entire filing cabinet. It is often called /usr/yourname. For example, it might be called /usr/john or /usr/steven. See the next section *Pathnames.*

The personal, purchases and sales folders are the equivalent of the different drawers within the cabinet. The work and social folders are like the folders in a drawer.

**Pathnames**

When you build up a structure of folders, each individual folder has a pathname. The pathname tells Uniplex where the folder is in the structure. Uniplex uses a slash (/) character to show the different levels of the structure.

Often your own folder is prefaced with the letters `usr`, which stands for user. If your system is set up like this, the pathname for your own folder is:

```
/usr/yourname
```

The pathname for the personal folder is:

```
/usr/yourname/personal
```

This tells Uniplex that the personal folder is a subdivision of your own folder. The pathname for the work folder is:

```
/usr/yourname/personal/work
```

This tells Uniplex that the work folder is a subdivision of the personal folder, which is itself a subdivision of your own folder.

**Create a Folder**

You can create new folders for all the different areas of your work. To create a new folder:

1. Pick and point the File Manager option.
FILING YOUR WORK

Folders

2 Activate the File Manager pulldown menus by pressing the / key or F2.

3 Select the following options from the File menu:

   New ➔ Folder

4 Complete the Create Folder screen.

5 Press F1 (Esc e).

For more information see the Create a Folder section of the File Manager chapter.

Move between Folders

If you want to work with a document or file in one of your folders, you must either move to that folder or specify the full pathname to access the file or document.

- To move to another folder:

  Pick and point View ➔ Open Folder ➔ Named Folder. Uniplex prompts for a folder name.

- To move down a level in the folder structure:

  Enter the name of the folder. You do not need to enter the pathname.

- To move up a level in the folder structure:

  Enter:

  . . /

  Uniplex moves you up to the next level in the folder structure.
To move to another folder in the same level:

Enter:

`../foldername`

For example, if you look back to the diagram in *Folders*, to move from the *april* folder to the *may* folder, enter:

`../may`

To move to an unrelated folder:

Enter the full pathname of the folder. For example:

`/usr/anne/finance`

See *Pathnames* for details.
Filing Your Work

Change Folder  2-6
Create
  File  2-2
  Folder  2-5

Directory (see Folder)
Document (see File)

Exit (see Save)

File
  Create  2-2
  Name  2-2
  Save  2-3

Folder  2-4
  Change  2-6
  Create  2-5
  Move Between  2-6
  Organize Work  2-4
  Pathname  2-5
  Structure  2-4

Leave (see Save)
Letter (see File)

Memo (see File)
Move Between Folders  2-6

Name
  Conventions  2-2
  File  2-2

Organize Work  2-4

Pathname  2-5

Quit File  2-3

Report (see File)

Save
  File  2-3
  Another  2-3
  Continue  2-3
  Exit  2-3

Store (see Save)
Chapter 3
Word Processor
# Word Processor

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>3-1</td>
</tr>
<tr>
<td>Access the Word Processor</td>
<td>3-4</td>
</tr>
<tr>
<td>Help</td>
<td>3-6</td>
</tr>
<tr>
<td>Worked Example</td>
<td>3-9</td>
</tr>
<tr>
<td><strong>BASIC WORD PROCESSING</strong></td>
<td>3-27</td>
</tr>
<tr>
<td>Create a Document</td>
<td>3-29</td>
</tr>
<tr>
<td>Screen Components</td>
<td>3-30</td>
</tr>
<tr>
<td>Information Lines</td>
<td>3-30</td>
</tr>
<tr>
<td>Text Area</td>
<td>3-32</td>
</tr>
<tr>
<td>Softkey Menu</td>
<td>3-32</td>
</tr>
<tr>
<td>Command Menu</td>
<td>3-34</td>
</tr>
<tr>
<td>Edit an Existing Document</td>
<td>3-36</td>
</tr>
<tr>
<td>Move the Cursor</td>
<td>3-37</td>
</tr>
<tr>
<td>Command Menu</td>
<td>3-37</td>
</tr>
<tr>
<td>Key Commands</td>
<td>3-40</td>
</tr>
<tr>
<td>Scroll Text</td>
<td>3-42</td>
</tr>
<tr>
<td>Enter Text</td>
<td>3-43</td>
</tr>
<tr>
<td>End a Line</td>
<td>3-44</td>
</tr>
<tr>
<td>End a Page</td>
<td>3-44</td>
</tr>
<tr>
<td>Insert Text</td>
<td>3-47</td>
</tr>
<tr>
<td>Space</td>
<td>3-47</td>
</tr>
<tr>
<td>Blank Line</td>
<td>3-48</td>
</tr>
<tr>
<td>Blank Lines</td>
<td>3-49</td>
</tr>
<tr>
<td>Insert Mode</td>
<td>3-49</td>
</tr>
<tr>
<td>Delete Text</td>
<td>3-52</td>
</tr>
<tr>
<td>Previous Character</td>
<td>3-52</td>
</tr>
<tr>
<td>Character</td>
<td>3-52</td>
</tr>
<tr>
<td>Word</td>
<td>3-53</td>
</tr>
<tr>
<td>Line</td>
<td>3-53</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Word Processor</strong></td>
<td></td>
</tr>
<tr>
<td>Blank Lines</td>
<td>3-54</td>
</tr>
<tr>
<td>Right of Cursor</td>
<td>3-54</td>
</tr>
<tr>
<td>Left of Cursor</td>
<td>3-55</td>
</tr>
<tr>
<td>Sentence</td>
<td>3-55</td>
</tr>
<tr>
<td>Text Block</td>
<td>3-56</td>
</tr>
<tr>
<td><strong>Undo a Command</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3-57</td>
</tr>
<tr>
<td><strong>Redraw the Screen</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3-57</td>
</tr>
<tr>
<td><strong>Check Spelling</strong></td>
<td></td>
</tr>
<tr>
<td>Spell Check a Whole Document</td>
<td>3-62</td>
</tr>
<tr>
<td>Spell Check from Current Position</td>
<td>3-63</td>
</tr>
<tr>
<td>Spell Check a Block of Text</td>
<td>3-63</td>
</tr>
<tr>
<td>Change Language Dictionary</td>
<td>3-64</td>
</tr>
<tr>
<td>Change Supplementary Dictionaries</td>
<td>3-66</td>
</tr>
<tr>
<td>Skip Spell Checking</td>
<td>3-68</td>
</tr>
<tr>
<td><strong>Dictionary Management</strong></td>
<td></td>
</tr>
<tr>
<td>Create a Supplementary Dictionary</td>
<td>3-70</td>
</tr>
<tr>
<td>Update a Supplementary Dictionary</td>
<td>3-71</td>
</tr>
<tr>
<td>Set Hyphenation Breaks</td>
<td>3-73</td>
</tr>
<tr>
<td><strong>Save and Name a Document</strong></td>
<td></td>
</tr>
<tr>
<td>Name a Document</td>
<td>3-74</td>
</tr>
<tr>
<td>Save Changes and Continue</td>
<td>3-75</td>
</tr>
<tr>
<td>Quit without Saving</td>
<td>3-76</td>
</tr>
<tr>
<td>Save and Exit</td>
<td>3-76</td>
</tr>
<tr>
<td>Copy a Document</td>
<td>3-77</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td></td>
</tr>
<tr>
<td>Save Printer Information</td>
<td>3-78</td>
</tr>
<tr>
<td>Change Document Format Details</td>
<td>3-79</td>
</tr>
<tr>
<td>Add Document Format Details</td>
<td>3-81</td>
</tr>
<tr>
<td>Print a Pre-styled Document</td>
<td>3-82</td>
</tr>
<tr>
<td>Turn Off Document Format</td>
<td>3-82</td>
</tr>
<tr>
<td>Send a Printer Command</td>
<td>3-82</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

## Word Processor

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Preview</td>
<td>3-84</td>
</tr>
<tr>
<td>Move around the Screen</td>
<td>3-86</td>
</tr>
<tr>
<td>Goto and Find</td>
<td>3-87</td>
</tr>
<tr>
<td><strong>CHANGE YOUR WORK</strong></td>
<td>3-91</td>
</tr>
<tr>
<td>Rulers</td>
<td>3-93</td>
</tr>
<tr>
<td>Ragged Right Margin</td>
<td>3-94</td>
</tr>
<tr>
<td>Justified Right Margin</td>
<td>3-95</td>
</tr>
<tr>
<td>Align to Right Margin</td>
<td>3-95</td>
</tr>
<tr>
<td>Center between Margins</td>
<td>3-96</td>
</tr>
<tr>
<td>Hang First Word Outside Left Margin</td>
<td>3-96</td>
</tr>
<tr>
<td>Indent First Line</td>
<td>3-97</td>
</tr>
<tr>
<td>Hang First Line Outside Left Margin</td>
<td>3-97</td>
</tr>
<tr>
<td>Center around a Point</td>
<td>3-98</td>
</tr>
<tr>
<td>Align Numbers in Columns</td>
<td>3-98</td>
</tr>
<tr>
<td>Preset Rulers</td>
<td>3-99</td>
</tr>
<tr>
<td>Customize a Ruler</td>
<td>3-100</td>
</tr>
<tr>
<td>Save a Customized Ruler</td>
<td>3-103</td>
</tr>
<tr>
<td>Save Current Rulers Permanently</td>
<td>3-104</td>
</tr>
<tr>
<td>Temporary Left Margin</td>
<td>3-105</td>
</tr>
<tr>
<td>Multiple Columns</td>
<td>3-106</td>
</tr>
<tr>
<td>Rulers</td>
<td>3-107</td>
</tr>
<tr>
<td>Enter Text</td>
<td>3-107</td>
</tr>
<tr>
<td>Align Text</td>
<td>3-108</td>
</tr>
<tr>
<td>Delimiters</td>
<td>3-109</td>
</tr>
<tr>
<td>Format Boxed Text</td>
<td>3-110</td>
</tr>
<tr>
<td>Double Rulers</td>
<td>3-112</td>
</tr>
<tr>
<td>Reformat Text</td>
<td>3-113</td>
</tr>
<tr>
<td>Stop and Restart Reformatting</td>
<td>3-114</td>
</tr>
<tr>
<td>Right Align a Line</td>
<td>3-116</td>
</tr>
<tr>
<td>Center a Line</td>
<td>3-116</td>
</tr>
<tr>
<td>Split a Line</td>
<td>3-117</td>
</tr>
<tr>
<td>Join Two Lines</td>
<td>3-118</td>
</tr>
<tr>
<td><strong>Convert Case</strong></td>
<td>3-119</td>
</tr>
<tr>
<td>Text</td>
<td>3-119</td>
</tr>
<tr>
<td>Text Block</td>
<td>3-120</td>
</tr>
</tbody>
</table>
Word Processor

Hard Characters.................................................................3-122

Headers and Footers..........................................................3-123
Set........................................................................3-124
Delete......................................................................3-126
Header Margin..............................................................3-127
Footer Margin...............................................................3-128

Numbering......................................................................3-130
Section Numbering.........................................................3-131
Page Numbering.............................................................3-134
Force Page Numbering....................................................3-137
Paragraph Numbering.....................................................3-138
Force Paragraph Numbering.............................................3-143

Change Page Length..........................................................3-144

Cut and Paste..................................................................3-146
Copy........................................................................3-147
Move.......................................................................3-149
Cut..........................................................................3-151
Paste........................................................................3-152
Select a Clipboard..........................................................3-153
View Clipboard Contents...............................................3-154

Merge...........................................................................3-155
Merge a Document while Editing......................................3-155
Merge a Document or Command at Print Time.................3-156
Merge the Result of a Command........................................3-158
Integrate a Graphics File................................................3-158

Box Drawing....................................................................3-159
Draw a Box..................................................................3-160
Delete a Box.................................................................3-161
Shade an Area...............................................................3-162

Line Drawing..................................................................3-164
Draw a Line..................................................................3-164
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Processor</td>
<td>3-165</td>
</tr>
<tr>
<td>Move while Drawing</td>
<td>3-166</td>
</tr>
<tr>
<td>Erase Lines</td>
<td>3-165</td>
</tr>
<tr>
<td>Effects</td>
<td>3-166</td>
</tr>
<tr>
<td>Effect Text</td>
<td>3-167</td>
</tr>
<tr>
<td>Effect a Word</td>
<td>3-168</td>
</tr>
<tr>
<td>Effect a Block of Text</td>
<td>3-169</td>
</tr>
<tr>
<td>Turn Off an Effect</td>
<td>3-170</td>
</tr>
<tr>
<td>Check an Effect</td>
<td>3-171</td>
</tr>
<tr>
<td>Repeat Last Command</td>
<td>3-172</td>
</tr>
<tr>
<td>ADVANCED WORD PROCESSING</td>
<td>3-175</td>
</tr>
<tr>
<td>Thesaurus</td>
<td>3-177</td>
</tr>
<tr>
<td>Find a Synonym</td>
<td>3-180</td>
</tr>
<tr>
<td>Glossaries</td>
<td>3-182</td>
</tr>
<tr>
<td>Create</td>
<td>3-183</td>
</tr>
<tr>
<td>Add Entry</td>
<td>3-183</td>
</tr>
<tr>
<td>Insert Entry while Editing</td>
<td>3-184</td>
</tr>
<tr>
<td>Insert Entry at Print Time</td>
<td>3-185</td>
</tr>
<tr>
<td>Search and Replace</td>
<td>3-187</td>
</tr>
<tr>
<td>Case</td>
<td>3-187</td>
</tr>
<tr>
<td>Replace Options</td>
<td>3-188</td>
</tr>
<tr>
<td>Interactive</td>
<td>3-188</td>
</tr>
<tr>
<td>Global</td>
<td>3-188</td>
</tr>
<tr>
<td>Formfill</td>
<td>3-189</td>
</tr>
<tr>
<td>Search Procedures</td>
<td>3-189</td>
</tr>
<tr>
<td>Repeat Search</td>
<td>3-192</td>
</tr>
<tr>
<td>Quick Search</td>
<td>3-192</td>
</tr>
<tr>
<td>Calculator</td>
<td>3-193</td>
</tr>
<tr>
<td>Calculate Individual Numbers</td>
<td>3-193</td>
</tr>
<tr>
<td>Add a Range of Numbers</td>
<td>3-194</td>
</tr>
<tr>
<td>Footnotes</td>
<td>3-196</td>
</tr>
<tr>
<td>Marker</td>
<td>3-196</td>
</tr>
</tbody>
</table>
TABLE OF CONTENTS

Word Processor

Enter Text ................................................................. 3-197
Delete Text ............................................................... 3-199
Numbering Style ...................................................... 3-199
Marker Effects ............................................................ 3-202
Position ........................................................................ 3-203

Non-printing Remarks ................................................. 3-205

Bookmarks ................................................................. 3-207
Enter a Bookmark ...................................................... 3-207
Return to a Bookmark ................................................ 3-208

Set Line Spacing ........................................................ 3-209
Pre-styled Documents ............................................... 3-211

Keep Lines Together .................................................. 3-212

Change Ruler Pitch ..................................................... 3-216

Abandon Global Commands ........................................ 3-218

Index ........................................................................... 3-219
Plan ............................................................................. 3-219
Add Entries .................................................................... 3-220
Primary Entry ............................................................ 3-221
Secondary Entry .......................................................... 3-222
Inverse Entry ............................................................. 3-222
Effects ........................................................................ 3-223
Multiple Indexes .......................................................... 3-224
Numbering Style .......................................................... 3-226
Edit an Entry ............................................................... 3-228
Generate ...................................................................... 3-229

Table of Contents ........................................................ 3-232
Plan ............................................................................. 3-232
Add Entries .................................................................... 3-233
Primary Entry ............................................................ 3-233
Secondary Entry .......................................................... 3-234
Effects ........................................................................ 3-235
## TABLE OF CONTENTS

### Word Processor

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Tables of Contents</td>
<td>3-236</td>
</tr>
<tr>
<td>Numbering Style</td>
<td>3-237</td>
</tr>
<tr>
<td>Edit an Entry</td>
<td>3-239</td>
</tr>
<tr>
<td>Generate</td>
<td>3-239</td>
</tr>
<tr>
<td>Clear Current Document</td>
<td>3-243</td>
</tr>
<tr>
<td>Clear Current Document</td>
<td>3-243</td>
</tr>
<tr>
<td>Edit Another Document</td>
<td>3-244</td>
</tr>
<tr>
<td>Browse Non-Uniplex Documents</td>
<td>3-245</td>
</tr>
<tr>
<td>Import/Export Non-Uniplex Documents</td>
<td>3-246</td>
</tr>
<tr>
<td>Import a Non-Uniplex Document</td>
<td>3-246</td>
</tr>
<tr>
<td>Export to a Non-Uniplex Document</td>
<td>3-247</td>
</tr>
<tr>
<td>Operating Modes</td>
<td>3-248</td>
</tr>
<tr>
<td>Set Insert Mode</td>
<td>3-248</td>
</tr>
<tr>
<td>Use Hard Returns</td>
<td>3-248</td>
</tr>
<tr>
<td>Change Position Marker</td>
<td>3-249</td>
</tr>
<tr>
<td>Hyphenate Text</td>
<td>3-249</td>
</tr>
<tr>
<td>Automatic Hyphenation</td>
<td>3-249</td>
</tr>
<tr>
<td>Manual Hyphenation</td>
<td>3-250</td>
</tr>
<tr>
<td>Reformat Text Automatically</td>
<td>3-251</td>
</tr>
<tr>
<td>Use Tab Mode</td>
<td>3-251</td>
</tr>
<tr>
<td>Set Auto Save</td>
<td>3-252</td>
</tr>
<tr>
<td>Recover Auto Saved Document</td>
<td>3-252</td>
</tr>
<tr>
<td>Display Command Hints</td>
<td>3-253</td>
</tr>
<tr>
<td>Set Command Menu Access Character</td>
<td>3-254</td>
</tr>
<tr>
<td>Set Cursor Wrapping</td>
<td>3-254</td>
</tr>
<tr>
<td>Align Multiple Columns</td>
<td>3-254</td>
</tr>
<tr>
<td>Generate Style Information</td>
<td>3-255</td>
</tr>
<tr>
<td>Set Operating Modes</td>
<td>3-255</td>
</tr>
<tr>
<td>Windows</td>
<td>3-259</td>
</tr>
<tr>
<td>Open a Window</td>
<td>3-259</td>
</tr>
<tr>
<td>Switch between Windows</td>
<td>3-261</td>
</tr>
<tr>
<td>Close a Window</td>
<td>3-261</td>
</tr>
</tbody>
</table>
TABLE OF CONTENTS

**Word Processor**

**Fonts** ................................................................. 3-262
  - Select Font .................................................. 3-263
  - Edit Font ...................................................... 3-265
  - Predefined Font Names .................................... 3-265
  - Reset Font .................................................. 3-266

**Mail Merge** ........................................................... 3-267
  - Access the Mail Merge Menu ......................... 3-268
  - Create an Address File .................................. 3-269
  - Add Addresses to an Address File .................. 3-271
  - Create a Standard Letter .............................. 3-274
  - Format a Standard Letter .............................. 3-274
  - Left Align a Mail Merge Entry ...................... 3-274
  - Right Align a Mail Merge Entry .................... 3-274
  - Suppress Blank Lines and Spaces .................. 3-275
  - Suppress Following Spaces ........................... 3-275
  - Truncate Mail Merge Entries ......................... 3-276
  - Other Mail Merge Entries ............................. 3-276
  - Run a Mail Merge .......................................... 3-277
  - Run an Interactive Mail Merge ...................... 3-279
  - Edit a Mail Merge Document ......................... 3-281

**Index** ..................................................................... 3-283
Overview
A Word Processor is a computer tool for creating, editing and printing documents. It is similar to a typewriter because it lets you print text onto a piece of paper and yet far more advanced because it lets you edit the document, save it and return to it as often as you like.

The Uniplex Word Processor is more advanced still. It is not just a word processor, but an advanced and powerful document processing device. It has numerous features to make producing quality, professional documents easy.

You do not have to worry about learning hundreds of keystrokes in order to access a particular feature. An easy-to-use command menu guides you through each process step-by-step.

Naturally you can perform all the standard word processor functions, for example:

- Correcting any typing errors you make.
- Inserting text anywhere in the document.
- Indenting paragraphs permanently or temporarily.
- Centering text in the middle of the margins.
- Searching for and replacing any text in the document.
- Checking the spelling of the document and correcting any errors you find using Uniplex’s 100,000 word dictionary.

In addition the Uniplex Word Processor contains many advanced word processing features, for example:

- A Thesaurus to find a synonym (word of similar meaning) for any word in the document.
Overview

- An Indexing facility to create an alphabetic index for any words in the document with subentries.
- A Windows facility to enable you to edit one part of the document while also displaying another.
- A Mail Merge facility to create a number of different letters from one standard document.
- A Line Draw facility to make drawing and erasing straight lines anywhere in the document simple.

The Word Processor has been improved in a number of ways. The following additional information has been added to this manual:

- **New Features**
  - Save Printer Information with a Document and Browse Non-Uniplex Documents.

- **Enhanced Features**
  - Font Selection (see *Fonts*) and the Word Processor F3 Softkey (see *Command Menu*).

- **Additional Documentation**
  - Dictionary Management (see *Check Spelling*).

The Uniplex Word Processor is compatible with all other applications of the Uniplex Business Software suite. For example, you can:

- Include database information in a document.
- Add spreadsheet data to a document table.
- Merge Uniplex graphics into a document.
This chapter explains how easy it is to access and use all the features available in the Uniplex Word Processor. It is divided into the following sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worked Example</td>
<td>Step-by-step instructions show the first time user the basic Word Processor features.</td>
</tr>
<tr>
<td>Basic Word Processing</td>
<td>The information necessary to create a basic Uniplex document, such as how to access the Word Processor, enter text in a document, and save the document.</td>
</tr>
<tr>
<td>Change Your Work</td>
<td>How to change the layout of a document, including how to change the style of a paragraph and how to move sections of text around the document.</td>
</tr>
<tr>
<td>Advanced Word Processing</td>
<td>How to improve the quality of a document such as how to use the thesaurus to find a synonym for any word in the document and how to create an index or a table of contents for the document.</td>
</tr>
<tr>
<td>Index</td>
<td>You can find any information in the chapter quickly and easily with the comprehensive index.</td>
</tr>
</tbody>
</table>
Overview

Access the Word Processor

You can access the Word Processor in two ways, either from the Main menu or from any Uniplex application using the Uniplex Desk.

To access the Word Processor from the Main menu:

1. Select the Word Processor option from the Main menu.

   Uniplex displays the Word Processor menu, for example:

   1. Press ESC x d or F9

   Uniplex displays the Desk popup menu.

2. If you want to invoke the Word Processor in a window, select the Window WP option.

   If you want to invoke the Word Processor in full screen, select the Word Processor option from the second page of the Uniplex Desk.
Uniplex prompts for the name of the document you want to edit, if any.

3 Either:

- Enter the name of the document you want to edit and press RETURN.

- Press the DOWN ARROW to display a list of all the documents in the current folder. Move the highlight onto the document you require and press RETURN.

- Leave the field blank and press RETURN to create a new document.
Help

At any time while you are using the Word Processor you can access on-line help. Uniplex displays full help about how to use the Word Processor, help about the tasks you can perform using the command menu and help about using the common Uniplex features.

To access full help about the Word Processor:

1 Press **ESC h**
   Uniplex displays a popup help menu showing the help topics available.

2 Select the option you require.
   Uniplex displays help concerning this subject.

In some cases Uniplex displays a further popup menu from which you can select more specific help.

To access help about a particular command menu option:

1 Move the cursor onto the appropriate command menu option.

2 Press **ESC h**
   Uniplex displays help concerning that option.

To return to the current task when displaying help press **ESC q**.
Worked Example
**Worked Example**

This worked example introduces you to the main concepts and features of the Word Processor.

When you have completed it you will be able to use the word processor to create, save, edit and print a document. You will also be able to change the way a document appears on the screen and access other word processor features.

If you have never worked with a computer before, read the *Getting to Know Uniplex* chapter before you begin this worked example.

1 **Create a Document**

All work you do using the word processor is stored in documents. A document can be a memo, a report or a chapter of a book. Each time you begin a new piece of work, you must create a document:

a) Select the Word Processor option from the Main menu.

b) Select the Create a Document option from the Word Processor menu.

Uniplex displays the word processor editing screen. The top line of the screen is known as the *status line*. It displays the name of the document, if the document has a name, the length of the page in lines (PL66) and your current page number (#1). This is useful when you are working in large documents. To the far right of the status line Uniplex displays a counter which shows the current line number and character position on the screen. Uniplex also displays any modes you have set, for example TAB, on this line.

The two lines below the status line are where the *command menu* is displayed. Later in the worked example you will find out how to access and use the command menu, to perform word processor functions.
Worked Example

The fourth line is the *ruler*. Uniplex uses rulers to show you the layout of the current paragraph. For example, any tabstops and where the left and right margins are set. You can change the ruler to control the appearance or *format* of the text.

<table>
<thead>
<tr>
<th>UNIPLEX</th>
<th>TAB</th>
<th>PL66 #1</th>
<th>32:1</th>
</tr>
</thead>
</table>

Print Style and Printer: Fixed-pitch, printer 1

<-End Pre-styled Document Format->

2 Move Around the Screen

Towards the top left of the screen you can see a small light square, or underscore. This is known as the *cursor*. Uniplex always enters text at the cursor position.

You can move the cursor to any position on the screen:

a) Find the *arrow keys* on the keyboard. They are usually indicated by four directional arrows: ←, →, ↓, and ↑. If there are no arrow keys on the keyboard, ask the System Administrator which keys you should use instead.
b) Press the right arrow key several times, then the down arrow key, followed by the left arrow key and the up arrow key. Watch the cursor move in the same direction as the key you press.

You use the arrow keys to move the cursor around the screen and to the place where you want to edit or enter text.

You cannot move the cursor past the top line, or the left edge of the screen.

You can also move quickly to any part of the screen or document using other Uniplex commands. See Move the Cursor for details.

3 Enter Text

You enter text in a document using the keyboard. As you press character keys on the keyboard the corresponding character appears on the screen. Press the SPACEBAR, at the bottom of the keyboard, to enter spaces, just like a typewriter.

a) Use the arrow keys to move the cursor to the top left corner of the screen.

b) Enter the following text:

At the end of July there will be a company trip to Barbados. Everyone who wishes to go should contact Julie Jones.

Notice that when the text reaches the end of the line, Uniplex automatically moves the cursor to the beginning of the next line. This feature is known as wordwrap.

If you made any mistakes while entering the text, do not worry about them now. Later in the worked example you will find out how easy it is to correct them.
Worked Example

c) Find the RETURN key on the keyboard. Sometimes this is marked as the ENTER key. If you are not sure which is the RETURN key, ask the System Administrator.

d) Press the RETURN key twice.

You can see the cursor move to the left of the screen, two lines below its previous position. This is how you begin a new paragraph.

e) Now enter the following paragraph:

The trip will be free to all company staff and their spouses. However you must ensure that you bring enough money to pay for lunches and drinks.

Again, do not worry about any mistakes, you can correct them later. Your screen should now look something like this:

```
At the end of July there will be a company trip to Barbados. Everyone who wishes to go should contact Julie Jones.

The trip will be free to all company staff and their spouses. However you must ensure that you bring enough money to pay for lunches and drinks.
```

F1=Save&Exit F2=Menu F3=Preview F4=Quit F5>Draw F6=Easi F7>Eff F8>
4 Make Changes to Text

A major advantage of using a word processor is that you can make changes to text easily, without having to retype it.

a) Use the arrow keys to move the cursor to the J of the word July on the first line of the first paragraph.

b) Enter the word:

   June

   You can see that Uniplex types over the word July and replaces it with the word June. You can type over any amount of text, to replace a single letter or an entire page.

5 Insert Text

You can also add extra words, lines or paragraphs to an existing piece of text.

a) Find the key marked ESC on the keyboard. This is the ESCAPE key. You use it to initiate many Uniplex commands.

   The ESCAPE key may have a different name according to the keyboard you have. If you are unsure which is the ESCAPE key ask the System Administrator.

b) Press the ESC key, then press i.

   In the center of the status line, Uniplex displays the word INSERT. You are now in insert mode. If you enter text now, Uniplex inserts the text at the cursor position and pushes any existing text over to make room.

   Insert text:

   a) Move the cursor to the J of the word Julie.
**Worked Example**

b) Enter the following text:

```
Mrs
```

then press the SPACEBAR once.

You can see that Uniplex inserts the new text at the cursor position. Your paragraphs should now appear something like the following:

```
At the end of June there will be a company trip to Barbados. Everyone who wishes to go should contact Mrs Julie Jones.

The trip will be free to all company staff and their spouses. However you must ensure that you bring enough money to pay for lunches and drinks.
```

c) Press **ESC** to turn off insert mode.

6 **Delete Text**

You do not need to worry about making mistakes when you are using the word processor, as you can easily delete letters, words, or entire lines.

a) Find the **CTRL** key on the keyboard. This is the CONTROL key. You use the CONTROL key, in conjunction with other keys, to initiate Uniplex commands.

The CONTROL key may have a different name according to the keyboard you have. If you are unsure which is the CONTROL key, ask the System Administrator.

When you initiate commands using the CONTROL key, you must press it at the same time as another key (like using the SHIFT key to enter a capital letter).

b) Use the arrow keys to move the cursor to the **J** of **Julie**.
c) Press the **CTRL** key and **c** together six times.

Uniplex deletes the word **Julie** from the screen. Notice how Uniplex closes up any spaces that are created.

Uniplex has other commands which let you delete text. See *Delete Text* for details.

### 7 The Command Menu

a) Find the key marked F2. This is a *function key* used to display the command menu at the top of the screen.

b) Press F2

Uniplex displays the command menu which is used to access many Uniplex features:

```
UNIPLEX          TAB  FL66 #1  3:12
Layout  Edit  File  Goto  Search  Tools  Print  Options  Undo
Rulers,Format,Page,Effect,Set_Font,Uppercase-lowercase,Comments
L........T........T........T........T........T........T........R
```

The Layout option is highlighted.

The top line of the command menu shows the main menu options. The second line shows the submenu attached to the highlighted option.

Move the highlight along the menu using the left and right arrows. Notice that as each option is highlighted a submenu or prompt for that option appears on the second line.

To select an option from the command menu, you enter the first letter of the option you require or press down arrow when the highlight is on the option you require.

c) Press the **ESC** key, then **q**, to leave the command menu.
Worked Example

8 Undo Mistakes

If you enter a Uniplex command by mistake, you can always undo the effect of the command. For example, if you delete a whole line of text by mistake, you can retrieve it just as quickly.

a) Move the cursor to any line of text on the screen.

b) Press F2 to display the command menu.

c) Press e to select the Edit option.

d) Press d to select the Delete option.

e) Press t to select the This_Line option

Uniplex deletes the whole line.

You realize now that you did not mean to delete the line.

a) Press F2 to display the command menu.

b) Press u to select the Undo option.

Uniplex retrieves the line you deleted.

If you made any mistakes when you first entered the text, correct them now. You can insert and delete text and use the arrow keys to make changes to the paragraphs. If the paragraph becomes unevenly arranged on the screen, do not worry as you will correct this later in the worked example.
9 Reformat Text

The format of the text is the way it appears on the screen. Generally Uniplex formats text according to the ruler above it. However, if you insert or make changes to text, it may become arranged unevenly on the screen.

To make the text appear correctly again, you can reformat it.

a) Use the arrow keys to move to any position on the first paragraph.

b) Press F2 to display the command menu.

c) Press I to select the Layout option.

d) Press F to select the Format option.

e) Press P to select the Paragraph option.

Uniplex automatically reformats the paragraph so that it is displayed evenly on the screen.

10 Save and Name a Document

You can save the text you have written, then return to it later if you want to change it or add to it.

a) Press F1 to save and exit the file.

At the top of the screen, Uniplex prompts for a name for the document.

b) Enter example.wp and press RETURN.

Uniplex saves the document using the name example.wp and returns you to the Word Processor menu. You can return to the document at any time and change it as required.
11 Edit a Document

Returning to a document that already exists, even if you only want to read it, is known as editing.

You can edit the example document you have created and make changes to it.

a) Select the Edit a Document option from the Word Processor menu.
   Uniplex prompts for a document name and automatically enters the name of the last document you worked with.

b) Press RETURN to edit the example.wp document.
   Uniplex displays the example document in the word processor screen.

12 Move a Block of Text

One of the most useful features of the word processor is the ability to move blocks of text from one area of a document to another. This is particularly useful when you are writing draft versions of a document. You can restructure information without having to retype it.

Moving text is a two stage process, first you select and cut out the text you want to move, then you move to another part of the document and paste it in. This is why it is also known as cutting and pasting.

a) Use the arrow keys to move the cursor to the E of the word Everyone in the first paragraph.

b) Press F2 to display the command menu.

c) Press e to select the Edit option.
d) Press \textbf{m} to select the Move option.

e) Press \textbf{s} to select the Sentence option.

Uniplex removes the sentence from the screen and prompts you to move to the position you want to move the text to.

a) Use the arrow keys to move the cursor to the beginning of the second blank line below the last paragraph.

b) Press RETURN.

Uniplex displays the paste options on the command menu.

c) Press \textbf{i} to select the Insert option.

Uniplex inserts the text at the current position.

d) Use the arrow keys to move the cursor onto the first letter of the sentence you have just inserted.

e) Press \textbf{CTRL} and \textbf{f} together, then press \textbf{p}.

Uniplex reformats the sentence.

In addition to moving text within a document, you can also copy it or move it to another document or application. See \textit{Cut and Paste} for details.

\section*{13 Scroll the Screen}

In addition to moving the cursor around the screen, you can also scroll text on the screen. This is useful if you want to see part of a document that is not currently visible on the screen.

a) Press \textbf{CTRL y} to scroll up one line. You can see the document move past the top edge of the screen.
**Worked Example**

b) Press **CTRL v** to scroll down one line. You can see the complete document reappear on the screen.

Try using these commands several times and watch the text move up and down the screen.

14 **Center Text**

You can easily center text on the screen. This is particularly useful if you are entering headings.

a) Use the arrow keys to move to the beginning of the top line of the document.

b) Press F2 to display the command menu.

c) Press **e** to select the Edit option.

d) Press **I** to select the Insert option.

e) Press **I** to select the Line option.

Uniplex creates a blank line above the text.

f) Repeat the above steps to create another blank line.

You can now enter the text you want to center.

a) Use the arrow keys to move the cursor to the top left of the screen.

b) Enter **Summer Trip**

c) Press F2 to display the command menu.

d) Press **e** to select the Edit option.

e) Press **I** to select the Line_Format option.
f) Press `c` to select the Center option.

Uniplex centers the line.

15 Effect Text

In addition to making changes to text and moving blocks of text around, you can also effect text. When you effect text, you specify a way that the text is shown when it is printed. For example, you can effect text in **bold** or *italic*.

a) Use the arrow keys to move to the `S` of the word Summer in the title.

b) Press F2 to display the command menu.

c) Press `l` to select the Layout option.

d) Press `e` to select the Effect option.

e) Press `s` to select the Start option.

Uniplex displays a pick and point list of the available effects.

f) Press `a` to indicate that you want the text effected in bold.

Normally Uniplex highlights from the cursor position to the end of the current line. You now have to specify the area you want to effect.

a) Press **ESC** then the **right arrow** key.

Uniplex moves the cursor to the end of the line. You may not be able to see the cursor if the text is highlighted.

> *Using the up arrow key to specify the area you want effected turns the effect off.*

b) Press F2 to display the command menu.
Worked Example

c) Press I to select the Layout option.

d) Press e to select the Effect option.

e) Press e to select the End option.

Uniplex turns off the effect at the end of the heading. When you print the document the title will be shown in **bold**.

16 Draw Boxes

One of Uniplex’s time saving features is the drawing boxes facility. This is useful when you want to draw diagrams or emphasize a piece of text by enclosing it in a box.

a) Move the cursor to the S of Summer in the title.

b) Press F2 to display the command menu.

c) Press e to select the Edit option.

d) Press i to select the Insert option.

e) Press I to select the Line option.

Uniplex enters a blank line above the heading. You can now draw a box around it.

a) Move the cursor one space to the left, so it is one space to the left and one space above the heading.

b) Press F2 to display the command menu.

   c) Press t to select the Tools option.

   d) Press b to select the Box/Draw option.

   e) Press b to select the Box option.
Uniplex prompts you to move to the top left corner of the box and press RETURN.

f) As you are already in the correct position, press RETURN.

Uniplex prompts you to move to the bottom right corner of the box and press RETURN.

g) Move the cursor to the line below the final letter of the heading, then move it one space to the right.

h) Press RETURN.

Uniplex encloses the heading within a box.

17 Spell Check a Document

Before you produce a printed version of the document, it is a good idea to ask Uniplex to check for any spelling errors. This is particularly useful if you have written a long document or report.

a) Press F2 to display the command menu.

b) Press t to select the Tools option.

c) Press s to select the Spell option.

d) Press a to select the All option.

Uniplex automatically checks the text for spelling errors. If Uniplex does not find any errors, it displays a message to tell you it has completed the task.

If Uniplex finds any errors, follow the instructions at the top of the screen to make any necessary corrections.
18 Print your Document

When you are satisfied with the document, you can produce a printed copy of it.

a) Press F2 to display the command menu.

b) Press p to select the Print option.

c) Press p to select the Print option.

Uniplex produces a printed copy of the document. It looks like this:

```
Summer Trip
```

At the end of June there will be a company trip to Barbados.

The trip will be free to all company staff and their spouses. However you must ensure that you bring enough money to pay for lunches and drinks.

Everyone who wishes to go should contact Mrs Jones.

d) Press the ESC key, then press e to exit the document.
BASIC
WORD PROCESSING
**BASIC WORD PROCESSING**

This section is designed to give you all the information necessary to create and save a basic Uniplex Word Processing document.

It explains how to access the Word Processor, how to enter text in a document, how to check the spelling and how to save and name it. It also gives details of basic editing commands such as deleting text, inserting text and undoing the last command.

This section contains the following subsections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Document</td>
<td>Explains how to create a new Word Processing document.</td>
</tr>
<tr>
<td>Screen Components</td>
<td>Explains the different elements of the Word Processor screen including the status line, the softkey menu and the command menu.</td>
</tr>
<tr>
<td>Command Menu</td>
<td>Explains how to use the command menu to access Word Processing features.</td>
</tr>
<tr>
<td>Edit an Existing Document</td>
<td>Explains how to access an existing Word Processor document so you can edit it.</td>
</tr>
<tr>
<td>Move the Cursor</td>
<td>Explains how to move the cursor around the document and scroll the screen using the command menu and key commands.</td>
</tr>
<tr>
<td>Enter Text</td>
<td>Explains how to enter text in a document, end a line and end a page.</td>
</tr>
</tbody>
</table>
## BASIC WORD PROCESSING

<table>
<thead>
<tr>
<th>Section</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Text</td>
<td>Explains how to insert spaces in the document and switch between insert and overwrite mode when editing text.</td>
</tr>
<tr>
<td>Delete Text</td>
<td>Explains how to delete small or large pieces of text.</td>
</tr>
<tr>
<td>Undo a Command</td>
<td>Explains how to use the Undo command to correct the effect of commands you have used by mistake.</td>
</tr>
<tr>
<td>Redraw the Screen</td>
<td>Explains how to refresh the screen.</td>
</tr>
<tr>
<td>Check Spelling</td>
<td>Explains how to check all or part of the document for spelling and grammatical errors.</td>
</tr>
<tr>
<td>Dictionary Management</td>
<td>Explains how to create and maintain personal supplementary dictionaries.</td>
</tr>
<tr>
<td>Save and Name a Document</td>
<td>Explains how to save, name, copy and quit the document.</td>
</tr>
<tr>
<td>Printing</td>
<td>Explains where to look for details of printing the documents from within the word processor or from a menu.</td>
</tr>
</tbody>
</table>
Create a Document

You store work you do in the Word Processor in *documents*. Each time you start a new piece of work Uniplex automatically creates a new document for it. When you finish working on a new document, you save it and provide the document with a name.

A document can be any size from a letter to a book. If you are working on a long document, such as a large book, it is a good idea to divide your work into several documents. For example, each chapter of a book can be contained in one document.

To create a document:

- Select the Create a Document option from the Word Processor menu.

Uniplex displays the Word Processing screen. For example:

```
UNIPLEX   TAB   PL66   #1   1:1
Print Style and Printer: Fixed-pitch, printer 1
<-End Pre-styled Document Format->
```

You can now enter text in the new document. See *Enter Text* for details.
Screen Components

The Word Processor Screen is made up of three sections:

- **The Information Lines.** The first four lines at the top of the screen which display information about the document, the current ruler and the command menu.

- **The Text Area.** The area between the top and bottom of the screen in which you enter the text.

- **The Softkey Menu.** The last line of the screen from which you can access the most common word processor features.

Information Lines

The first four lines of the screen display information about the current document. For example:

```
UNIPLEX myfile    INSERT    TAB    PL66   #1   4:53
L......T......T......T.......T.......T.......T......R
```

The top line is the *status line*. It displays information about the current status of the document. The following is a summary of this information:

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNIPLEX</td>
<td>The name of the word processor you are using.</td>
</tr>
<tr>
<td>myfile</td>
<td>The name of the current document. If you have not named the document this field is blank.</td>
</tr>
</tbody>
</table>
### Screen Components

<table>
<thead>
<tr>
<th><strong>Example</strong></th>
<th><strong>Explanation</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INSERT</strong></td>
<td>Your current operating modes. Uniplex displays the modes that are currently active. See <em>Operating Modes</em> for more details.</td>
</tr>
<tr>
<td><strong>TAB</strong></td>
<td></td>
</tr>
<tr>
<td><strong>AUTO-</strong></td>
<td></td>
</tr>
<tr>
<td><strong>JUSTIFY</strong></td>
<td></td>
</tr>
<tr>
<td><strong>HYPHEN</strong></td>
<td></td>
</tr>
<tr>
<td><strong>PL66</strong></td>
<td>The current page length. The number of lines available on the current page.</td>
</tr>
<tr>
<td><strong>#1</strong></td>
<td>The number of the page you are currently working on.</td>
</tr>
<tr>
<td><strong>4</strong></td>
<td>The current cursor position. You can alter this to display the line and column number, for example 4:53 (line 4 column 53), only the line, for example 4, or neither. See <em>Operating Modes</em> for details of how to change this display.</td>
</tr>
<tr>
<td><strong>4:53</strong></td>
<td></td>
</tr>
</tbody>
</table>

The two lines immediately below the status line are where the command menu is displayed. See *Command Menu* for details about the command menu.

The line beneath these two lines displays the current ruler. As you move the cursor across a ruler line, this line changes to display the new ruler. See *Rulers* for details about rulers and how to use them.
Screen Components

Text Area

The text area is the area of the screen between the information lines and the softkey menu in which you enter the text. See Enter Text for details of how to enter text in this area.

When creating a new document, Uniplex can automatically include document format details. For more information about this see Save Printer Information.

Softkey Menu

The last line on the screen is the softkey menu. It gives you access to seven of the most common word processing features. This means that you need only press one key to access these features. See Softkeys in the Getting to Know Uniplex chapter for details of how to use the softkey menu.

You can use the softkey menu to access the following features:

<table>
<thead>
<tr>
<th>Softkey</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1=Save&amp;Exit</td>
<td>Saves the current document and returns you to the Word Processor menu.</td>
</tr>
<tr>
<td>F2=Menu</td>
<td>Displays the command menu on the information lines.</td>
</tr>
<tr>
<td>F3=Preview</td>
<td>Creates a Preview display of the current document on the screen.</td>
</tr>
</tbody>
</table>

The F3 softkey was previously used to access the last-used command menu. To do this now use the key sequence Esc gl.
<table>
<thead>
<tr>
<th>Softkey</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4=Quit</td>
<td>Quits from the current document without saving.</td>
</tr>
<tr>
<td>F5&gt;Draw</td>
<td>Displays the draw softkey menu.</td>
</tr>
<tr>
<td>F6=EasiPrint</td>
<td>Prints the current document using the default printer settings.</td>
</tr>
<tr>
<td>F7&gt;Effects</td>
<td>Displays the effects softkey menu.</td>
</tr>
<tr>
<td>F8&gt;</td>
<td>Displays further softkey options.</td>
</tr>
</tbody>
</table>

For more details about these features see the sections that follow.
Command Menu

You can access all the features of the Word Processor using the command menu. When you access the command menu it is displayed at the top of the screen.

To access the command menu, either:

- Press F2 to display the command menu at the top of the screen, with the first option highlighted. For example:

```
UNIPLEX user3.basics TAB PL43 #9 15:13
Layout Edit File Goto Search Tools Print Options Undo
Rulers,Format,Page,Effect,Set_Font,Uppercase-lowercase,Comments
....L.....T.....T....T...T...T...T...T...T...R
```

or

- Press **ESC gl** to display the command menu at the top of the screen, with the last option you selected highlighted.

  Although you use **F2** to access the main command menu, you can now alternatively use the key sequence **Esc gm**.

The first line of the command menu shows the main menu options. Below each main menu option there are a number of suboptions, the suboptions attached to the highlighted option are displayed on the second line of the command menu.

You can move the highlight along the menu using the left and right arrow keys or the SPACEBAR. As each option is highlighted, suboptions or a prompt for that option is displayed on the line below.
You can select options from the command menu in one of two ways. Either:

- Move the highlight onto the option you require and press RETURN or Down Arrow.

  or

- Enter the initial letter of the option you require. For example if you want to select the Layout option, enter l.

When you select an option from the command menu Uniplex either displays a suboptions menu or performs a task. For example, if you select the Layout option, Uniplex displays the Layout suboptions:

Rulers Format Page Effect Set_Font Uppercase-Lowercase Comments
Recall, Create, Save

If you select the Undo option Uniplex undoes the last command you gave.

To return to the previous menu from a submenu press the up arrow.

To quit from the command menu at any level press ESC q.

See Appendix A at the end of these manuals for a map of the command menu, showing how to reach each option.

If you prefer to use softkeys rather than options from a command menu see the System Administrator for details of replacing the command menu with softkeys.
Edit an Existing Document

You can easily access any existing document so you can edit it.

To edit an existing document:

1. Select the Edit a Document option from the Word Processor menu.

   Uniplex prompts for the name of the document you want to edit.

2. Either:

   a. Press RETURN to access the document you were previously editing.

      or

   b. Enter the name of the document you want to edit and press RETURN.

      or

   c. Press the DOWN ARROW to display a list of all the documents in the current folder. Move the highlight onto the document you require and press RETURN.

Uniplex displays the first screen of the document you selected.

For details of how to edit an existing document while using the word processor, see *Clear Current Document*. 
◆ Move the Cursor

The cursor is usually a blinking rectangle of light. It marks the current position on the screen. Sometimes it is an underscore or a cross. The cursor marks the current working position. The point at which you will enter the next piece of text or Uniplex performs the next command.

As you enter text the cursor moves across the screen. You can also move the cursor around the screen without entering any text. You do this by using the command menu, key commands or using the arrow keys.

◊ Command Menu

To move the cursor around the document using the command menu you use the Goto option. You can then use the Goto suboptions to move the cursor quickly to different parts of the document. To access the Goto suboptions:

1. Select the Goto option from the command menu.

Uniplex displays the Goto suboptions:

```
Down  Up  End  Top  Sentence  Paragraph  Number  Bookmark
Move down a screen
```
Move the Cursor

The following table explains the function of each suboption.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Down</td>
<td>Moves the cursor down one screen.</td>
</tr>
<tr>
<td>Up</td>
<td>Moves the cursor up one screen.</td>
</tr>
<tr>
<td>End</td>
<td>Moves the cursor to the end of the document.</td>
</tr>
<tr>
<td>Top</td>
<td>Moves the cursor to the top of the document.</td>
</tr>
<tr>
<td>Sentence</td>
<td>Displays the Sentence suboptions:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Start</th>
<th>End</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Start</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Start</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Start</td>
</tr>
</tbody>
</table>

Start

Moves the cursor to the beginning of the current sentence.

End

Moves the cursor to the end of the current sentence.

Next

Moves the cursor to the beginning of the next sentence.
### Move the Cursor

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paragraph</strong></td>
<td>Displays the Paragraph suboptions:</td>
</tr>
<tr>
<td></td>
<td><strong>Start End Next</strong></td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>Moves the cursor to the beginning of the current paragraph.</td>
</tr>
<tr>
<td><strong>End</strong></td>
<td>Moves the cursor to the end of the current paragraph.</td>
</tr>
<tr>
<td><strong>Next</strong></td>
<td>Moves the cursor to the beginning of the next paragraph.</td>
</tr>
<tr>
<td><strong>Number</strong></td>
<td>Moves the cursor to the top of the page you specify.</td>
</tr>
<tr>
<td></td>
<td>Uniplex prompts for the page you require. Enter the page number and press RETURN.</td>
</tr>
<tr>
<td><strong>Bookmark</strong></td>
<td>Displays the Bookmark suboptions.</td>
</tr>
<tr>
<td></td>
<td><strong>Create Find</strong></td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Creates a bookmark above the current line.</td>
</tr>
<tr>
<td><strong>Find</strong></td>
<td>Moves the cursor to an existing bookmark.</td>
</tr>
</tbody>
</table>
Move the Cursor

Key Commands

In addition to using the Command Menu options to move the cursor around the document you can also use the *arrow keys* and Key Commands as a quicker alternative. The arrow keys are the keys marked with direction arrows, usually to the right of the keyboard, they move the cursor one character space or line, in the direction they point.

The following table details the tasks you can perform using Key Commands:

<table>
<thead>
<tr>
<th>Task</th>
<th>Key Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td></td>
</tr>
<tr>
<td>Move to the top of the document.</td>
<td>ESC t</td>
</tr>
<tr>
<td>Move to the bottom of the document.</td>
<td>ESC b</td>
</tr>
<tr>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>Move to the first character of the page.</td>
<td>ESC p s</td>
</tr>
<tr>
<td>Move to the last character of the page.</td>
<td>ESC p e</td>
</tr>
<tr>
<td>Move to beginning of the next page.</td>
<td>ESC p n</td>
</tr>
<tr>
<td>Move to the beginning of a specific page.</td>
<td>ESC p p n</td>
</tr>
<tr>
<td>Paragraph</td>
<td></td>
</tr>
<tr>
<td>Move to the beginning of the current paragraph.</td>
<td>ESC ESC b s</td>
</tr>
<tr>
<td>Move to the end of the current paragraph.</td>
<td>ESC ESC b e</td>
</tr>
<tr>
<td>Move to the beginning of the next paragraph.</td>
<td>ESC ESC b n</td>
</tr>
<tr>
<td>Sentence</td>
<td></td>
</tr>
<tr>
<td>Move to the beginning of the current sentence.</td>
<td>ESC ESC s s</td>
</tr>
<tr>
<td>Move to the end of the current sentence.</td>
<td>ESC ESC s e</td>
</tr>
<tr>
<td>Move to the beginning of the next sentence.</td>
<td>ESC ESC s n</td>
</tr>
</tbody>
</table>
### Move the Cursor

<table>
<thead>
<tr>
<th>Task</th>
<th>Key Command</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line</strong></td>
<td></td>
</tr>
<tr>
<td>Go to the beginning of the current line.</td>
<td>ESC Left Arrow</td>
</tr>
<tr>
<td>Go to the end of the current line.</td>
<td>ESC Right Arrow</td>
</tr>
<tr>
<td><strong>Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Move to the next tab position.</td>
<td>TAB</td>
</tr>
<tr>
<td>Move to the previous tab position.</td>
<td>CTRL g or BACKTAB</td>
</tr>
<tr>
<td><strong>Word</strong></td>
<td></td>
</tr>
<tr>
<td>Move to the previous word.</td>
<td>CTRL p</td>
</tr>
<tr>
<td>Move to the next word.</td>
<td>CTRL n</td>
</tr>
<tr>
<td><strong>Screen</strong></td>
<td></td>
</tr>
<tr>
<td>Move to the top of the current screen.</td>
<td>ESC Up Arrow</td>
</tr>
<tr>
<td>Move to the bottom of the current screen.</td>
<td>ESC Down Arrow</td>
</tr>
<tr>
<td>Move to the top left of the current screen.</td>
<td>ESC CTRL t</td>
</tr>
<tr>
<td>Move to the last character on the screen.</td>
<td>ESC CTRL b</td>
</tr>
</tbody>
</table>
Move the Cursor

◊ Scroll Text

As well as moving the cursor around the document you can also scroll through the document. Scrolling lets you move through the document a line or a screen at a time.

When you scroll up or down one line, Uniplex moves the current screen up or down one line and leaves the cursor in its current position.

When you scroll up or down a whole screen, Uniplex displays the next or previous screenful of text on the screen. You can scroll through the document using either the Command Menu or Key Commands.

The following table details how to scroll through the document using the command menu.

<table>
<thead>
<tr>
<th>Task</th>
<th>Command Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll text up one screen.</td>
<td>Goto Up</td>
</tr>
<tr>
<td>Scroll text down one screen.</td>
<td>Goto Down</td>
</tr>
</tbody>
</table>

The following table details how to scroll through the document using key commands:

<table>
<thead>
<tr>
<th>Task</th>
<th>Key Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll text up one line.</td>
<td>CTRL y</td>
</tr>
<tr>
<td>Scroll text down one line.</td>
<td>CTRL v</td>
</tr>
<tr>
<td>Scroll text up one screen.</td>
<td>CTRL u</td>
</tr>
<tr>
<td>Scroll text down one screen.</td>
<td>CTRL d</td>
</tr>
</tbody>
</table>
◆ Enter Text

The cursor shows next character position as you type. It moves automatically to the start of each new line and takes the current word with it if that word won’t fit on the previous line. This is called *word wrap*. Here the word *Australasia* won’t fit at the end of the line:

```
UNIPLEX TAB PL66 #1 1:64
L......T......T......T......T......T......T......T........R
<-End Pre-styled Document Format->
Print Style and Printer: Fixed-pitch, printer 1
We are sure the company headquarters will be located in Aus
```

As you continue typing the word, Uniplex moves both the cursor and the word to the beginning of the next line. For example:

```
UNIPLEX TAB PL66 #1 1:13
L......T......T......T......T......T......T......T........R
<-End Pre-styled Document Format->
Print Style and Printer: Fixed-pitch, printer 1
We are sure the company headquarters will be located in Australasia.
```
Enter Text

Uniplex arranges the text according to the current ruler. This is known as formatting. To change the format of the text, you simply change the current ruler. See Rulers for more details about rulers.

End a Line

You only need to end a line if you are entering a list of words or ending a paragraph as Uniplex automatically wraps to the next line when entering text in a paragraph. Press RETURN to end a line. Uniplex moves the cursor to the beginning of the next line.

You can insert a hard return marker to permanently mark the end of a line. This ensures that Uniplex always breaks the line at this point when you print or reformat the document (i.e., if you are entering a list with no spaces between each line or ending a paragraph with no blank line before the next paragraph).

Press ESC RETURN to enter a hard return marker at the current cursor position (usually shown as a tilde "˜"). See Operating Modes for details of how to force a hard return every time you press the RETURN key.

End a Page

By default Uniplex ends a page every 66 lines. It automatically calculates the number of lines on the page and inserts a page break at the point where each new page begins.

For example:

.............................................(memo.23 #2 PL66)
The page break gives you a summary of the document up to this point. It displays information about the document name, the current page number and current page length. The table below explains this information:

<table>
<thead>
<tr>
<th>Example</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>memo.23</td>
<td>Your current document name. If you have not named the document this is left blank.</td>
</tr>
<tr>
<td>#2</td>
<td>The number of the page you have just completed.</td>
</tr>
<tr>
<td>PL66</td>
<td>The length, in lines, of the page you have just completed.</td>
</tr>
</tbody>
</table>

You can alter the positioning of the page break in one of two ways. You can either change the page length (see Change Page Length for details) or insert a forced page break. To add a forced page break:

1. Move the cursor to the left hand edge of the screen on the line on which you want to break the page.
2. Select the following options from the command menu:

   Edit → Insert → Page_Break

   or

   Enter .PA on a new line and press RETURN

Uniplex enters a forced page break at this point in the document. For example:

**Forced Page Break**

................................................................. (memo.23 #2 PL66)
Enter Text

To delete this command once you have entered it:

1. Move the cursor onto the same line as the command.

2. Select the following options from the command menu:
   - Edit ➔ Edit-Print
   - Press . (period)

   Uniplex prompts you to confirm that you want to delete the command.

3. Select Yes to delete the command.
   - or
   - Select No to return to the document.
■ Insert Text

While you are editing a document you can insert text or blank space anywhere within an existing area of text. You can either insert individual sections of text or switch into insert mode so that you can insert any amount of text you require.

The following sections explain how to insert text in the document.

◇ Space

To insert a single space:

1. Move the cursor to the position at which you want to insert a space.

2. Select the following options from the command menu:

   Edit ➔ Insert ➔ Character

   or

   Press CTRL e

Uniplex inserts a space at the current cursor position and pushes existing text to the right. For example:

Before inserting a space:

Hawaii is in the PacificOcean

After inserting a space:

Hawaii is in the Pacific Ocean
WORD PROCESSOR

Insert Text

◊ Blank Line

To insert a single blank line:

1. Move the cursor to the position at which you want to insert a blank line.

2. Select the following options from the command menu:

   - **Edit** → **Insert** → **Line**

   or

   - Press **CTRL o**

Uniplex inserts a blank line at the current cursor position and moves the existing text down one line. For example:

Before inserting a line:

```
The view from the top of the Eiffel Tower in Paris is one of the most famous in Europe.
You can see all of Paris’ famous landmarks including Notre Dame and the Seine.
```

After inserting a line:

```
The view from the top of the Eiffel Tower in Paris is one of the most famous in Europe.
```

```
You can see all of Paris’ famous landmarks including Notre Dame and the Seine.
```
Blank Lines

To insert a number of blank lines:

1. Move the cursor to the position at which you want to insert the blank lines.

2. Select the following options from the command menu:

   Edit → Insert → Blank-lines

   or

   Press ESC a b

Uniplex inserts blank lines into the document from the current cursor position to the bottom of the screen.

Insert Mode

When you enter text in a document you usually enter it in overtype mode. This means that any text you enter overwrites any existing text. However, at any time, you can switch into insert mode. This means that instead of overwriting existing text, it is automatically pushed to the right as you enter new text.

You can switch between overwrite and insert mode as often as you require in an editing session.

The following examples illustrate the differences between using insert and overwrite mode.
The distance, in travel time, between Europe and the USA has never been shorter than it is today and the numbers of people travelling between the two continents has never been greater than in the last year.

If you enter the text, or of a more diverse nature, while in overtype mode with the cursor positioned at the beginning of the word, than, in the last line, the screen is as follows:

The distance, in travel time, between Europe and the USA has never been shorter than it is today and the numbers of people travelling between the two continents has never been greater or of a more diverse nature
If you enter the same text while in insert mode, the screen appears as follows:

<table>
<thead>
<tr>
<th>UNIPLEX</th>
<th>INSERT</th>
<th>TAB</th>
<th>PL66</th>
<th>#1</th>
<th>4:42</th>
</tr>
</thead>
<tbody>
<tr>
<td>L......</td>
<td>T......</td>
<td>T......</td>
<td>T......</td>
<td>T......</td>
<td>T.......</td>
</tr>
</tbody>
</table>

Print Style and Printer: Fixed-pitch, printer 1

The distance, in travel time, between Europe and the USA has never been shorter than it is today and the numbers of people travelling between the two continents has never been greater or of a more diverse nature than in the last year.

To switch to insert mode, while in overtype mode:

1. Select the following options from the command menu:
   
   Edit ➔ Insert ➔ Mode

   or

   Press ESC i

   Uniplex places you in insert mode and displays the word INSERT on the status line.

To switch to overtype mode while in insert mode, simply repeat the above steps.
Delete Text

When you are editing a document you can easily delete any amount of text or blank space in the document. The following sections explain how to delete sections of text within the document.

♦ Previous Character

To delete the previous character:

- Press DEL or RUBOUT

Uniplex deletes the last character to the left of the cursor and moves the cursor one place to the left.

♦ Character

To delete a character:

1. Move the cursor onto the character you want to delete.

2. Select the following options from command menu:

   Edit ➔ Delete ➔ Character

   or

   Press CTRL c

Uniplex deletes the character the cursor is currently on and pulls text over from the right to fill the gap. You can also use this command to delete a blank space.
Delete Text

◊ **Word**

To delete a word:

1. Move the cursor onto the first character of the word if you want to delete the whole word, or any other character if you want to delete the remainder of the word to the right of the cursor.

2. Select the following options from the command menu:
   
   Edit ➔ Delete ➔ Word

   or

   Press **CTRL w**

   Uniplex deletes all or part of the word and pulls text over from the right to fill the gap.

◊ **Line**

To delete a single line:

1. Move the cursor onto the line you want to delete.

2. Select the following options from the command menu:

   Edit ➔ Delete ➔ This_Line

   or

   Press **CTRL x**

   Uniplex deletes the line the cursor is on and closes up the gap.
Delete Text

◇ Blank Lines

To delete the space up to the next line of text:

1. Move the cursor to the top of the space you want to delete.
2. Select the following options from the command menu:

   Edit ➔ Delete ➔ Blank-lines

   or

   Press ESC d b

Uniplex deletes a maximum of 100 blank lines up to the next line of text. The ESC d b command may be issued as many times as required.

◇ Right of Cursor

To delete text from the current cursor position up to the end of the current line:

1. Move the cursor to the point on a line from which you want to delete text.
2. Select the following options from the command menu:

   Edit ➔ Delete ➔ Right

   or

   Press ESC d r

Uniplex deletes all the text from the current cursor position to the end of the line.
**Left of Cursor**

To delete text from the beginning of a line up to the current cursor position:

1. Move the cursor to the point on a line up to which you want to delete text.

2. Select the following options from the command menu:

   - Edit ➔ Delete ➔ Left

   or

   Press ESC d l

   Uniplex deletes all the text from the beginning of the line up to the current cursor position.

**Sentence**

To delete a sentence:

1. Move the cursor onto the sentence you want to delete.

2. Select the following options from the command menu:

   - Edit ➔ Delete ➔ Sentence

   Uniplex deletes the sentence the cursor is on.
Delete Text

Text Block

To delete a block of text:

1. Move the cursor to the beginning of the block you want to delete.

2. Select the following options from the command menu:
   - **Edit ➔ Delete ➔ Area**
   - Uniplex prompts you to move to the end of the block you want to delete.

3. Move the cursor to the bottom right corner of the block you want to delete and press RETURN.
   - Uniplex deletes the block you select.
Undo a Command

If you use a word processor command by mistake, or change your mind about the last command you used, you can undo the effect of that command. For example, if you delete a line by mistake you can retrieve the line by undoing the command.

You can undo the effect of any command including deleting text, inserting text, formatting text, and moving the cursor. Uniplex only undoes the effect of the last command you performed. For the undo to be effective you must use it immediately after the command you want to undo. To undo the last command:

- Select the following option from the command menu:
  - *Undo*

  or

  Press **ESC u**

  Uniplex undoes the effect of the last command.

Redraw the Screen

When using the Word Processor, the text on the screen may occasionally become mixed up, due to a broadcast message from another user, or some other interference.

You can easily redraw the information on the screen. This does not change any of the text in the document, but simply refreshes the original screen and removes any interference. To redraw the screen:

- Press **ESC v**

  Uniplex redraws the screen.
Check Spelling

You can check the spelling of the words in the document using the Uniplex spell checker. Uniplex stops at any word it cannot find in the dictionary. You can then choose to replace the word, ignore it, or add it to a dictionary—for the current occurrence only or for all occurrences in the document.

You can either check the spelling of the whole document or a specific area using the default language dictionary and current supplementary dictionaries unless you specify otherwise.

A language dictionary is the main dictionary Uniplex uses to spell check the document. Your system may have more than one language dictionary available enabling you to change language depending on the text you are spell checking. You can change the language dictionary you use at any time and as many times as you like in the documents.

A supplementary dictionary is a dictionary which includes words not contained in the language dictionaries. When you spell check a document you can create and use up to three supplementary dictionaries at one time. You can have up to 24 supplementary dictionaries on your system.

System-wide Supplementary dictionaries may have been created by the System Administrator which relate to specific subjects, such as legal or medical work. See the System Administrator for details of the supplementary dictionaries available on your system.

To change the language dictionary and supplementary dictionaries see Change Language Dictionary and Change Supplementary Dictionaries.

You can only change the language dictionary if you have more than one installed on your system. See the System Administrator for details of the dictionaries available to you.
When Uniplex encounters a word that is misspelled or is not present in the dictionary, it displays a number of options on the screen. For example:

<table>
<thead>
<tr>
<th>UNIPLEX</th>
<th>TAB PL66 #1 1:1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select: t 2 3 4 5 Skip Ignore Edit Global Add-dict Quit</td>
<td></td>
</tr>
<tr>
<td>1= outstanding, 2=outspending, 3=outspanning, 4=outspreading</td>
<td></td>
</tr>
</tbody>
</table>

England has many outstanding Cathedrals including:
- Salisbury
- Lincoln
- St. Albans
- Liverpool
- Coventry
- and St. Pauls

The following table describes each of the options available to you:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>Press n, where n represents one of the numbered alternative spellings displayed below the status line, to replace the misspelled word with an alternative. Uniplex makes the replacement and continues checking through the document.</td>
</tr>
<tr>
<td>Skip</td>
<td>Select this option to skip a word. This is useful if you are using special terms in a document which you do not want to add to a supplementary dictionary.</td>
</tr>
<tr>
<td>Ignore</td>
<td>Select this option to skip all occurrences of a word in the document.</td>
</tr>
</tbody>
</table>
### Check Spelling

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Select this option to replace the misspelled word with a completely different alternative. Uniplex displays an input line on which you can enter the alternative. Enter the alternative and press RETURN to make the replacement.</td>
</tr>
<tr>
<td><strong>Global</strong></td>
<td>Select this option to display the global options. Then select one of the following global options:</td>
</tr>
<tr>
<td>$n$</td>
<td>Press $n$, where $n$ represents one of the numbered alternatives displayed below the status line, to replace all occurrences of the misspelled word with an alternative.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Select this option to replace all occurrences of the misspelled word with a completely different alternative. Uniplex displays an input line on which you can enter the alternative. Enter the alternative and press RETURN to make the replacement.</td>
</tr>
<tr>
<td><strong>Quit</strong></td>
<td>Select this option to quit the spell checking session.</td>
</tr>
<tr>
<td><strong>Add-dict</strong></td>
<td>Select this option to add a word to a special document which you can subsequently use to update a supplementary dictionary. The word is then ignored for the remainder of the spelling session.</td>
</tr>
<tr>
<td><strong>Quit</strong></td>
<td>Select this option to quit the spell checking session. When you do this Uniplex leaves the cursor on the last word that it found and returns you to the document.</td>
</tr>
</tbody>
</table>
When you spell check a document Uniplex also displays error messages when it encounters the following grammatical errors:

<table>
<thead>
<tr>
<th>Message</th>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Contains Invalid Character</td>
<td>The word contains a character which is not an alphabetic character (including accented characters if they are part of the language), a period (.), an apostrophe (’), a hyphen (-), or a slash (/).</td>
</tr>
<tr>
<td>Spelling Error in Part of Compound Word</td>
<td>The word is a compound word, linked with hyphens, and at least one of the sections is misspelled:</td>
</tr>
<tr>
<td></td>
<td>state-of-the-art</td>
</tr>
<tr>
<td>Word Repetition</td>
<td>The word has been entered twice one after the other:</td>
</tr>
<tr>
<td></td>
<td>the the shop</td>
</tr>
<tr>
<td>Improper Capitalization</td>
<td>The word is improperly capitalized:</td>
</tr>
<tr>
<td></td>
<td>LONdon</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>The word is an uncapitalized proper noun:</td>
</tr>
<tr>
<td></td>
<td>london</td>
</tr>
<tr>
<td></td>
<td>In this case Uniplex offers an alternative with correct capitalization.</td>
</tr>
</tbody>
</table>
Check Spelling

<table>
<thead>
<tr>
<th>Message</th>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>✎ The following two errors only occur if you are using a French or Canadian French dictionary.</td>
<td></td>
</tr>
<tr>
<td>Invalid Word Combination</td>
<td>The word is an invalid combination of verbs, pronouns and nouns:</td>
</tr>
<tr>
<td></td>
<td>parlez-je</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>j’autobus</td>
</tr>
<tr>
<td>Invalid Use of Apostrophe</td>
<td>The word contains an incorrect apostrophe:</td>
</tr>
<tr>
<td></td>
<td>qu’femme</td>
</tr>
</tbody>
</table>

When Uniplex encounters one of these grammatical errors, it displays the relevant error message and spelling options, shown earlier in this section.

◊ Spell Check a Whole Document

Select these options from the command menu to spell check a whole document:

Tools ➔ Spell ➔ All

or

1 Press ESC t

2 Press ESC $

Uniplex checks the spelling of the document and highlights any spelling or grammatical errors.
◊ **Spell Check from Current Position**

To spell check a document from the current cursor position select the following options from the command menu:

Tools ➔ Spell ➔ Remainder

or

Press ESC $

Uniplex checks the spelling of the document from the current cursor position to the end of the document and highlights any spelling or grammatical errors.

◊ **Spell Check a Block of Text**

To spell check a block of text:

1. Move the cursor to the top left-hand corner of the text.
2. Select the following options from the command menu:

   Tools ➔ Spell ➔ Block

   or

   Press ESC (

3. Move the cursor to the bottom right-hand corner of the text.
4. Press RETURN

   or

   Press ESC ) o s

Uniplex checks the spelling of the area you mark and highlights any spelling or grammatical errors.
Check Spelling

Change Language Dictionary

If your system has more than one language dictionary installed, you can specify which language dictionary you want to use, and where in the document you want to use it. See the System Administrator for details of the dictionaries available on your system.

For example, you can spell check one page of the document using the British English dictionary and another using the French dictionary. To change language dictionary:

1. Move the cursor to the position in the document at which you want to change language dictionary.

2. Select the following options from the command menu:
   
   Tools → Spell → Language

   Select Language
   044 British
   001 American
   033 French
   049 German
   039 Italian
   002 Canadian-French
   045 Danish
   031 Dutch
   047 Norwegian
   034 Spanish
   351 Portuguese
   358 Finnish
   046 Swedish
3 Uniplex displays a pick and point list of the language dictionaries available, preceded by their language code.

- The order of the Language List may vary based on installation files and available dictionaries.

4 Select the language dictionary you require and press RETURN.

Uniplex places a change language command in the document containing the language code and language dictionary name to change to. For example:

- Select Language : 044 British

This command changes the dictionary to British English. It does not affect which supplementary dictionaries Uniplex uses.

5 If you want to change the dictionary again, or you want to return to using the original dictionary, move the cursor to the appropriate point in the document and repeat these steps.

You can now spell check the document. Uniplex changes the language dictionary it uses to spell check the document when it reaches each change language command.

- You can also change the dictionary by entering a .UP command at any point in a document, using the format .UP 1 n, where n is the language code of the dictionary. The System Administrator can tell you which dictionaries are available to you.

To edit this command once you have entered it:

1 Move the cursor onto the same line as the command.

2 Select the following options from the command menu:

   Edit ➔ Edit-Print
Check Spelling

or

Press . (period)

Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN or press CTRL x RETURN to delete the command value.

✎ To delete the entire command, move cursor onto the same line as the command then press CTRL x.

Change Supplementary Dictionaries

Uniplex uses the current supplementary dictionaries as well as the specified language dictionaries when spell checking. A supplementary dictionary is one which includes any additional words not contained in the language dictionary. For example, if you write legal documents you can set up a legal supplementary dictionary to include specific legal words. See the System Administrator for details of the supplementary dictionaries available on your system.

✎ Supplementary dictionaries remain current unless specifically changed and are not affected by the language dictionary.

You can use up to three supplementary dictionaries at a time when you spell check a document. For example, if you use three different language dictionaries in a document, you can use three supplementary dictionaries, one for each language. To change a supplementary dictionary:

1 Select the following options from the command menu:

   Tools ➔ Spell ➔ Dictionaries

   Uniplex displays the Change Supplementary Dictionaries form. This shows the current supplementary dictionaries and provides three fields you complete to change them.
Complete this form as follows. Press the SPACEBAR to scroll to the option you require and the arrow keys to move between the fields. Press any character key to display a pick and point list of the available options in each field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Option/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Field</td>
<td>1st Dictionary Changes the first supplementary dictionary.</td>
</tr>
<tr>
<td></td>
<td>2nd Dictionary Changes the second supplementary dictionary.</td>
</tr>
<tr>
<td></td>
<td>3rd Dictionary Changes the third supplementary dictionary.</td>
</tr>
<tr>
<td>Second Field</td>
<td>Delete Removes the dictionary set in the first field</td>
</tr>
<tr>
<td></td>
<td>Replace with Replaces the dictionary selected in the first field with the one selected in the third field.</td>
</tr>
<tr>
<td>Third Field</td>
<td>The supplementary dictionary to be added if the Replace with option was selected in the second field, otherwise this field is ignored.</td>
</tr>
</tbody>
</table>
Check Spelling

3 When the form is as you require, press ESC e. Uniplex makes the supplementary dictionary you select current. Repeat if you want to change other supplementary dictionaries.

You can now spell check the document. Uniplex uses the current supplementary dictionaries when it spell checks the document.

◊ Skip Spell Checking

You can skip any section of the document when spell checking.

1 Move the cursor to the beginning of the section you want Uniplex to ignore.

2 Select the following options from the command menu:

   Tools ➔ Spell ➔ Stop

   or

   Enter .UP 2 0 in the left-hand margin.

   Uniplex enters a stop spelling command:

   Stop Spell Checking

To restart the spell check:

1 Move the cursor to the end of the section to be ignored.

2 Select the following options from the command menu:

   Tools ➔ Spell ➔ Go

   or

   Enter .UP 2 1 in the left-hand margin.
Uniplex enters a restart spelling command:

**Start Spell Checking**

To delete either of the above commands:

1. Move the cursor onto the same line as the command.
2. Select the following options from the command menu:
   - **Edit** ➔ **Edit-Print**
   - or
   - Press . (period)

   Uniplex prompts for the new value for the command.

3. Enter the new value for the command and press RETURN or press **CTRL x** then RETURN to delete the command value.

   To delete the entire command, move cursor onto the same line as the command then press **CTRL x**.
Dictionary Management

The following subsections describe how to create and maintain personal supplementary dictionaries.

✎ The System Administrator follows a similar procedure to create system-wide supplementary dictionaries.

tridges a Supplementary Dictionary

To create a supplementary dictionary:

1. From the Word Processing Menu, choose Dictionary Management.


Uniplex displays the Create a Dictionary form, which requests the dictionary name, language, and type.

3. Complete the form as follows. To change an entry, press any key to display a list of choices and choose the one you require.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dictionary Name</td>
<td>Type the name for the dictionary using a maximum of 40 characters.</td>
</tr>
<tr>
<td>Dictionary Language</td>
<td>Choose the language you require from one installed on your system.</td>
</tr>
<tr>
<td>Dictionary Type</td>
<td>Choose Local for a personal dictionary. The System Administrator can set this to System to create a dictionary for all users.</td>
</tr>
</tbody>
</table>
Press F1 (Esc e) to create the dictionary.

Before you can use a supplementary dictionary, you must make it current. See Change Supplementary Dictionaries.

**Update a Supplementary Dictionary**

When you spell check a document, you can select the Add-dict option to add a word to the dictionary. This option copies the word to a file called addtodict in your home folder. You can edit this file to add words to, or delete words from, one of the supplementary dictionaries. After editing the file, you can update the appropriate supplementary dictionary.

To edit and update a supplementary dictionary:

1. From the Word Processing Menu, choose Dictionary Management.
2. From the Dictionary Management menu, choose Edit New Words. Uniplex opens the addtodict file and displays each entry you have added. The entries are shown in the format: \textit{n word}, where \textit{n} is the language code and \textit{word} is the word to be added to the dictionary.
3. If you want to add a new word:
   a) Move the cursor to a new line.
   b) Type the language code and the word to add.

   For example:

   \textbf{044 Uniplex}
4 If you want to delete a word:
   
   a) Move the cursor to the end of the word to delete.

   b) Type < immediately after the word.

   For example:

   \texttt{044 color<}

5 When the file is as you require, press \textbf{F1 (Esc e)} to save it.

Uniplex redisplays the Dictionary Management menu.

6 From the Dictionary Management menu, choose \textbf{Update Selected Dictionary}.

Uniplex displays the Update Supplementary Dictionary form.

7 Complete the form as follows. To change an entry, press any key to display a list of choices and choose the one you require.

   \begin{tabular}{|l|l|}
     \hline
     \textbf{Field} & \textbf{Description} \\
     \hline
     Dictionary to Update & Choose the supplementary dictionary to update. \\
     Remove Word List after Update & Choose \texttt{no} to update the dictionary and leave the \texttt{addtodict} file unchanged. \\
     & Choose \texttt{yes} to update the dictionary and delete the contents of the \texttt{addtodict} file. \\
     \hline
   \end{tabular}

8 Press \textbf{F1 (Esc e)} to update the dictionary.
Set Hyphenation Breaks

You can choose hyphenation breaks for new words by updating the hyphenations file. There is one hyphenations file per language.

For example, if you add the word *spacebar* to a supplementary dictionary, you can allow Uniplex to hyphenate the word at a specific point if it has to. If you do not set a hyphenation break in a word, Uniplex never breaks the word across lines.

To set hyphenation breaks:

1. From the Word Processing Menu, choose **Dictionary Management**.
2. From the Dictionary Management menu, choose **Add Hyphenation Breaks**.
   
   Uniplex opens the hyphenations file, which is currently blank.
3. Type each word on a separate line, beginning with the relevant language code, and typing a soft-hyphen (Esc % -) at its acceptable hyphenation point. For example:

   044 space-bar

4. Press **F1 (Esc e)** to save the file.

   Assuming an average word length of 15 characters, there is a limit of approximately 1,000 words per hyphenations file. There is one hyphenations file for each language.
Save and Name a Document

You can save a document at any time during an edit session. You can also:

- Save the document and continue working on it.
- Quit from the document without saving it.
- Save the document and exit from the current session.
- Make a copy of the document in a separate document.

You should ensure that you save all the work you want to keep, even if you have only made a few changes to the document. When you save a new document for the first time you also have to name it. The following sections give details of how to save and name documents.

Name a Document

Each time you save a new document Uniplex prompts for a name for it. For example:

Enter document name (DOWNARROW for File Manager): [______________]

When you name a document use a name which reflects its contents. For example, if the document contains details of United States trade figures, call it `us.trade`. Other document naming rules are:

- Do not exceed fourteen characters.
- Uppercase and lowercase letters are not equivalent. For example, a document named `japan` will not be found if you enter `JA-PAN`. It is often better to use letters of only one case to avoid confusion.
Save and Name a Document

- Do not use any of the following characters:
  - asterisk (*)
  - comma (,)
  - question mark (?)
  - slash (/)
  - space ( )

Save Changes and Continue

If you are working on a large document or you are doing a particularly intricate piece of work, you can save the document at any point without quitting from the document. This is useful if you are working on a system which could go offline without warning.

It is recommended that you use this command at least once every ten minutes to safeguard your work. Any changes you have made to the document will then be safe even if your system fails.

- Select the following options from the command menu to save changes and continue:
  - File ➔ Save
  
or
  - Press ESC w

The cursor remains in position and the document is saved if it was named previously. You are prompted to enter a name if one is required. Enter a name and press RETURN. The cursor remains in position and the document is saved.
Save and Name a Document

◊ Quit without Saving

An editing session may be ended at any time without saving if no changes have been made or if you do not wish to save the current changes. This is also useful if a document is opened in error. To quit without saving:

1. Select the following options from the command menu:

   File → Quit

   or

   Press ESC q

   Uniplex displays the Quit options on the command menu.

2. Select the Yes option (or *) to quit from the document or select the No option to return to the document. The document is closed without saving any changes from the current session. The document is deleted if it is new (not saved previously).

   To abandon the command press RETURN. The quit command is dropped and the current session resumes.

◊ Save and Exit

When you have finished working on a document you can save it and return to the Word Processor menu. Select the following options from the command menu to save changes and exit from the document:

   File → Exit

   or

   Press ESC e
Save and Name a Document

The document is saved and closed if it was named previously. You are prompted to enter a name if one is required. Enter a name and press RETURN. The document is saved and closed. Uniplex returns to the Word Processor menu.

◊ Copy a Document

An exact copy of the current document may be saved into another, separate document. One use of this feature is to make a backup copy before making extensive changes to the original. To make a copy of the current document:

1 Select the following options from the command menu:

   File ➔ Duplicate

   or

   Press ESC s x

   Uniplex prompts for a name for the copy.

2 Enter a name and press RETURN.

   Uniplex makes a copy of the document, with the name you specified, and returns you to the original.
You can print any document you create using the word processor, either from within the word processor, using the command menu and softkeys, or from any Uniplex menu using the Printing option. From within the word processor you can:

- **Easiprint.** Print a document using the default print settings.
- **Print Using Form.** Print a document using the Print Form to specify the print requirements.
- **Print to Screen.** Display a preview of the document on the screen as it will be printed.

See the Printing chapter for more details.

**Save Printer Information**

Documents created with UBS V8.10 or later are called Pre-styled documents and include document format details which define the initial ruler and store the print style and printer name. This formatting information makes it easier to successfully print documents created by another user. The initial ruler controls printing until another ruler is found in the text. See Print a Pre-styled Document for more information.

Whenever you create a new document, the document format details are automatically added to the top of the document. These details show the name of the default print style and printer. For example:
Printer details appear as a Select Language command and are ignored while the initial ruler appears at the top of the document and does apply when a Pre-styled document is opened in a version of UBS prior to V8.10.

The printer details are taken from your defaults at the time you create the document. If you change your printer defaults while in a document, the changes are not reflected in the document’s format details. You can either edit the format details or remove them and then insert the new details.

A document can have only one set of document format details. Therefore, if you merge one Pre-styled document into another, Uniplex ignores the second document’s format details and shows Redundant Pre-styled Document Format in its place. However, the second document’s initial ruler is added to the main document for formatting purposes.

Documents created with versions of Uniplex earlier then Version 8.10 do not automatically become Pre-styled documents. However, you can add the document format details to one of these documents to make it a Pre-styled document.

Change Document Format Details

Recall document format details to change the print style, the printer name, the initial ruler, or to remove the document’s format details:

1. Open the document for editing.

2. If you want to change the document’s initial ruler, position the cursor below the ruler with which to replace it.

   Position the cursor below the ruler to make it current.
Printing

From the command menu, choose:

Print ➔ Format

Uniplex displays the Document Format pop-up. For example:

<table>
<thead>
<tr>
<th>Document Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Style</td>
</tr>
<tr>
<td>Printer Class</td>
</tr>
<tr>
<td>Set to Current Ruler</td>
</tr>
<tr>
<td>Remove Document Format</td>
</tr>
</tbody>
</table>

4 Complete the pop-up as follows. To change an entry, press any key to display a list of choices and choose the one you require.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Style</td>
<td>The originator’s default print style.</td>
</tr>
<tr>
<td>Printer Class</td>
<td>The originator’s default printer.</td>
</tr>
<tr>
<td>Set to Current Ruler</td>
<td>Replace the document’s initial ruler with the current ruler.</td>
</tr>
<tr>
<td>Remove Document Format</td>
<td>Remove the document format details.</td>
</tr>
</tbody>
</table>

5 To confirm the changes, press F1 (Esc e).
Uniplex updates the document format details accordingly:

Print Style & Printer: Prop-space,prtr2
<-End Pre-styled Document Format->
To: Tim

◊ **Add Document Format Details**

You can add document format details to any existing document. Once you do so, the document becomes Pre-styled.

To add document format details:

1. Open the document for editing.

2. If you want to replace the default initial ruler with a specific one in the document, position the cursor below the ruler so that it takes effect.

3. From the command menu, choose:

   **Print ➔ Format**

   Uniplex displays the Document Format pop-up.
Printing

4 To overwrite the default ruler with the current one, scroll the Set to Current Ruler field to Yes.

If you want to change further format details, see Change Document Format Details.

5 To add the document format details, press F1 (Esc e).

◊ Print a Pre-styled Document

When printing a Pre-styled document using EasiPrint, Uniplex prints on the default printer using the print style in the document format details. When printing a Pre-styled document using the Print Form, by default, Uniplex will use the print style in the document format details. You can, however, override this and print using any other print style. For details of these options see the Printing chapter.

◊ Turn Off Document Format

By default, Uniplex adds document format details to any new documents that you create. You can turn this facility off if you prefer:

1 From the Word Processor command menu, choose:

   Options ➔ Modes

2 Scroll the Generate Style Information field to No.

3 If you want to permanently save this setting, scroll the Save Options & Rulers field to Yes.

4 Press F1 (Esc e).

◊ Send a Printer Command

You can send commands directly to the printer while a document is being printed to operate special printer features, such as fonts, paper bins or output trays not directly supported by Uniplex.
- **SN Command.** Sends a command to the printer at once, such as a font change in the middle of a page.

- **ST Command.** Sends a command to the printer as the first line of the current page when it must take effect before any lines are printed on that page. Many printers require that all commands be sent at the top of page (a command in the middle of a page will not take effect until the start of the next page).

- **SB Command.** Sends a command to the printer as the last line of the current page. This is used for commands that must take effect exactly at the end of a page. More typically it would be used to reset a previous command used higher on that page.

Use the following syntax for printer code commands:

```
.SN code or .ST code or .SB code
```

where `code` is the printer command sequence. There is no standard for these codes. You will need to consult the documentation for your specific printer to determine which codes it uses for each individual function.

A Uniplex printer definition file (Pcap) entry may include a keyword which is used to send a command to the printer. The keyword may then be used in place of the actual command sequence in the .SN, .ST, or .SB commands. For example, most Uniplex printer definitions provide a facility to print change bars in the document using the keywords **CS, CC, and CE**:

- **SNCS.** Start single change bar.
- **STCC.** Start continuous change bar.
- **SBCE.** End change bar.
Document Preview

Print to screen now includes a command menu. This makes it simpler and more intuitive to use.

To print the current document to the display:

1. Either press **F3** or choose the following options from the command menu:

   - **Print ➔ Display**

   For Pre-styled documents, the Print to Display pop-up opens in which you can specify how to display the document.

   For example:

<table>
<thead>
<tr>
<th>Print to Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Style</td>
</tr>
<tr>
<td>Printer Class</td>
</tr>
<tr>
<td>Remember Choice</td>
</tr>
</tbody>
</table>

2. Complete the pop-up as follows. To change an entry, press any key to display a list of choices and choose the one you require.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Style</strong></td>
<td><strong>From Document</strong>: Displays the document using the print style defined in the document format details.</td>
</tr>
<tr>
<td></td>
<td><strong>Default</strong>: Displays the document using the default print style.</td>
</tr>
</tbody>
</table>
**Document Preview**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printer Class</strong></td>
<td><strong>Default</strong>: Displays the document using the default printer setup.</td>
</tr>
<tr>
<td></td>
<td><strong>From Document</strong>: Displays the document using the printer defined in the document format details, if available. If a suitable printer cannot be found, Uniplex uses your default printer.</td>
</tr>
<tr>
<td><strong>Remember Choice</strong></td>
<td><strong>Yes</strong>: Remembers the chosen print style and printer whenever you re-invoke Print to Screen.</td>
</tr>
<tr>
<td></td>
<td><strong>No</strong>: Redisplays this pop-up for you to confirm the print style and printer settings each time you re-invoke Print to Screen.</td>
</tr>
</tbody>
</table>

*Remember Choice is for the current document only. When you open another document and choose Print to Display, the print style and printer settings return to their defaults.*

3 When the pop-up is complete, press F1 (Esc e).

Uniplex displays the formatted document on the screen. You can move around the document, search for a character or text string, and toggle between the document and the print to display version. For details, see the following subsections.

4 To close the print to screen document, choose Quit from the command menu. Alternatively, press F4 (Esc q) twice.

✎ You will not be able to switch processes (ESC xd) or activate the Uniplex Desk (ESC 9) or Utilities (ESC 12) popup menus while in Preview Mode.
Move around the Screen

You can move around the displayed document using the cursor-movement keys. To move into the displayed document:

Press ↑

The cursor moves into the print to screen document. You can move around the document but you cannot make any changes. You can toggle between the print to screen document and the Word Processor document using Esc xe. To return to the Print to Screen command menu:

From the print to screen document, press F2.

You can also move around the print to screen document using the following command menu actions:

- **Down** Displays the next screen of the current page.
- **Up** Displays the previous screen of the current page.
- **Next_Page** Displays the next page of the document.
- **Previous_Page** Displays the previous page of the document.
- **Edit_Mode** Moves from the print to screen document to the Word Processor document. To return to the print to screen document, without taking account of any changes made in the document, choose:

  Print ➔ Return_to_Display
Goto and Find

Using the Find command menu option, you can go straight to a specific page, go to the start or end of the document, or find a character or text string within the document, up to a maximum of 42 characters. To go to a specific place in the document:

1. From the command menu, choose Find.

2. From the Find submenu, choose the appropriate option:
   - **Start**: Moves to the first line of the document.
   - **End**: Moves to the last line of the document.
   - **Page**: Goes to the page number you specify.

To find a specific piece of text:

1. From the command menu, choose Find.

2. From the Find submenu, choose the appropriate option.
   - **Forwards**: Searches forwards through the document.
   - **Backwards**: Searches backwards through the document.
   - **Next**: Searches for the next occurrence of a previously-defined search.

If you chose **Forwards** or **Backwards**, Uniplex prompts for the text you want to search for.

3. If prompted, type the search string and press Return. Uniplex finds the first occurrence of the text, if any.

4. To find the next occurrence of text, choose **Next** from the command menu, or press Esc n.
CHANGE YOUR WORK
CHANGE YOUR WORK

This section shows you how to improve the appearance of your work. It explains how to change the way the text is laid out, repeat text at the top and bottom of every page, number parts of the document automatically, copy and move areas of text around the document, and print the text with different effects.

<table>
<thead>
<tr>
<th>Section</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rulers</td>
<td>Explains how to change the layout of the text using Uniplex rulers.</td>
</tr>
<tr>
<td>Convert Case</td>
<td>Explains how to convert UPPER case text to lower case and lower case to UPPER case.</td>
</tr>
<tr>
<td>Hard Characters</td>
<td>Explains how to enter hard spaces and hard tabs in the document to ensure the format is retained at print time.</td>
</tr>
<tr>
<td>Headers and Footers</td>
<td>Explains how to enter text in the document so that it prints at the top or bottom of every page. For example, a chapter title or company name.</td>
</tr>
<tr>
<td>Numbering</td>
<td>Explains how to automatically number sections, pages and paragraphs of the document when you print it.</td>
</tr>
<tr>
<td>Change Page Length</td>
<td>Explains how to change the number of lines on each page of the document.</td>
</tr>
<tr>
<td>Section</td>
<td>Contents</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cut and Paste</td>
<td>Explains how to reorganize the document by copying, moving and deleting areas of text.</td>
</tr>
<tr>
<td>Merge</td>
<td>Explains how to merge other documents print time and as you are editing. Also explains how to merge the result of an operating system command. For example, the current date, or a list of files.</td>
</tr>
<tr>
<td>Box Drawing</td>
<td>Explains how to draw boxes, lines and shaded areas in the document.</td>
</tr>
<tr>
<td>Line Drawing</td>
<td>Explains how to draw and erase lines using draw mode.</td>
</tr>
<tr>
<td>Effects</td>
<td>Explains how to effect text in the document. For example, in <strong>bold</strong> or <em>italic</em>.</td>
</tr>
<tr>
<td>Repeat Last Command</td>
<td>Explains how to repeat the last editing command you gave Uniplex.</td>
</tr>
</tbody>
</table>
Rulers

The *format* of the text is the way in which it is laid out, on the screen and when you print it. For example, whether the text aligns with the right hand margin of the page or the left hand margin. You format the text using *rulers*.

A ruler is a line containing a number of dots and letters which you enter in the document whenever you want to change the layout of the text. It can be between 30 and 254 characters long. Any ruler shorter than 30 characters is interpreted as a printable word. Your current ruler is displayed on the last status line. For example:

```
L......T......T......T......T......T......T......T....R
```

The letters, or characters, determine the layout of the text beneath the ruler. The dots are simply used as spacing. You can only enter valid ruler characters on the ruler line. The following table gives a brief description of the valid ruler characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>Indicates the position of the left margin.</td>
</tr>
<tr>
<td>R</td>
<td>Indicates the position of the right margin. Text appears with a ragged right margin.</td>
</tr>
<tr>
<td>J</td>
<td>Indicates the position of the right margin. Text appears with a justified right margin.</td>
</tr>
<tr>
<td>A</td>
<td>Indicates the position of the right margin. Text appears with a right aligned right margin and a ragged left margin.</td>
</tr>
<tr>
<td>M</td>
<td>Indicates the position of the right margin. Centers text between the left and right margins.</td>
</tr>
</tbody>
</table>
Rulers

<table>
<thead>
<tr>
<th>Character</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>Hangs the first word of a paragraph outside the left margin.</td>
</tr>
<tr>
<td>I</td>
<td>Indents the first line of a paragraph inside or outside.</td>
</tr>
<tr>
<td>C</td>
<td>Centers text underneath this character.</td>
</tr>
<tr>
<td>T</td>
<td>Marks the position of a tab.</td>
</tr>
<tr>
<td>#</td>
<td>Aligns decimal figures beneath this character.</td>
</tr>
<tr>
<td></td>
<td>Marks the delimiter between columns in multiple column text.</td>
</tr>
<tr>
<td>.</td>
<td>Separates the other ruler characters.</td>
</tr>
</tbody>
</table>

The following sections describe how you use each ruler character to format text in different ways. See Customize a Ruler for details of how to change a ruler.

◊ **Ragged Right Margin**

You use the ruler character R to format text with a ragged right margin. Enter the R at the position on the ruler at which you want the right margin. Uniplex will format text with a ragged right margin:

L...T.......T.......T.......T.......T.......T.......T.......T....R

The idea of introducing a common European Currency, or EMU (European Monetary Unit) for short, has caused much controversy within the European community. While many countries feel that it would save both money and time, especially for businesses, others only expect it to further promote the idea of a United States of Europe.
◊ Justified Right Margin

You use the ruler character J to format text with a justified right margin. Enter the J at the position on the ruler at which you want the right margin. Format a paragraph by pressing 

```
CTRL f p
```

Uniplex justifies the text, making the right margin straight and each line the same length:

```
```

The idea of introducing a common European Currency, or EMU (European Monetary Unit) for short, has caused much controversy within the European community. While many countries feel that it would save both money and time, especially for businesses, others only expect it to further promote the idea of a United States of Europe.

◊ Align to Right Margin

You use the ruler character A to format text aligned to the right margin. Enter the A at the position on the ruler at which you want the right margin. Uniplex will format text with a ragged left margin. Format a paragraph by pressing 

```
CTRL f p
```

Uniplex aligns the text with the right margin:

```
L...T......T......T......T......T......T......T......T......T......A
```

The idea of introducing a common European Currency, or EMU (European Monetary Unit) for short, has caused much controversy within the European community. While many countries feel that it would save both money and time, especially for businesses, others only expect it to further promote the idea of a United States of Europe.
**Rulers**

◇ **Center between Margins**

You use the ruler character **M** to format text centered between the left and right margins. Enter the M at the position on the ruler at which you want the right margin. Uniplex will format text with the right and left margins ragged. Format a paragraph by pressing **CTRL f p**. Uniplex centers the text between the two margins:

```
L...T......T......T......T......T......T......T......T.....M
```

The idea of introducing a common European Currency, or EMU (European Monetary Unit) for short, has caused much controversy within the European community. While many countries feel that it would save both money and time, especially for businesses, others only expect it to further promote the idea of a United States of Europe.

◇ **Hang First Word Outside Left Margin**

You use the ruler character **H** to format each paragraph with the first word (all the characters preceding a space) hung outside the left margin. Enter the H at the position on the ruler at which you want the hung word to start. Format a paragraph by pressing **CTRL f p**. Uniplex hangs the first word of the paragraph outside the left margin:

```
```

1 The idea of introducing a common European Currency, or EMU (European Monetary Unit) for short, has caused much controversy within the European community. While many countries feel that it would save both money and time, especially for businesses, others only expect it to further promote the idea of a United States of Europe.
◊ **Indent First Line**

You use the ruler character I to format text with the first line of each paragraph indented. Enter the I at the position on the ruler at which you want the first line of the paragraph to begin. Format a paragraph by pressing **CTRL f p**. Uniplex indents the first line of the paragraph:

L......I....T......T......T......T......T......T......T...R

The idea of introducing a common European Currency, or EMU (European Monetary Unit) for short, has caused much controversy within the European community. While many countries feel that it would save both money and time, especially for businesses, others only expect it to further promote the idea of a United States of Europe.

◊ **Hang First Line Outside Left Margin**

You use the ruler character I to format text with the entire first line of each paragraph hung outside the left margin. Enter the I at the position on the ruler at which you want the first line of the paragraph to begin. Uniplex hangs the whole of the first line of each paragraph outside the left margin:

I......L....T......T......T......T......T......T......T......T...R

The idea of introducing a common European Currency, or EMU (European Monetary Unit) for short, has caused much controversy within the European community. While many countries feel that it would save both money and time, especially for businesses, others only expect it to further promote the idea of a United States of Europe.
Rulers

Center around a Point

You use the ruler character \( C \) to center text. Enter the \( C \) at the position on the ruler beneath which you want the text centered. Press \textit{ESC} \textit{c} while the cursor is on the line you want to center:

\[
\text{L...T.......C.......T.......T.......T.......T.......T....R}
\]

Brazilian Rain Forests

Align Numbers in Columns

Use the decimal tab (\#) ruler character to format numbers in columns. Place the \# at the point on the ruler underneath which you want to align the units column of each number.

Precede each number with a \textit{hard tab} when you enter numbers beneath decimal tabs. Enter a hard tab by pressing \textit{ESC TAB}. This ensures that the layout is not altered if you reformat the document.

Enter a hard tab after entering a number if you want to go to the next decimal tab or press \textit{RETURN} if you have reached the end of the line. Uniplex aligns the units column of each number beneath the \#.

\( \text{A hard return (ESC RETURN) is required to stop a Document Format from altering the page.} \)

The following is an example of numbers aligned in columns:

\[
\text{L...T.......#.......T.......T.......T.......T.......T....R}
\]

\[
> \quad 45.56 \quad \text{\$67.89}\text{CR}
\]

\[
> \quad 654.89 \quad 54,678.9^\text{“}
\]

\[
> \quad 45.908 \quad 45.67^\text{“}
\]

\[
> \quad 457,868 \quad .876^\text{“}
\]
Preset Rulers

Uniplex contains ten preset rulers. You can access these at any time and insert them into the document to change the layout of the text. To use one of the preset rulers:

1. Move the cursor to the position at which you want the ruler.
2. Select the following options from the command menu:
   
   Layout ➔ Rulers ➔ Recall

   Uniplex displays a list of the available rulers. For example:

<table>
<thead>
<tr>
<th>Select a ruler</th>
<th>Left</th>
<th>Right</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>. = L...T...T...T...T...T...T...T...T...T...R 1 70</td>
<td>Current</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0 = L...T...T...T...T...T...T...T...T...T...R 1 70</td>
<td>Ragged R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 = L...T...T...T...T...T...R...T...J 1 70</td>
<td>Justified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 = L...T...T...T...T...T...T...T...T...T...J 1 75</td>
<td>Justified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 = L...T...T...T...T...T...T...T...T...T...R 1 75</td>
<td>Ragged R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 = ....L...T...T...T...T...T...T...T...T...T...J 9 75</td>
<td>Justified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 = ....L...T...T...T...T...T...T...T...T...T...J 9 78</td>
<td>Justified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 = ........L...T...T...T...T...T...T...T...T...R 17 78</td>
<td>Ragged R</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 = ........L...T...T...T...T...T...T...T...T...J 17 78</td>
<td>Justified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 = L...........J.L...........J.L......J 2 77</td>
<td>Multi-Col</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 = L.......T.......T.......T.......T...R 1 253</td>
<td>Wide Ruler</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Press the number which corresponds to the ruler you require, or press . (period) to repeat the current ruler.

   Uniplex inserts the ruler in the document. Any text you enter beneath the ruler is formatted according to that ruler. This ruler is only current until the cursor passes through another ruler, either forwards or backwards, in the document.
Rulers

To recall a preset ruler without using the command menu:

- Press `ESC r r n`

where `n` is the number of the ruler you want to use.

◊ Customize a Ruler

You can customize an existing ruler to meet specific formatting needs such as a table specific to one part of a document. You can customize a ruler for a single use or you can save it to use repeatedly during the current editing session. Customize a ruler by using the Create Ruler form or by editing its characters directly.

To customize a ruler using the Create Ruler form:

1. Move the cursor to the line where the ruler is needed.
2. Select the following options from the command menu:

   Layout ➔ Rulers ➔ Create

   Uniplex displays the Create Ruler form:

<table>
<thead>
<tr>
<th>Create a Ruler</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left Margin</td>
</tr>
<tr>
<td>Right Margin</td>
</tr>
<tr>
<td>Justification</td>
</tr>
<tr>
<td>First Line Indent</td>
</tr>
<tr>
<td>Hang First Word</td>
</tr>
<tr>
<td>Save as Ruler No.#</td>
</tr>
</tbody>
</table>

3-100
3 Complete the form as follows. Use the arrow keys to move between fields and the SPACEBAR to scroll to the options you require. Press any character key to display a pick and point list of the options available in each scrollable field:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Left Margin</strong></td>
<td>Enter the number of the column at which you want the left margin. For example, if you want the left margin at the left edge of the screen, enter 1.</td>
</tr>
<tr>
<td><strong>Right Margin</strong></td>
<td>Enter the number of the column at which you want the right margin. For example, if you want the right margin to be in column 70, enter 70.</td>
</tr>
<tr>
<td><strong>Justification</strong></td>
<td><strong>Ragged</strong> Formats the text with a ragged right margin. <strong>Justified</strong> Formats the text with a justified right margin. <strong>R Aligned</strong> Formats the text with a right aligned right margin. <strong>Centered</strong> Formats the text centered between the left and right margins.</td>
</tr>
<tr>
<td><strong>First Line Indent</strong></td>
<td>Enter the column number at which the first line of each paragraph should start. Uniplex indents the first line if this field is greater than the Left Margin field and hangs the first line outside the left margin if this field is less than the Left Margin field.</td>
</tr>
</tbody>
</table>
Rulers

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hang First Word</strong></td>
<td>Leave this as 0 for flush paragraphs or enter the column number at which you want the first word of each paragraph to be hung outside the left margin (the value must be less than the Left Margin field).</td>
</tr>
<tr>
<td><strong>Save as Ruler No.#</strong></td>
<td>Enter the number from 0-9 under which the customized ruler should be saved or leave blank to use the ruler once without saving it.</td>
</tr>
</tbody>
</table>

4 When the form is as you require press F1 or ESC e

Uniplex inserts the ruler at the current cursor position and saves it under the specified ruler number, if any. You can reuse the last ruler (even if not saved) by pressing ESC r r or you can use the Recall Ruler option from the Command menu followed by the number of a saved ruler.

To customize a ruler directly:

1 Move the cursor to the line where the ruler is needed.

2 Select the following options from the command menu:

   Layout ➔ Rulers ➔ Recall

   or

   Press ESC r r

   Uniplex prompts you for a ruler number between 0 and 9.

3 Enter the number of the ruler to be customized.

   Uniplex inserts that ruler on the current line.
4 You can now edit the ruler as required. Ensure that you only use the valid ruler characters as explained earlier in this section.

5 When the ruler is as you require move the cursor below it to make it current.

Diamond Save a Customized Ruler

You can save any ruler you customize for the duration of the current editing session. This is useful if you repeat a particular text layout a number of times in a document. To save a customized ruler:

1 Move the cursor onto the ruler you want to save.

2 Select the following commands from the command menu:

   Layout → Rulers → Save

   or

   Press ESC r s

   Uniplex prompts for the number by which to save the ruler.

3 Enter a number between 0 and 9.

   Uniplex replaces the previous ruler of that number with the customized ruler from the current editing session. The standard ten preset rulers are restored when you next run a Uniplex editing session.

   When creating a ruler that indents the right hand margin be sure to leave trailing dots, e.g., "R...". Some type styles have the "scale ruler" option enabled and will ignore the indent when text is printed if no dots are present after the "R".
Rulers

Save Current Rulers Permanently

If you find that you are using the same rulers often, you can save the current rulers permanently. This means that even if you quit from Uniplex, when you reinvoke it the same rulers will be current. To save the current rulers permanently:

1. Select the following options from the command menu:
   - Options ➔ Modes

2. Move the cursor to the Save Options and Rulers field and use the SPACEBAR to scroll the field to Yes.

3. Press ESC e
   
   Uniplex saves the current rulers permanently.
Temporary Left Margin

When you enter text in the document you may want to indent a paragraph from the current left margin. You can do this without entering another ruler by using hard tabs to mark the indented left margin. You can then enter the text as usual. Uniplex continues to use this margin until you press RETURN. For example:

```
L...T......T......T......T......T......T......T......R
```

The idea of building an underground railway beneath the streets of Birmingham has been around for some time, however it has never before aroused the sort of reaction that was recently heard in Parliament:

> "The idea of introducing any type of underground system in Birmingham is preposterous, pathetic and totally without foundation."

These immortal words were spoken by the Member of Parliament for the City of London.

To create a temporary left margin:

1. Move the cursor to the current left margin.
2. Press **ESC TAB**
   
   Uniplex enters a hard tab (>) and moves the cursor to the next tab position on the current ruler.
3. Continue to enter hard tabs until you reach the position at which you want the temporary left margin.

   You can now enter the text as usual. Uniplex keeps the temporary left margin until you press RETURN.
Rulers

Multiple Columns

Usually you enter text in a single column, but for greater effect when writing reports or magazine articles you can enter text in more than one column. This is especially useful if you are creating tables of text or figures. The following are examples of multiple column text with appropriate rulers:

L...T........T.....T....J  L...T........T.....T....J

The recent attempt by Although the exact causes of the Jones brothers to their failure are unclear as they cross the United States yet, it appears that they wore pogo-stick shoes through the rubber ends of abandoned only days after they left New York. They could not afford to keep on route for Los Angeles.

L...................R.L........M..L........M

<table>
<thead>
<tr>
<th>Question</th>
<th>Percentage in Favor</th>
<th>Percentage Against</th>
</tr>
</thead>
<tbody>
<tr>
<td>Should a tunnel be built beneath the English Channel?</td>
<td>53</td>
<td>47</td>
</tr>
<tr>
<td>Should there be a high speed train link between the tunnel and London?</td>
<td>75</td>
<td>25</td>
</tr>
<tr>
<td>Should the government take any responsibility for the completion of the tunnel?</td>
<td>31</td>
<td>69</td>
</tr>
</tbody>
</table>
Rulers

To create a multiple column ruler:

1. Select a ruler to customize.

2. Edit the ruler as required, using the valid ruler characters. Ensure that you mark a left and right margin for each column and that you leave at least one space between the columns.

3. When the ruler is as you require move the cursor below it to make it current.

Enter Text

You enter text in multiple columns as in a single column. When you reach the end of the column Uniplex wraps the cursor as if you had reached the end of the line in a single column.

To move the cursor between columns you use the TAB key. Press TAB to move to the next column and BACKTAB (or CTRL g) to move to the previous column.

All editing commands such as delete a line or insert blank lines work as usual within multiple columns, although joining two lines does not. If the cursor is inside a column then the command effects only that column. If the cursor is in the space between columns then the command effects all the columns.

Merged text is not formatted to the current ruler. Thus, merging from another document or glossary with dissimilar rulers can cause problems. A tip is to precede potentially dissimilar text layouts with a single column, wide ruler (e.g., Ruler 9) and then manage it down to current margins and columns.

✎ It is recommended that you do not use insert mode or cut and paste while using multiple columns as this may result in incorrect formatting.
You can ensure that if you edit text in one of multiple columns, text below the column is aligned across the page and is not disrupted. Set the Blank line to align columns field on the Operating Modes form to Yes. Uniplex ensures that any text below the columns separated by a blank line is not disrupted when you edit text in one of the columns. For example, if you try to insert a blank line in the left hand column of the following text:

Scientists are still amazed by the appearance of 10,000 large holes in and around Detroit, Michigan.

Although some were rather small, a number have appeared in roads and private property, causing much distress and concern.

Although the reason for the holes is expected to be geological, many people

that extra-terrestrial forces may be at work.

Uniplex ensures that the text in the lower columns is kept aligned:

Scientists are still amazed by the appearance of 10,000 large holes in and around Detroit, Michigan.

Although some were rather small, a number have appeared in roads and private property, causing much distress and concern.

Although the reason for the holes is expected to be geological, many people

that extra-terrestrial forces may be at work.

For details of how to set column alignment see Operating Modes.
**Delimiters**

If you require, you can reformat text which is outside the margins of a column into that column. You do this by marking the column limits using the ruler character \| (delimiter).

This is particularly useful if you are cutting and pasting text in multiple columns, or have edited a multiple column ruler so part of the text now lies outside the ruler margins.

For example, the text in both columns exceeds the column margins:

```
|...L.......T.......T...R....|...H.......L.......T.......T...J
```

Which one of these is not

- a) New York
- b) Arizona
- c) Texas
- d) Buffalo

If you reformat the text in this column, Uniplex formats all text between the delimiters into the column margins. For example:

```
|...L.......T.......T...R....|...H.......L.......T.......T...J
```

Which one of these is not an American state?

- a) New York
- b) Arizona
- c) Texas
- d) Buffalo

When you reformat text in this way, Uniplex formats all text from one space after the left hand delimiter and up to and including text under the right hand delimiter, into the multiple column margins.
Rulers

Format Boxed Text

If you enter text within a box, at print time Uniplex does not usually reformat it. This often means that when printed the box has a large amount of blank space at the right edge. For example:

On screen:

```
WARNING: If you want to use the Black Leg Pass to reach Eagle Canyon you must ensure that you take along a local guide who knows the route well and the possible dangers.
```

At print time:

```
WARNING: If you want to use the Black Leg Pass to reach Eagle Canyon you must ensure that you take along a local guide who knows the route well and the possible dangers.
```

To remove this blank space and format text within the box correctly you must ensure both the left and right margins on the ruler are within the box and there are trailing dots up to the edge of the box. For example, to make the above example print correctly you use the following ruler:

```
```

```
WARNING: If you want to use the Black Leg Pass to reach Eagle Canyon you must ensure that you take along a local guide who knows the route well and the possible dangers.
```
At print time the text appears as follows:

```
WARNING: If you want to use the Black Leg Pass to reach Eagle Canyon you
must ensure that you take along a local guide who knows the route well and the
possible dangers.
```

Uniplex reformats the text according to the left and right margins
and prints a box around it of the correct size.

The left and right margin characters on the ruler mark the position
of the text within the box. If you want to leave a space at the left or
right of the box move the left and right margin characters closer to-
gether. For example:

```
........L........T........T........T........T........T........R... 
```

```
WARNING: If you want to use the Black Leg Pass
to reach Eagle Canyon you must ensure that you
take along a local guide who knows the route well and the possible dangers.
```

At print time this text appears as follows:

```
WARNING: If you want to use the Black Leg Pass to reach Eagle Canyon you must ensure that you take along a local guide who knows the route well and the possible dangers.
```

When entering text in boxes ensure that you always enter the text
before drawing a box around it. For details of how to draw boxes
see Box Drawing.
WORD PROCESSOR

Rulers

Double Rulers

A double ruler is a ruler that consists of two rulers on sequential lines to each other. For example:

```
L..................T..................................................R
L..................T..................................................R
```

You can use double rulers to move and close up text when you print it. Each ruler has a separate function. The lower ruler specifies the layout of the text on screen and the upper ruler specifies the layout you require at print time.

For example, if you have a boxed table which extends outside the right margin, when you print the document the text will be printed over the right edge of the page. You can use a double ruler to ensure that the text prints within the right edge of the page.

You do this by entering a lower ruler showing the current layout of the table on screen and an upper ruler showing how you want the table to print. For example:

```
........L..........................T..................R
........L............................................T..................R

<table>
<thead>
<tr>
<th>Japan</th>
<th>87%</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States of America</td>
<td>64%</td>
</tr>
<tr>
<td>England</td>
<td>50%</td>
</tr>
<tr>
<td>Germany</td>
<td>23%</td>
</tr>
<tr>
<td>Holland</td>
<td>12%</td>
</tr>
<tr>
<td>Australia</td>
<td>8%</td>
</tr>
</tbody>
</table>
```

When you print the document, Uniplex lays out the text according to the upper ruler placing the text aligned beneath the tab character on the lower ruler at the equivalent tab position on the upper ruler.
Rulers

For example:

<table>
<thead>
<tr>
<th>Country</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Japan</td>
<td>87%</td>
</tr>
<tr>
<td>United States of America</td>
<td>64%</td>
</tr>
<tr>
<td>England</td>
<td>50%</td>
</tr>
<tr>
<td>Germany</td>
<td>23%</td>
</tr>
<tr>
<td>Holland</td>
<td>12%</td>
</tr>
<tr>
<td>Australia</td>
<td>8%</td>
</tr>
</tbody>
</table>

When you use double rulers there are two rules you must follow:

- Both rulers must always be the same length. Use trailing dots at the end of the upper ruler to match the lower ruler.

- Both rulers must contain the same number of tabs. Uniplex moves tab-aligned text on the lower ruler to the tab positions on the upper ruler at print time.

You can also use double rulers to overlay text on graphics. See the Printing chapter for more details.

Reformat Text

Text in a document does not always match the layout of the rulers, for example, if you insert or delete text. Making the text match the rulers is called reformating. You can either reformat the current paragraph, the next paragraph, the whole document, or the remainder of the document forward from the current cursor position. To reformat the current paragraph:

1. Place the cursor on the paragraph you want to reformat.
2. Select the following options from the command menu:
   - Layout ➔ Format ➔ Paragraph
   - or
   - Press CTRL f p
Rulers

Uniplex reformats the paragraph per the current ruler.

To reformat the next paragraph select the following options from the command menu:

Layout ➔ Format ➔ Next

Uniplex reformats the next paragraph per the current ruler.

To reformat a document select the following options from the command menu:

Layout ➔ Format ➔ All

or

Press ESC t, then press CTRL f d.

To format the document from the current cursor position select the following options from the command menu:

Layout ➔ Format ➔ Remainder

or

Press CTRL f d

Uniplex reformats the document from the current cursor position to its end, according to the rulers contained in it. This command will not reformat text in multiple columns, the text of headers and footers, or text between non-reformat commands.

Stop and Restart Reformatting

Use the Allow and Disallow Reformatting command to stop a section of the document from being changed by the Reformat Document command or at print time, especially useful if a document contains intricate tables. Stop reformatting for part of a document:
1 Move the cursor to the beginning of the area you do not want reformatted.

2 Select the following options from the command menu:

   Layout ➔ Format ➔ Stop

   or

   Enter .JN on a new line at the left of the screen.

   Uniplex enters a stop reformatting command:

   **Disallow Reformatting**

3 Move the cursor to the line after the area you do not want reformatted.

4 Select the following options from the command menu:

   Layout ➔ Format ➔ Go

   or

   Enter .JY on a new line at the left of the screen.

   Uniplex enters a restart reformatting command:

   **Allow Reformatting**

   Uniplex does not reformat the area between these commands when you reformat or print the document.

Delete a reformatting command:

1 Move the cursor onto the same line as the command.

2 Select the following options from the command menu:
Uniplex prompts you to confirm the deletion.

3 Select Yes to delete the command.

or

Select No to return to the document.

Right Align a Line

To align a single line of text with the right margin:

1 Move the cursor onto the line you want to right justify.

2 Select the following options from the command menu:

   Edit ➔ Line-Format ➔ Right

or

Press CTRL f r

Uniplex right aligns the line. For example:

   The Maple Leaf is the Canadian national emblem.

Center a Line

When you center a single line of text, Uniplex centers the line between the left and right margins, or around the ruler character C if the current ruler contains it.
To center a single line:

1. Move the cursor onto the line you want to center.

2. Select the following options from the command menu:

   Edit ➔ Line-Format ➔ Center

or

   Press ESC c

Uniplex centers the line between the left and right margins, or around the C ruler character. For example:

```
      GREAT AMERICAN LAKES

      GREAT AMERICAN LAKES
```

◇ Split a Line

If a line of text is longer than you require, you can split it so that all text in front of the current cursor position is placed on the next line. For example, before splitting a line:

```
Wastwater is the deepest lake in England.
```

After splitting a line:

```
Wastwater is the deepest lake in
England.
```

To split a single line:

1. Move the cursor to the point on the line at which you want the split to occur.
Rulers

2. Select the following options from the command menu:

   Edit ➔ Line-Format ➔ Split

   or

   Press CTRL f s

   Uniplex splits the line at the current cursor position and places all the text to the right of the cursor on the next line, pushing any text below down one line.

Join Two Lines

If you want to add two adjoining lines together you can join them. For example, before joining the lines:

   The Rhine is the longest river
   in Germany.

After joining the lines:

   The Rhine is the longest river in Germany.

To join two lines:

1. Move the cursor onto the first line of the two you want to join.

2. Select the following options from the command menu:

   Edit ➔ Line-Format ➔ Join

   or Press CTRL f j

   Uniplex joins the line below with the current line.

   Joining lines does not work on multiple column text.
Convert Case

Uniplex allows you to convert the case of any text in the document. You can convert lower case text to UPPER CASE and UPPER CASE text to lower case. For example, you convert part of the following text from lower case:

The Balaeric Islands are *spanish* territory.

to UPPER CASE

The Balaeric Islands are *SPANISH* territory.

When you convert the case of text, if the cursor is at the beginning of a word Uniplex converts the whole word. If the cursor is in the middle of a word Uniplex converts the remainder of the word. If the cursor is on a space Uniplex converts the remainder of the line.

Text

To convert text from lower to UPPER case:

1. Move the cursor to the start of the text to convert.
2. Select the following options from the command menu:

   **Edit**  ➔  **Line-Format**  ➔  **Upper**

   or

   Press **CTRL f u**

   Uniplex converts the text to upper case.

To convert text from UPPER to lower case:

1. Move the cursor to the start of the text to convert.
2. Select the following options from the command menu:
WORD PROCESSOR

Convert Case

Edit ➔ Line-Format ➔ Lower

or

Press CTRL f l

Uniplex converts the text to lower case.

Text Block

When you convert text, you can convert blocks of text as well as individual words or lines. To convert a block of text:

1 Select the following options from the command menu:

   Layout ➔ Uppercase-lowercase

   Uniplex displays the Effect suboptions.

2 Select Uppercase_convert to convert to UPPER case.

   or

   Select Lowercase_convert to convert to lower case.

   Uniplex prompts you to move to the top left corner of the block you want to convert.

3 Move the cursor to the top left corner of the block you want to convert and press RETURN.

   Uniplex prompts you to move to the bottom right corner of the block you want to convert.

4 Move the cursor to the bottom right corner of the block you want to convert and press RETURN.

   Uniplex converts the block of text.
You can convert a block of text without using the command menu:

1. Move the cursor to the top left corner of the text block.
2. Press **ESC (**
3. Move the cursor to the bottom right corner of the text block.
4. Press **ESC ) o**
5. Press **u** to convert the text to *UPPER* case or **I** to convert the text to *lower* case.
Hard Characters

Hard Characters

Hard characters are formatting commands you enter in a document which cannot be removed or altered by Uniplex when you reformat or print the document. There are three hard characters: hard space, hard tab, and hard return. For details of using hard returns see Operating Modes. You use a hard space to set a permanent space in the document or as an invisible join between two words which you do not want split over two lines. For example, hard spaces are used to force a double space between words:

Indian  Ocean

or to keep a company name all on the same line:

The following is a description of the future plans for World Domination Enterprises.

Press ESC SPACEBAR to enter a hard space. Uniplex enters a hard space at the current cursor position. The hard space marker varies depending on the way the terminal is configured. It is usually a highlighted block or line, for example: ______.

You use a hard tab to ensure columns are aligned when you print a document. If you enter a normal tab Uniplex may reformat it at print time or when you reformat the document. To enter a hard tab:

1  Ensure that the current ruler has tab characters (T) aligned above the first character of each of the columns.

2  Press ESC TAB

Uniplex inserts a hard tab at the current cursor position and moves the cursor to the next tab character. The hard tab character varies depending on the way a terminal is configured. It is usually a highlighted right arrow, for example: >.

3-122
Headers and Footer

If you want to print the same text at the top or bottom of every page in the document, such as your company name or today’s date, you can do this using headers and footers.

Text that appears at the top of each page is known as a header. Text that appears at the bottom of each page is known as a footer. You only need to enter headers and footers on one page in the document. It is only when you print the document that the headers and footers appear on every following page you specify.

You can have as many different headers and footers within a document as you require. For example, you can have a different header and footer for each chapter or section of the document.

You can include a running page number in the header or footer if you require. See Numbering for more details.

The following is an example of a header:

Page Header

World Domination Enterprises
PRIVATE AND CONFIDENTIAL

<-End Header->

The following is an example of a footer:

Page Footer

First Draft Version 5
<-End Footer->
Headers and Footers

To set a header or footer in the document:

1. Move the cursor to the top left of the first page on which you want the header or footer to appear.

2. Select the following options from the command menu:

   Layout → Page → Header/Footer

   Uniplex displays the Headers and Footers form:

<table>
<thead>
<tr>
<th>Headers and Footers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header or Footer?</td>
</tr>
<tr>
<td>[Header]</td>
</tr>
<tr>
<td>Number of Lines</td>
</tr>
<tr>
<td>[3]</td>
</tr>
<tr>
<td>Which Page?</td>
</tr>
<tr>
<td>[Both Pages]</td>
</tr>
</tbody>
</table>

3. Complete this form as follows. Use the arrow keys to move between fields and the SPACEBAR to scroll to the options you require. Press any character key to display a pick and point list of the options available in each field:

   Field                      Entry/Explanation

   **Header or Footer?**      **Header** Enters the text at the top of each page.
   **Footer** Enters the text at the bottom of each page.

   **Number of Lines**        Enter the number of lines you require for the header or footer. Enter 0 to turn off any current headers or footers.
Headers and Footers

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which Page?</td>
<td></td>
</tr>
<tr>
<td>Both Pages</td>
<td>Enters the header or footer on both pages of the document.</td>
</tr>
<tr>
<td>Left Page</td>
<td>Enters the header or footer on left (even) pages only.</td>
</tr>
<tr>
<td>Right Page</td>
<td>Enters the header or footer on right (odd) pages only.</td>
</tr>
</tbody>
</table>

4 When the form is as you require press **ESC e**.

Uniplex inserts a header or footer command of the size you specify. For example:

```
-Page Heading-
```

```
<-End Header->
```

5 Enter the text you require as the header or footer between the markers.

When you enter the header or footer text, if you realize that the header command is too big or too small, you can open and delete lines within it as necessary, using the standard insert and delete commands.

⚠️ You cannot move the cursor onto the header/footer end command.
**Headers and Footers**

You can enter headers/footers without using the command menu:

1. Move the cursor to the top left of the first page on which you want the header or footer to appear.

2. To create a header, enter:
   
   \texttt{.HE n (<)(>)} and press RETURN

   To create a footer, enter:

   \texttt{.FO n (<)(>)} and press RETURN

   Where \( n \) is the number of lines the header/footer requires, \(<\) sets the header/footer for left-hand pages only, and \( >\) sets the header/footer for right-hand pages only. Omit \(<\) and \( >\) for the header/footer to appear on all pages.

   Uniplex inserts a header/footer command as specified.

3. Enter the text you want as your header/footer between the header/footer markers.

**Delete**

To delete a header or footer:

1. Move the cursor onto the top header or footer command line.

2. Select the following options from the command menu:

   \texttt{Edit} \rightarrow \texttt{Edit-Print}

   or

   Press . (period)
Headers and Footers

Uniplex prompts you to confirm the deletion.

3 Select Yes to delete the command.

or

Select No to return to the document.

◊ Header Margin

If you want to enter some blank space between the header and the main text you use a header margin, which you enter directly after the header. To enter a header margin:

1 Move the cursor to the far left of the first line following the header text.

2 Select the following options from the command menu:

   Layout ➔ Page ➔ Layout

   Uniplex displays the page format form.

3 Move the cursor onto the Top Margin field. Enter the number of lines and press ESC e.

   Uniplex enters a header margin command in the document. For example:

   Header Margin : 3

   or

   1 Move the cursor to the far left of the first line following the header text.

   2 Enter .HMn on a new line and press RETURN where n is the number of lines required in the header margin.
Headers and Footers

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.
2. Select the following options from the command menu:
   - Edit ➔ Edit-Print
     or
   - Press . (period)
     Uniplex prompts for the new value for the command.
3. Enter the new value for the command and press RETURN.
   or
   - Press CTRL x then RETURN, to delete the command value.

   To delete the entire command, move cursor onto the same line as the command then press CTRL x.

Footer Margin

If you want to enter some blank space between the main text and the footer you use a footer margin, which you enter directly after the footer. To enter a footer margin:

1. Move the cursor to the far left of the first line following the footer text.
2. Select the following options from the command menu:
   - Layout ➔ Page ➔ Layout
     Uniplex displays the page format form.
3 Move the cursor onto the Bottom Margin field. Enter the number of lines and press ESC e.

Uniplex enters a footer margin command in the document. For example:

```
Footer Margin : 3
```

or

1 Move the cursor to the far left of the first line following the footer text.

2 Enter `.FM n` on a new line and press RETURN where `n` is the number of lines required in the footer margin.

To edit this command once you have entered it:

1 Move the cursor onto the same line as the command.

2 Select the following options from the command menu:

```
Edit ➜ Edit-Print
```

or

Press . (period)

Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN.

or

Press CTRL x then RETURN, to delete the command value.

✎ To delete the entire command, move cursor onto the same line as the command then press CTRL x.
Numbering

Using Uniplex you can number different parts of the document in different ways at print time. You can number sections, pages and paragraphs within the document automatically at print time, so you do not have to worry about adding and changing numbers every time you reorganize, or edit, the document.

When you set numbering within the document you can specify which style of numbering you want to use for numbering sections, pages and paragraphs. The following table shows the available numbering styles:

<table>
<thead>
<tr>
<th>Style</th>
<th>Character</th>
<th>Explanation</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Roman Numeral (Upper Case)</td>
<td>I, II, III, IV,...</td>
<td></td>
</tr>
<tr>
<td>r</td>
<td>Roman Numeral (Lower Case)</td>
<td>i, ii, iii, iv,...</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>English Alpha (Upper Case)</td>
<td>A, B, C, D,...</td>
<td></td>
</tr>
<tr>
<td>a</td>
<td>English Alpha (Lower Case)</td>
<td>a, b, c, d,...</td>
<td></td>
</tr>
<tr>
<td>N/n</td>
<td>Arabic Numerals</td>
<td>1, 2, 3, 4,...</td>
<td></td>
</tr>
<tr>
<td>T/t</td>
<td>Typographical Marks</td>
<td>*, +, %, &amp;,...</td>
<td></td>
</tr>
</tbody>
</table>

The style character is the character you enter when you set numbering within the document, without using the command menu. See the sections that follow for details.

Setting numbering in the document is a two stage process. Firstly you specify the style you want to use for the numbering and then you specify where you want Uniplex to enter the numbers at print time.
Section Numbering

When you number the document you can number different sections and include the section numbers in the headers and footers automatically at print time. For example, if the document is made up of three chapters you can set section numbering so that it changes with each new chapter.

As you do not actually enter the numbers for each section, if you change the position of the sections they will still be numbered in the correct order at print time.

Setting section numbering is a two phase process, first you specify the numbering style and then you specify where to place the section number in the headers and footers.

To specify the section numbering style:

1. Move the cursor to the beginning of the section you want to number. Ensure that the cursor is at the left edge of the screen.

2. Select the following options from the command menu:
   - Options ➔ Numbering

   Uniplex displays the Numbering Styles form:

<table>
<thead>
<tr>
<th>Numbering Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Number</td>
</tr>
<tr>
<td>Style</td>
</tr>
<tr>
<td>Start Numbering From</td>
</tr>
</tbody>
</table>

3-131
Numbering

3 Complete this form as follows. Use the arrow keys to move between fields and the SPACEBAR to scroll to the option you require. Press any character key to display a pick and point list of the available options in each scrolling field:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Number</td>
<td>Scroll this field to <strong>Section Number</strong>.</td>
</tr>
<tr>
<td>Style</td>
<td>Scroll this field to the numbering style you require. See the beginning of this section for details of the available styles.</td>
</tr>
<tr>
<td>Start Numbering</td>
<td>Enter the value to start numbering from (# keeps the same number as in the previous section while + increases the number by one from the previous section).</td>
</tr>
</tbody>
</table>

4 When the form is as you require press **ESC e**.

A section numbering command is entered on the current line.

To edit this command once you have entered it:

1 Move the cursor onto the same line as the command.

2 Select the following options from the command menu:

   - **Edit ➔ Edit-Print**
   - Press . (period)

   Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN or press **CTRL x** then RETURN to delete the command value.
To delete the entire command, move cursor onto the same line as the command then press \texttt{CTRL x}.

You can specify the section numbering style without using the command menu:

1. Move the cursor to the start of the section to number. Ensure that the cursor is at the left edge of the screen.

2. Enter \texttt{.NS \#S style n}, on a new line, and press \texttt{RETURN}

where \textit{style} is the style character for the numbering style you require and \textit{n} is the value to start numbering from.

To specify the section numbering position:

1. Move the cursor onto the header or footer text at the position you want the section number to print. See Headers and Footers for details about setting headers and footers.

2. Enter \texttt{\#S}

When you print the document Uniplex replaces the \texttt{\#S} with the section number in the style you specified. For example, if you enter the section number and style as follows:

\begin{verbatim}
Section Numbering Style R 2
Page Heading
Section \#S
\end{verbatim}

Uniplex prints it as follows:

\begin{verbatim}
Section II
\end{verbatim}
Numbering

Page Numbering

You can number each page of a document, including the page number automatically in headers/footers at print time. Pages will then be numbered correctly each time you print, even if you have completely reordered the document. First you pick a numbering style, then you pick a location for the page number in the header/footer. To specify a numbering style:

1 Move the cursor to the beginning of the page you want to number. Ensure that the cursor is at the left edge of the screen.

2 Select the following options from the command menu:

Options ➔ Numbering

Uniplex displays the Numbering Styles form:

<table>
<thead>
<tr>
<th>Numbering Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Number</td>
</tr>
<tr>
<td>Style</td>
</tr>
<tr>
<td>Start Numbering From</td>
</tr>
</tbody>
</table>

3 Complete this form as follows. Use the arrow keys to move between fields and the SPACEBAR to scroll to the option you require. Press any character key to display a pick and point list of the available options in each scrolling field.

4 When the form is as you require press ESC e.

A page numbering command is entered on the current line.
### Numbering

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Number</td>
<td>Scroll this field to <strong>Page Number</strong>.</td>
</tr>
<tr>
<td>Style</td>
<td>Scroll this field to the numbering style you require. See the beginning of this section for details of the available styles.</td>
</tr>
<tr>
<td>Start Numbering</td>
<td>Enter the value start numbering (# keeps the same number as in the previous page while + increases the number by one from the previous page).</td>
</tr>
<tr>
<td>From</td>
<td></td>
</tr>
</tbody>
</table>

You can specify the page numbering style without using the command menu as follows:

1. Move the cursor to the start of the page to number. Ensure that the cursor is at the left edge of the screen.
2. Enter `.NS # style n`, on a new line, and press RETURN
   where `style` is the style character for the numbering style you require and `n` is the value to start numbering from.

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.
2. Select the following options from the command menu:
   - **Edit** ➔ **Edit-Print**
     or
   - Press . (period)

   Uniplex prompts for the new value for the command.
Numbering

3 Enter the new value for the command and press RETURN.

or

Press CTRL x then RETURN, to delete the command value.

✎ To delete the entire command, move cursor onto the same line as the command then press CTRL x.

To specify the page numbering position:

1 Move the cursor onto the header or footer text at the position you want to enter the page number. See Headers and Footers for details about setting headers and footers.

2 Enter #

When you print the document Uniplex replaces the # with the page number in the style you specified.

For example, if you enter the page number and style as follows:

Page Numbering Style n 5
Page Footer
Page #
<End Footer->

Uniplex prints it as follows:

Page 5
**Force Page Numbering**

Uniplex begins numbering at page one with both the on screen page counter and when you print. You can change the current page number at any point which is useful if you split a single document into multiple files but want it numbered continuously or if you have different numbering for each chapter of a long document. To force page numbering:

1. Move the cursor to the beginning of the page from which you want to change the page numbering.

2. Select the following options from the command menu:
   
   Layout ➔ Page ➔ Set_Number

   Uniplex prompts for the starting page number.

3. Enter the page number and press RETURN.

   or

   Enter `.PNn` on a new line and press RETURN where `n` is the page number from which to start numbering.

   Uniplex enters a page number command in the document:

   ```plaintext
   Page Number : 30
   ```

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.

2. Select the following options from the command menu:

   Edit ➔ Edit-Print

   or
Numbering

Press . (period)

Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN.

or

Press CTRL x then RETURN, to delete the command value.

✎ To delete the entire command, move cursor onto the same line as the command then press CTRL x.

◊ Paragraph Numbering

Any paragraphs within a document can be numbered. This is useful if the document contains numbered steps or is a set of minutes, each of which needs to have a number. You can specify the levels of numbering and the numbering style at each level. You can also specify whether you want Uniplex to print all levels of numbering at the beginning of each paragraph or only the ones you specify. The following paragraphs are numbered with four levels:

A.1.I The following points arose concerning the company trip to Florida.

A.1.I.i Will we be staying in Orlando or Ft. Lauderdale?

A.1.I.ii Will accommodation include a full breakfast?

A.1.I.iii Will single rooms be available for people traveling on their own?

The following paragraphs are numbered with the last level of the previous four levels.
I The following points arose concerning the company trip to Florida.

i Will we be staying in Orlando or Ft. Lauderdale?

ii Will accommodation include a full breakfast?

iii Will single rooms be available for people traveling on their own?

Uniplex automatically numbers the paragraphs at print time so you can move them around without having to renumber. First you specify the numbering styles and then you specify where to place the paragraph numbers. To specify the paragraph numbering style:

1 Move the cursor to the beginning of the first paragraph to number. Ensure that the cursor is at the left edge of the screen.

2 Select the following options from the command menu:

   Options ➔ Paragraph_Numbers

Uniplex displays the Paragraph Numbering form:

<table>
<thead>
<tr>
<th>Paragraph Numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Mode</td>
</tr>
<tr>
<td>Reset All Levels</td>
</tr>
<tr>
<td>Level 1 Style</td>
</tr>
<tr>
<td>Level 2 Style</td>
</tr>
<tr>
<td>Level 3 Style</td>
</tr>
<tr>
<td>Level 4 Style</td>
</tr>
<tr>
<td>Level 5 Style</td>
</tr>
</tbody>
</table>
3 Complete the form as follows. Use the arrow keys to move between fields and the SPACEBAR to scroll to the option you require. Press any character to key to display a pick and point list of the available options in each scrollable field:

<table>
<thead>
<tr>
<th>Field</th>
<th>Options/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Mode</strong></td>
<td><strong>Print All Levels</strong></td>
</tr>
<tr>
<td></td>
<td>Prints all levels of paragraph numbering in each case.</td>
</tr>
<tr>
<td></td>
<td><strong>Print Last Level Only</strong></td>
</tr>
<tr>
<td></td>
<td>Only prints the last level of paragraph numbering in each case.</td>
</tr>
<tr>
<td><strong>Reset All Levels</strong></td>
<td><strong>Yes</strong></td>
</tr>
<tr>
<td></td>
<td>Begins paragraph numbering at one.</td>
</tr>
<tr>
<td></td>
<td><strong>No</strong></td>
</tr>
<tr>
<td></td>
<td>Continues to number the paragraphs with the next paragraph number.</td>
</tr>
<tr>
<td><strong>Level 1 Style</strong></td>
<td>Scroll each field to the numbering style you require. See the beginning of this section for details of the available styles.</td>
</tr>
<tr>
<td><strong>Level 5 Style</strong></td>
<td>If you specify less than five fields Uniplex ignores the other fields.</td>
</tr>
</tbody>
</table>

4 When the form is as you require press ESC e.

A paragraph numbering command is entered on the current line.

To edit this command once you have entered it:

1 Move the cursor onto the same line as the command.

2 Select the following options from the command menu:
Edit ➞ Edit-Print

or

Press . (period)

Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN.

or

Press CTRL x then RETURN, to delete the command value.

✎ To delete the entire command, move cursor onto the same line as the command then press CTRL x.

You can specify the paragraph numbering style without using the command menu as follows:

1 Move the cursor to the line before the first paragraph to be numbered. Ensure that the cursor is at the left edge of the screen.

2 Enter .NS #P styles mode [0] on a new line and press RETURN

where:

styles are the numbering styles you require for each level of paragraph numbering, separated by a period (.). For example, A.n.r.A.a .

mode can be either // to print all levels of paragraph numbering, or / to print just the last level.

0 resets all levels of paragraph numbering to zero.
Numbering

To specify the paragraph numbering position:

1. Move the cursor to the position in the paragraph at which you want to enter a number (i.e., the start of line one).

2. Enter ##n

Where n is the numbering level (i.e., enter ## 3 to enter a third level paragraph number). Uniplex replaces the ##n with the paragraph number at print time. For example, if you enter the following paragraph numbers and styles:

```
Paragraph Numbering Style:  A.n.R.r // 0
## 3  The following points arose concerning the company trip to Florida.
```

```
Paragraph Numbering Style:  A.n.R.r / 0
## 4  Will we be staying in Orlando or Miami?
## 4  Will accommodation include a full breakfast?
## 4  Will single rooms be available for people traveling on their own?
```

Uniplex prints the paragraphs as follows:

```
A.1.I The following points arose concerning the company trip to Florida.
   i  Will we be staying in Orlando or Miami?
   ii Will accommodation include a full breakfast?
   iii Will single rooms be available for people traveling on their own?
```
Force Paragraph Numbering

When you number paragraphs in the document you can force Uni-plex to number any level of paragraph numbers with a specific num-
ber. To force paragraph numbering you replace the paragraph num-
ber with the following command:

#^format.format.format....

Where format is one of the following.

#  Keeps the numbering at its current level.
+
Changes the number to n.

If you want to force a paragraph number other than the first level, you must enter a format entry in the command for all previous lev-
els. For example, if you enter the following commands:

Paragraph Numbering Style:  A.n.R.r // 0

# 4  Minutes of the last board meeting.

# 4.2 The following additional points arose concerning the company trip to Florida.

# 4.2.3 Will we be staying in Orlando or Miami?

## 3  Will accommodation include a full breakfast?

### 3  Will single rooms be available for people traveling on their own?

---
**Numbering**

Uniplex prints the paragraphs as follows:

D Minutes of the last board meeting.

D.2 The following additional points arose concerning the company trip to Florida.

D.2.III Will we be staying in Orlando or Miami?

D.2.IV Will accommodation include a full breakfast?

D.2.V Will single rooms be available for people traveling on their own?

◆ **Change Page Length**

When you create a new document Uniplex uses a default page length, this is usually 66 lines. Uniplex displays the current page length on the status line. The page length specifies the number of lines of text, including headers and footers, on each page of the document and therefore the point in the document at which Uniplex starts a new page.

If you require you can change the page length for the whole document or just a particular section. To change the page length:

1. Move the cursor to the top left corner of the first page for which you want to change the page length.

2. Select the following options from the command menu:

   Layout ➔ Page ➔ Layout

   Uniplex displays the Page Format form.

3. Move the cursor to the Page Length field.
4 Enter the page length you require and press RETURN.

or

Enter .PLn on a new line and press RETURN where n is the number of lines of text needed on each following page. Uniplex enters a page length command. For example:

Page Length : 43

To edit this command once you have entered it:

1 Move the cursor onto the same line as the command.

2 Select the following options from the command menu:

   Edit ➔ Edit-Print

or

Press . (period)

Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN.

or

Press CTRL x then RETURN, to delete the command value.

✎ To delete the entire command, move cursor onto the same line as the command then press CTRL x.
Cut and Paste

When you create or edit a document you can rearrange how the text is laid out by cutting sections of it out and pasting them in at another part of the current document or in a different document. When you rearrange the text you have a number of options:

- You can specify to cut out text serially or in blocks. You cut text serially to cut continuous lines of text and retain the continuity of the document. You cut text by block to cut rectangular areas of text that do not form complete lines, such as tables or diagrams.

- You can copy text which places a copy of the specified text in a clipboard and leaves the original text untouched.

- You can move text which places a copy of the specified text in a clipboard and removes the original text.

- You can paste the text you have cut at any position in the current document or in another document by overlaying it on existing text, inserting it between existing text, or inserting it and elbowing the existing text to the right.

The area you want to select is highlighted as you move to the right during a cut operation. Press ESC q to remove the highlight. You can cut a series of lines by marking the top left and bottom right of an area to be cut.

Text that has been cut is copied to a clipboard, a temporary internal storage area, from which it can be pasted back into the document. You can cut text to each of ten clipboards numbered 0-9 of which the default is 0. See Select a Clipboard for more details. The contents of each clipboard may be examined at any time. See View Clipboard Contents for details. The following sections explain how to cut and paste text to copy, move, or delete it.
Copy

You can copy a section of text without disturbing the original and then place the copy at a different point in the document:

1. Move the cursor to the beginning of the area you want to copy.

2. Select the following options from the command menu:
   - Edit ➔ Copy

   Uniplex displays the Duplicate suboptions:

   Line Sentence Paragraph Text Block Word

3. Select the option you require:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Copy the current line.</td>
</tr>
<tr>
<td>Sentence</td>
<td>Copy the current sentence.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Copy the current paragraph.</td>
</tr>
<tr>
<td>Text</td>
<td>Move to the end of the area to be copied and press RETURN. Copies the text serially.</td>
</tr>
<tr>
<td>Block</td>
<td>Move to the end of the area to be copied and press RETURN. Copies the text by block.</td>
</tr>
<tr>
<td>Word</td>
<td>Copy the current word. You are prompted to select the next word or to end the selection.</td>
</tr>
</tbody>
</table>

Uniplex copies the text you select to a clipboard and prompts you to move to the position in the document to which you want to copy the text.
Cut and Paste

4 Move the cursor to the position in the document to which you want to copy the text and press RETURN.

Uniplex displays the following suboptions:

Insert Overlay Elbow

5 Select:

   Insert  To insert the text you copied, at the current cursor position, between the existing text.

   Overlay To overlay the text you copied, at the current cursor position, on top of the existing text.

   Elbow    To insert the text you copied, at the current cursor position, and elbow the existing text to the right.

Uniplex places the copied text at the current cursor position.

You can use the following key commands to copy text

1 Move the cursor to the beginning of the area to copy.

2 Press ESC ( to copy by block or ESC { to copy serially.

3 Move to the end of the area to copy.

4 Press ESC ) l to copy by block or ESC } l to copy serially.

5 Move the cursor to the position to copy the text.

6 Press ESC *

7 Select the paste option you require.
Move

When you rearrange text in the document you can cut out an area of text, remove the original text and place the text at another point in the document. To move a piece of text:

1. Move the cursor to the start of the area to be moved.

2. Select the following options from the command menu:

   Edit ➔ Move

   Uniplex displays the Move suboptions:

   Line  Sentence  Paragraph  Text  Block  Word

3. Select the option you require:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Move the current line.</td>
</tr>
<tr>
<td>Sentence</td>
<td>Move the current sentence.</td>
</tr>
<tr>
<td>Paragraph</td>
<td>Move the current paragraph.</td>
</tr>
<tr>
<td>Text</td>
<td>Move to the end of the area to be moved and press RETURN. Moves the text serially.</td>
</tr>
<tr>
<td>Block</td>
<td>Move to the end of the area to be moved and press RETURN. Moves the text by block.</td>
</tr>
<tr>
<td>Word</td>
<td>Move the current word. You are prompted to select the next word or to end the selection.</td>
</tr>
</tbody>
</table>

Uniplex removes the text you select and places it in a clipboard. It then prompts you to move to the position in the document to which you want to move the text.
Cut and Paste

4 Move the cursor to the position in the document to which you want to move the text and press RETURN.

Uniplex displays the following suboptions:

Insert Overlay Elbow

5 Select:

Insert To insert the text you moved, at the current cursor position, between the existing text.

Overlay To overlay the text you moved, at the current cursor position, on top of the existing text.

Elbow To insert the text you moved, at the current cursor position, and elbow the existing text to the right.

Uniplex places the moved text at the current cursor position.

You can use the following key commands to move text:

1 Move the cursor to the start of the area to be moved.
2 Press ESC ( for block move or ESC { for serial move.
3 Move to the end of the area you want to move.
4 Press ESC ) r for block move or ESC } r for serial move.
5 Move the cursor to the desired move position.
6 Press ESC *
7 Select the paste option you require.
Cut

You can cut text to delete it, to save it in a new document, or to add it to a new document:

1 Move to the beginning of the area you want to cut out.

2 Select the following option from the command menu:

   Edit ➔ Paste

   Uniplex displays the Cut and Paste suboptions:

   Block_Cut Serial_Cut Paste Clipboard View

3 Select **Block_Cut** to cut text by block.

   Select **Serial_Cut** to cut text serially.

4 Move to the end of the area to cut and press RETURN.

   Uniplex displays the cut options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>Deletes the text you select, places it in a clipboard.</td>
</tr>
<tr>
<td>Leave</td>
<td>Leaves the text you select as it is and places a copy of it in a clipboard.</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes the text you select, places it in a clipboard and pulls existing text up to fill the gap.</td>
</tr>
<tr>
<td>Write</td>
<td>Leaves the text you select as it is and prompts for the name of a new document to copy the text to.</td>
</tr>
<tr>
<td>Append</td>
<td>Leaves the text you select as it is and prompts for the name of an existing document you want to add the text to the end of.</td>
</tr>
</tbody>
</table>
Cut and Paste

5  Select the option you require.

You can use the following key commands to cut text.

1  Move the cursor to the start of the area to be cut:

2  Press ESC ( to cut text by block or ESC { to cut text serially.

3  Move to the end of the area you want to cut.

4  Press ESC ) to cut text by block or ESC } to cut text serially.

   Uniplex displays the cut suboptions.

5  Select the option you require.

◊ Paste

Once you have cut out an area of text, you can paste it into the current document, or any other document, at any position. To paste in the cut text:

1  Move to the position at which you want to insert the text. This does not have to be the same document as the text was cut from.

2  Select the following options from the command menu:

   Edit ➔ Paste ➔ Paste

   or

   Press ESC *

   Uniplex displays the paste suboptions.
3 Select:

- **Insert** To insert the text in the clipboard, at the current cursor position, between the existing text.

- **Overlay** To overlay the text in the clipboard, at the current cursor position, on top of the existing text.

- **Elbow** To insert the text in the clipboard, at the current cursor position, and elbow the existing text to the right.

Uniplex places the pasted text at the current cursor position.

◊ **Select a Clipboard**

When you move, copy or cut and paste any text, Uniplex places the text you select in a clipboard. Uniplex has ten clipboards. By default Uniplex places any text you select in clipboard 0 (zero). If you want to ensure that the clipboard contents are not overwritten, or you want to use a piece of text you have cut out repeatedly, you can select another clipboard.

⚠ You must always select the clipboard before cutting out or pasting in text, if you do not want to use the default clipboard.

To select a clipboard:

1. Select the following options from the command menu:
   
   **Edit ➔ Paste ➔ Clipboard**
   
   or
   
   Press **ESC #**
   
   Uniplex prompts for the number of the desired clipboard.

2. Enter a number between 0 and 9. The default is 0.
WORD PROCESSOR

Cut and Paste

When you perform a cut or paste action, Uniplex uses the clipboard you have selected instead of the default.

◊ View Clipboard Contents

If you are unsure of the current contents of the clipboards you can view them on the screen. To view the clipboard contents select the following options from the command menu:

   Edit → Paste → View

Uniplex displays the current contents of the ten clipboards. For example:

<table>
<thead>
<tr>
<th>View Cut &amp; Paste Buffers</th>
</tr>
</thead>
<tbody>
<tr>
<td>0: 0 All of these options are possible if you live south of</td>
</tr>
<tr>
<td>1: 0 There is little doubt that the systematic destruction</td>
</tr>
<tr>
<td>2: &quot; (not in use)</td>
</tr>
<tr>
<td>3: 0 If your car does not run on unleaded gas, then you</td>
</tr>
<tr>
<td>4: &quot; (not in use)</td>
</tr>
<tr>
<td>5: 0 Opportunities for businesses within Europe after 2000</td>
</tr>
<tr>
<td>6: 0 South America has become the focus of attention for</td>
</tr>
<tr>
<td>7: &quot; (not in use)</td>
</tr>
<tr>
<td>8: &quot; (not in use)</td>
</tr>
<tr>
<td>9: &quot; (not in use)</td>
</tr>
</tbody>
</table>

To view all of the contents of a particular clipboard simply move the cursor onto the number of the clipboard you want to see. Use the RIGHT ARROW to scroll down through its contents and LEFT ARROW to scroll up.

◊ Uniplex saves the contents of a clipboard until you exit Uniplex.
◆ Merge

You can merge another document or the result of a Unix command while you are editing or at print time.

◊ Merge a Document while Editing

You can merge interactively during an editing session by overlaying a document on top of the current text or inserting it between lines:

1. Move the cursor to the far left of the line at which to merge:
   - You can merge a document into the middle of a line, but the results may be unexpected as all dot commands and rulers in the merged document will be treated as text.

2. Select the following options from the command menu:
   - File ➔ Merge
   - or
   - Press ESC m

   Uniplex displays the Merge suboptions.

3. Select Insert to insert the document before the current line or select Overlay to overlay the document on top of the current line and on top of as many following lines as required.

   Uniplex prompts for the document you want to merge.

4. Enter the document name and press RETURN.
   - Enter the full pathname if the document is not in the current folder or use down arrow to access File Manager.

   Uniplex merges the document at the current cursor position.

3-155
Merge

Merge a Document or Command at Print Time

You can merge any document or the result of a Unix command into the current document when you print it:

1. Move the cursor to the far left of the line at which to merge.

2. Select the following options from the command menu:

   File → Merge → Print_Time_Merge

   Uniplex prompts for the merge document.

3. a) Enter the name of the document and press RETURN.

   Enter the full pathname if the document is not in the current folder or use down arrow to access File Manager.

   or

   Enter .ME document_name on a new line and press RETURN where document_name is the name of the document to merge.

   b) Enter ! and a Unix command and press RETURN.

   or

   Enter .ME! command on a new line and press RETURN where command is the operating system command.

   Uniplex enters a merge document command in the document:

   Merge Document : /home/fjh/report.data
   Merge Document : !date

   When you print the document Uniplex inserts the merge document or command result at the position of the merge command.
The argument to a Print Time Merge command may be preceeded with an integer value to specify that the merged-in text should be offset by that number of columns. For example:

```
.ME 10 /home/fjh/report.data
.ME ! 10 date
```

The blank space between the offset and the file or command name is optional. Thus, to merge a file or command whose name starts with an integer, you must prefix the name with "0":

```
.ME 0 1022/customer.details
```

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.
2. Select the following options from the command menu:
   - **Edit → Edit-Print**
   - or
   - Press . (period)
   - Uniplex prompts for the new value for the command.
3. Enter the new value for the command and press RETURN.
   - or
   - Press **CTRL x** then RETURN, to delete the command value.

```
To delete the entire command, move cursor onto the same line as the command then press **CTRL x**.
```
Merge

Merge the Result of a Command

You can interactively merge the result of any Unix command into a document (i.e., the date command for the current date). See the System Administrator for information about Unix commands. To merge the result of a command:

1. Move the cursor to the merge position.
2. Select the following options from the command menu:
   - File ➙ Merge
   or
   - Press ESC m

   Uniplex displays the Merge suboptions.
3. Select Insert to insert the result of the Unix command at the current cursor position or select Overlay to overlay the result of the Unix command on top of the text from the current cursor position to the right.

   Uniplex prompts for the Unix command.
4. Enter ! followed by the Unix command you want to use and press RETURN.

   Uniplex places the result of the command at the cursor position.

Integrate a Graphics File

You can integrate a graphic from the Uniplex Advanced Graphics System such as a chart or graph. See the Integration chapter of the Advanced Graphics System User Guide.
Box Drawing

When you are editing a document you can draw a box at any point in it, to emphasize particular areas of text or mark the area of a table. As well as drawing boxes, you can also shade areas within the document. For example, you can draw a box around a table:

<table>
<thead>
<tr>
<th>City</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>London</td>
<td>12:00</td>
</tr>
<tr>
<td>Dallas</td>
<td>06:00</td>
</tr>
<tr>
<td>Paris</td>
<td>13:00</td>
</tr>
<tr>
<td>New York</td>
<td>08:00</td>
</tr>
<tr>
<td>Sydney</td>
<td>21:00</td>
</tr>
</tbody>
</table>

You can shade an area:
Box Drawing

Draw a Box

You can draw a box around an area in the document. When drawing boxes ensure that the line does not go through any text, as Uniplex will overwrite it. To draw a box:

1. Select the following options from the command menu:

   Tools ➔ Box/Draw ➔ Box

2. Move the cursor to the top left corner of the area you want to box and press RETURN.

   Ensure the cursor is at least one line above and one space to the left of any text.

3. Move the cursor to the bottom right corner of the area you want to box and press RETURN.

   Ensure that the cursor is one line below and one space to the right of any text. Uniplex draws a box around the marked area.

You can use the following key commands to draw a box:

1. Move the cursor to the top left corner of the area you want to box.

2. Press ESC (

3. Move the cursor to the bottom right corner of the area you want to box.

4. Press ESC ) *
Delete a Box

Once you have entered a box in the document you can easily remove it. If you delete a box which has text inside it Uniplex does not delete the text. To delete a box:

1. Select the following options from the command menu:

   Tools ➔ Box/Draw ➔ Erase

2. Move the cursor to the top left corner of the box and press RETURN.

3. Move the cursor to the bottom right corner of the box and press RETURN.

   Uniplex deletes the box.

You can use the following key commands to delete a box:

1. Move the cursor to the top left corner of the box.

2. Press ESC (.

3. Move the cursor to the bottom right corner of the box:

4. Press ESC ) e
**Shade an Area**

You can shade any area within the document by entering a number between 0 and 9 to select a fill you want to use. The following table is an example of gray scale fills. The specific set of fills is defined by Uniplex or by the System Administrator on a printer-by-printer basis. Some printers use gray scale fills and others use pattern fills. The specific results may vary widely between printers.

<table>
<thead>
<tr>
<th>Number</th>
<th>Fill</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
</tr>
</tbody>
</table>

To shade an area:

1. Select the following options from the command menu:
   - **Tools** → **Box/Draw** → **Fill**

2. Move the cursor to the top left corner of the area you want to fill and press RETURN.

3. Move the cursor to the bottom right corner of the area you want to fill and press RETURN.

   Uniplex prompts for the fill you want to use.

4. Enter the number between 0 and 9 of the fill you want to use.

   Uniplex shades the area with the fill you specified.
You can use the following key commands to shade an area:

1. Move the cursor to the top left corner of the area to shade.
2. Press ESC ( 
3. Move the cursor to the bottom right corner of the area to shade.
4. Press ESC ) of n

   where n is the number of the fill you want to use.

When you shade an area Uniplex overwrites any text in that area with shading.
Line Drawing

Use *Draw Mode* to draw straight lines anywhere within a document. A line is drawn on the screen as you move the cursor around the page:

You can erase part of a line without disturbing other lines that it crosses:

You can also move the cursor without drawing. These features are explained below using the command menu. Alternatively, press \F5\ to access the Draw softkeys for the same functions.

**Draw a Line**

To draw a line:

1. Move to the point at which you want to begin the line.
2. Select the following options from the command menu:
   - Tools \* Box/Draw \* Lines \* Draw-Mode
Uniplex turns on Draw Mode and displays **DRAW** on the status line. You can now move the cursor to draw the line.

When you have finished drawing the line, select the following options from the command menu:

```
Tools ➔ Box/Draw ➔ Lines ➔ Normal-Mode
```

Uniplex turns off Draw Mode.

**Move while Drawing**

To move the cursor while you are in Draw Mode, without drawing, select the following options from the command menu:

```
Tools ➔ Box/Draw ➔ Lines ➔ Normal-Mode
```

You can now move the cursor without drawing a line.

**Erase Lines**

You can erase any lines you have drawn using Erase Mode. To erase lines:

1. Move to the beginning of the line you want to erase.
2. Select the following options from the command menu:

```
Tools ➔ Box/Draw ➔ Lines ➔ Erase-Mode
```

Uniplex turns on Erase Mode and displays **ERASE** on the status line.

3. Move the cursor along the line you want to erase.

If you erase a line that crosses another line, Uniplex leaves the remaining line intact.
**Effects**

If you want to highlight or emphasize text within the document or change the way it looks, for example, to enter titles or make information stand out, you can **effect** it. When you effect text Uniplex prints it in a different style. For example, you can print text **bold** or **italic**.

When you effect text you specify which effect you want to use by choosing an **effect character**. The following table shows the 22 Uniplex effects and their effect characters:

<table>
<thead>
<tr>
<th>Effect Character</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td><strong>Bold font</strong></td>
</tr>
<tr>
<td>B</td>
<td><strong>Doublestrike</strong></td>
</tr>
<tr>
<td>C</td>
<td><strong>Underline all</strong></td>
</tr>
<tr>
<td>D</td>
<td><strong>Underline text</strong></td>
</tr>
<tr>
<td>E</td>
<td><strong>Bold and Underline</strong></td>
</tr>
<tr>
<td>G</td>
<td><strong>Small font</strong></td>
</tr>
<tr>
<td>G</td>
<td><strong>Large font</strong></td>
</tr>
<tr>
<td>I</td>
<td><strong>Italic font</strong></td>
</tr>
<tr>
<td>J</td>
<td><strong>Super script</strong></td>
</tr>
<tr>
<td>K</td>
<td><strong>Sub script</strong></td>
</tr>
<tr>
<td>M</td>
<td><strong>Double Underline all</strong></td>
</tr>
<tr>
<td>N</td>
<td><strong>Double Underline text</strong></td>
</tr>
<tr>
<td>O</td>
<td><strong>PS-Small font</strong></td>
</tr>
<tr>
<td>P</td>
<td><strong>PS-Normal font</strong></td>
</tr>
<tr>
<td>Q</td>
<td><strong>FX-Small font</strong></td>
</tr>
<tr>
<td>R</td>
<td><strong>FX-Normal font</strong></td>
</tr>
<tr>
<td>S</td>
<td><strong>Normal font</strong></td>
</tr>
<tr>
<td>T</td>
<td><strong>Shaded Overstrike (Shaded Overstrike)</strong></td>
</tr>
<tr>
<td>U</td>
<td><strong>Strikeout Slash (Strikeout Slash)</strong></td>
</tr>
<tr>
<td>V</td>
<td><strong>Strikeout Dash (Strikeout Dash)</strong></td>
</tr>
<tr>
<td>X</td>
<td>Index Leader effect</td>
</tr>
<tr>
<td>[</td>
<td>Graphics font</td>
</tr>
</tbody>
</table>
Effect Text

You can add an effect as you type or to an existing text block:

1. Move the cursor to the point at which to start the effect.

2. Select the following options from the command menu:
   - Layout ➔ Effect ➔ Start

   Uniplex displays a pick and point list of the available effects:

<table>
<thead>
<tr>
<th>Select Required Font</th>
</tr>
</thead>
<tbody>
<tr>
<td>A = BOLD font</td>
</tr>
<tr>
<td>B = Double strike</td>
</tr>
<tr>
<td>C = Underline all</td>
</tr>
<tr>
<td>D = Underline Text</td>
</tr>
<tr>
<td>E = BOLD and underline</td>
</tr>
<tr>
<td>G = SMALL font</td>
</tr>
<tr>
<td>H = LARGE font</td>
</tr>
<tr>
<td>I = ITALIC font</td>
</tr>
<tr>
<td>J = Superscript</td>
</tr>
<tr>
<td>K = Subscript</td>
</tr>
<tr>
<td>M = Double underline</td>
</tr>
<tr>
<td>N = Double underline text</td>
</tr>
<tr>
<td>O = PS-SMALL font</td>
</tr>
<tr>
<td>P = PS-NORMAL font</td>
</tr>
<tr>
<td>Q = FX-SMALL font</td>
</tr>
<tr>
<td>** more pages **</td>
</tr>
</tbody>
</table>

3. Select the effect you require.

4. Enter the text you want to effect or move the cursor to the end of the area you want to effect.
Effects

Using the up arrow key to specify the area you want effected turns the effect off.

5 Select the following options from the command menu:

   Layout ➔ Effect ➔ End

Uniplex turns off the effect.

Effected text is highlighted, usually in reverse video. Multiple effects may look the same on screen. See Check an Effect to display the effect name.

You can use the following key commands to effect text:

1 Move the cursor to the beginning of the text to effect.

2 Press ESC <

3 Enter the effect character for the effect you want to use.

4 Enter the text to effect or move the cursor to the end of the area to effect.

5 Press ESC >

Effect a Word

You can also use the command menu to effect individual words. To effect individual words:

1 Move the cursor to the first letter of the first word to effect.

2 Select the following options from the command menu:

   Layout ➔ Effect ➔ Word
Uniplex displays the Word suboptions.

3 Select the option you require:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold_Word</td>
<td>Bolds the word.</td>
</tr>
<tr>
<td>Underline_Word</td>
<td>Underlines the word.</td>
</tr>
<tr>
<td>Italicize_Word</td>
<td>Italicizes the word.</td>
</tr>
<tr>
<td>Large_Word</td>
<td>Effects the word with Large Font.</td>
</tr>
</tbody>
</table>

Uniplex effects the current word.

4 Select another option to effect the next word or Quit to stop effecting text.

diamond Effect a Block of Text

You can also add an effect to a block of text:

1 Select the following options from the command menu:

    Layout → Effect → Block

    Uniplex prompts you to move to the top left corner of the area you want to effect.

2 Move the cursor to the top left corner of the area you want to effect and press RETURN.

    Uniplex prompts you to move to the bottom left corner of the area you want to effect.

3 Move the cursor to the bottom right corner of the area you want to effect and press RETURN.
Effects

4 Enter the effect character for the effect you want to use.

Uniplex effects the area you have marked. Uniplex does not change the effect of text that is already effected.

You can effect a block of text without the command menu:
1 Move the cursor to the top left of the text block.
2 Press ESC (  
3 Move the cursor to the bottom right of the text block.
4 Press ESC )  
5 Enter the effect character for the effect you want to use.

◇ Turn Off an Effect

You can remove an effect from a single line of text or from a block of text. To turn off an effect on a single line:

1 Move the cursor to the beginning of the effected text.
2 Select the following options from the command menu:

   Layout  ➔  Effect  ➔  End

   or

   Press ESC >

Uniplex turns off the effect from the current cursor position to the end of the current line.
To turn off an effect on a block of text:

1. Select the following options from the command menu:
   
   Layout ➔ Effect ➔ Uneffect

   Uniplex prompts you to move to the top left corner of the area you want to uneffect.

2. Move the cursor to the top left corner of the area you want to remove the effect from.

   Uniplex prompts you to move to the bottom right corner of the area you want to remove the effect from.

3. Move the cursor to the bottom right corner of the area you want to remove the effect from and press RETURN.

   Uniplex removes the effect from the area you have marked.

◊ Check an Effect

When you effect a piece of text Uniplex highlights it on the screen, usually using reverse video. You may find that some effects look the same on the screen. To find out which effect you are using you can check it. To check an effect:

1. Move the cursor onto the effected text.

2. Select the following options from the command menu:

   Layout ➔ Effect ➔ Describe

   or

   Press ESC
Effects

Uniplex displays the name of the effect on the status line and asks you to press RETURN to return to the document:

**BOLD font Press RETURN to continue**

Uniplex beeps if there is no effect present.

◆ Repeat Last Command

At any time you can repeat the last command you gave Uniplex. This is useful for repeating the same editing commands within a document. For example, if you want to paste in the same passage of text several times over, you can paste in the text, then use the repeat command to paste in the same piece of text as many times as you require.

To repeat the last command press ESC . (period) immediately after using the command you want to repeat.
ADVANCED
WORD PROCESSING
ADVANCED WORD PROCESSING

This section gives details of how to use Uniplex’s advanced word processing tools. For example, it explains how to create an index for the document and how to use the thesaurus to find a synonym for any word in the document. It contains the following subsections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thesaurus</td>
<td>Find a synonym or antonym for any word in the document.</td>
</tr>
<tr>
<td>Glossaries</td>
<td>Save a library of text sections for recall and reuse.</td>
</tr>
<tr>
<td>Search and Replace</td>
<td>Search for a text string and replace it with an alternative if you wish.</td>
</tr>
<tr>
<td>Calculator</td>
<td>Use the Uniplex calculator to perform simple calculations on numbers in the document.</td>
</tr>
<tr>
<td>Footnotes</td>
<td>Enter footnotes in the document which refer to sections of the text.</td>
</tr>
<tr>
<td>Non-printing Remarks</td>
<td>Enter remarks in the document that do not print out.</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>Enter a bookmark in the document to which you can return.</td>
</tr>
<tr>
<td>Set Line Spacing</td>
<td>Change the amount of space between lines at print time.</td>
</tr>
<tr>
<td>Keep Lines Together</td>
<td>Ensure that a paragraph is not split across pages at print time.</td>
</tr>
</tbody>
</table>
# ADVANCED WORD PROCESSING

<table>
<thead>
<tr>
<th>Section</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Ruler Pitch</td>
<td>Change the font spacing to align text and set the text area width.</td>
</tr>
<tr>
<td>Abandon Global Commands</td>
<td>Cancel a long global procedure.</td>
</tr>
<tr>
<td>Index</td>
<td>Plan an index, add index entries to the document, and generate an index to include in the document.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Plan a table of contents, add table of contents entries in the document, and generate a table of contents to include in the document.</td>
</tr>
<tr>
<td>Clear Current Document</td>
<td>Cancel the current edits.</td>
</tr>
<tr>
<td>Browse Non-Uniplex Documents</td>
<td>Browse converted copies of non-Uniplex documents.</td>
</tr>
<tr>
<td>Import/Export Non-Uniplex</td>
<td>Edit and save non-Uniplex format documents.</td>
</tr>
<tr>
<td>Operating Modes</td>
<td>Change Uniplex system defaults for the word processor editor.</td>
</tr>
<tr>
<td>Windows</td>
<td>View different portions of a document at the same time.</td>
</tr>
<tr>
<td>Fonts</td>
<td>Specify the text font, point size, and typeface.</td>
</tr>
<tr>
<td>Mail Merge</td>
<td>Send the same letter to many people automatically.</td>
</tr>
</tbody>
</table>
**Thesaurus**

You can use the Uniplex Thesaurus to provide *synonyms*, words of similar meaning, for any word in a document. You simply select the word for which you want to find a synonym. Uniplex displays a list of possible definitions for the word. For example, if the word you select is *ripple*, Uniplex displays the following:

```
Thesaurus of: ripple
Select meaning from:

 wave (n)
undulate (v)
fret (v)
```

The letter in brackets after each definition refers to its part of speech which can be one of the following:

- (n) - noun
- (a) - adjective
- (v) - verb
- (o) - other (*i.e.*, adverb/pronoun)

Uniplex displays a list of synonyms for the selected definition. For example, if you select *wave* from the definition list, Uniplex displays these replacement synonyms:

```
Thesaurus of: ripple

Meaning: wave (n)
Select replacement from:

 wave
ruffling
undulation
```
Thesaurus

You can replace the original word with one of the listed synonyms or search for a replacement synonym for one of them and repeat the above process as many times you wish. The original word displays at the top of the popup menu until a synonym is selected:

Replacing word: ripple
From Thesaurus of: wave
Select meaning from:
  breaker (n)
  undulate (v)
  greet (v)

Replacing word: ripple
From Thesaurus of: wave
Meaning: greet (v)
Select replacement from:
  greet
  beckon
  call
  motion

The case of the original word is maintained when it is replaced. An exact word may not be found in the Thesaurus as it does not contain plurals, all tenses, etc. It will provide a close match, but you may need to correct the word after the substitution is made. For example, if you want to find a synonym for the word, words, Uniplex displays the following popup screen:

Thesaurus of: words
Select meaning from:
  disagreement (n)
  related word...

Any direct match is displayed (i.e., disagreement) if there is one, but Uniplex also displays the term related word if it thinks it has found a close match to your word which is otherwise not listed in the Thesaurus. Pick and point related word.
Uniplex displays a list of close matches in a popup screen:

```
Thesaurus of: words
Select related word from:

word
```

Press **F6**. Uniplex displays the following popup screen:

```
Replacing word: words
From Thesaurus of: word
Select meaning from:

expression (n)
pledge (n)
report (n)
bidding (n)
antonym...
```

The word list includes the term *antonym* if there are words available with the opposite meaning of the selected word. Pick and point *antonym*. Uniplex displays the following popup screen:

```
Replacing word: words
From Thesaurus of: word
Select antonym from:

idea
```

This message displays if there is no close match for the word:

```
No synonym found
```
Thesaurus

◊ Find a Synonym

To find a synonym for a word in the document:

1. Place the cursor anywhere on the word you want to find a synonym for.

2. Select the following options from the command menu:

   Tools ➞ Thesaurus

   or

   Press ESC I t

3. If the word is contained in the Thesaurus, Uniplex displays a list of possible meanings. Select from this list the meaning you require. Uniplex displays a list of possible synonyms.

   If the word is not contained in the Thesaurus but a close match is, Uniplex displays a list of possible close matches. From the list of close matches select the one you require.

   Uniplex displays a list of possible meanings. From the list of meanings select the meaning you require. Uniplex displays a list of possible synonyms.

   If the word is not in the Thesaurus and no close match is available, Uniplex displays the message:

   No synonym found
4 After displaying the list of synonyms you have these options:

- Select the synonym you require and press **F1** or **ESC e**. Uniplex replaces the word with the selected synonym.

- Press **F4** or **ESC q** to return to the previous list of meanings.

- Select a synonym and press **F6**. Uniplex searches for a synonym for the synonym, and displays a list of meanings on the screen.

  Repeat the previous steps to display a list of synonyms. You can search for synonyms of synonyms as often as you require. Uniplex displays the original word at the top of the popup menu until you select the synonym you require.
When you create a number of documents you often need to use the same paragraph or section of text repeatedly. For example, you may always include the same paragraph at the end of every company letter or use a selection of standard paragraphs within various legal documents. To do this you use a *glossary*.

A glossary is a Uniplex document which contains pieces of text, *glossary entries*. You can merge these into a document automatically without having to retype them. You can create any number of glossaries and store as many glossary entries, of any length, as you wish. You can then merge entries into a document at any point, either while editing or at print time.

For example, you could create a glossary called *america*, containing the glossary entries:

```plaintext
#us_sales

The following is a detailed account of the rubber hosing sales you have made to U.S. customers.
}

#us_profits

The following is a detailed account of this month’s profits, made on sales of rubber hosing to U.S. customers.
}

#us_staff

The following is a detailed account of the staff currently selling rubber hosing to U.S. customers.
}
```
◊ **Create**

A glossary is simply a Uniplex document, so to create a glossary you create a document by selecting the Create a Document option from the Word Processor menu. Ensure that you give the glossary a name that reflects the entries it contains. For example, if the glossary contains standard English legal paragraphs, call it `england.legal`. When you have created a glossary you need to add the pieces of text, or glossary entries, to it. See the following section for details.

◊ **Add Entry**

A glossary entry is a piece of text you use frequently, which you can automatically include in the document without having to retype it. It can be of any length and is stored in a glossary. When you add glossary entries to a glossary you begin each with a name, preceded by a hash (#), and end each with a double closed parenthesis. For example:

```
#tour

Thank you for your recent application for press passes for David Jones’ forthcoming tour of Sweden.

I am enclosing your passes herewith, together with an invitation to the pre-tour press conference on Wednesday 24th May at the Ambassador Hotel, Gothenburg.
```

To add a glossary entry to a glossary:

1. Edit the glossary in which to add the entry.

2. Enter the name of the entry preceded by a hash (#):

```
#tour
```

3. Press RETURN twice.
Glossaries

4 Enter the glossary entry text.

5 Enter ]] on the line following the last line of text.

This marks the end of the glossary entry.

To add more than one glossary entry, simply repeat the above steps for each entry you want to add. When you have added all the glossary entries to a glossary press ESC e to save it. Uniplex prompts for a name for the glossary. Enter the name for the glossary and press RETURN.

◊ Insert Entry while Editing

You can merge a glossary entry at any point in a document while you are editing it:

1 Move the cursor to the position at which you want to merge the glossary entry.

2 Select the following options from the command menu:

   File ➔ Merge ➔ Insert

or

   Press ESC m i

Uniplex prompts for the name of the glossary entry.

3 Enter the name of the glossary entry in the following format:

   glossary_name, glossary_entry

   where glossary_name is the name of the glossary and
glossary_entry is the name of the glossary entry. For example:

   sweden, tour
4  Press RETURN.

Uniplex inserts the glossary entry at the current cursor position.

◇ Insert Entry at Print Time

You can dynamically merge a glossary entry at any point in the document at print time. This ensures that Uniplex enters the most recent version of the glossary entry:

1  Move the cursor to the left margin of the line at which you want to insert the glossary entry.

2  Select the following options from the command menu:

   File ➞ Merge ➞ Print_Time_Merge

Uniplex prompts for the name of the glossary entry.

3  Enter the name of the glossary entry in the following format and press RETURN:

   glossary_name,glossary_entry

   where glossary_name is the name of the glossary and
glossary_entry is the name of the glossary entry. For example:

   sweden,#tour

   Uniplex inserts the glossary entry at the position of the command when you print the document.

To edit this command once you have entered it:

1  Move the cursor onto the same line as the command.

2  Select the following options from the command menu:

   Edit ➞ Edit-Print
Glossaries

or

Press . (period)

Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN.

or

Press CTRL x then RETURN to delete the command value.

To delete the entire command, move cursor onto the same line as the command then press CTRL x.
Search and Replace

You can find any character, word, or group of words in the document, up to a maximum of 70 characters. For example, you can find a company name or a heading in the document. In addition you can find text and replace it with an alternative. For example, if you have misspelled the name of a company, you can find each occurrence in the document and replace it with an alternative, automatically. You have the following options when you search for text:

- Search forwards or backwards through the document.
- Search for text exactly the same case as the text you enter or search for text regardless of its case.
- Replace all occurrences of the text in the document with the same text, specify which occurrences you want to replace, or specify different replacement text for each occurrence.
- Replace text with the exact alternative or with the same case as the text you are replacing.

Case

You can specify whether to find the exact text you enter or whether to ignore the case of the text when you do a search. You can replace text with the exact text you enter, case-insensitive, or using the same pattern of upper and lower case letters as the text you are replacing, case-sensitive.

A case-sensitive search for the word, An, might find An and Another while a case-insensitive search would find AN, An, an, ANOTHER, Another, and another.
Search and Replace

Replace Options

You can search for and replace text in the document. There are three ways in which you can replace the text:

- Replace Text Interactively
- Replace Text Globally
- Replace Text Using Formfill

Interactive

The following options are provided each time the text you want to replace occurs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace-Word</td>
<td>Replace the current text with the new text and search for the next occurrence.</td>
</tr>
<tr>
<td>Skip</td>
<td>Skip current text and move to the next occurrence.</td>
</tr>
<tr>
<td>Quit</td>
<td>Abandon the search and return to the editor.</td>
</tr>
</tbody>
</table>

Global

Every occurrence of the text you search for is replaced with the new text unless you limit replacements to a particular number of times.
Formfill

You can specify different replacement text for each occurrence of the specified text using these options for each occurrence:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace-Word</td>
<td>Prompts for the replacement text. Enter the replacement text and press RETURN. Uniplex replaces the text and moves to the next occurrence.</td>
</tr>
<tr>
<td>Skip</td>
<td>Skip current text and move to the next occurrence.</td>
</tr>
<tr>
<td>Quit</td>
<td>Abandon the search.</td>
</tr>
</tbody>
</table>

Search Procedures

You can search for any text and replace it if you wish:

1. Select the following option from the command menu:

   Search → Search

Uniplex displays the Search and Replace form:

```
Search and Replace

Search For [________________]
Direction [Forwards_]
Case Sensitive Search [Yes]
Replace Text? [No_]
Replace With [________________]
How [Interactive]
Case Sensitive Replace [Yes]
Replace Count [__]
```
Search and Replace

2. Complete the form by using the arrow keys to move between fields and the SPACEBAR to scroll to the option you require. Press any character key to display a pick and point list of the available options in each field:

<table>
<thead>
<tr>
<th>Field</th>
<th>Options/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search For</td>
<td>Enter the text to search for as any combination of characters and spaces, up to 70 characters long.</td>
</tr>
<tr>
<td>Direction</td>
<td>Forwards: Searches forwards through the document. Backwards: Searches backwards through the document.</td>
</tr>
<tr>
<td>Case Sensitive Search</td>
<td>Yes: Searches for the exact text you enter. No: Searches for all occurrences of the text you enter, regardless of upper and lower case letters.</td>
</tr>
<tr>
<td>Replace Text?</td>
<td>Yes: Can enter replacement text. No: Cannot enter replacement text.</td>
</tr>
</tbody>
</table>
Search and Replace

The following options only take effect if you enter Yes in the Replace Text? field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Options/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace With</td>
<td>Enter the replacement text. This can be any combination of characters and spaces, up to 70 characters in length. Leave this field blank to delete all occurrences of the text.</td>
</tr>
<tr>
<td>How?</td>
<td>Interactive Prompts for information before replacing the text.</td>
</tr>
<tr>
<td></td>
<td>Global Replaces all occurrences of the text automatically.</td>
</tr>
<tr>
<td></td>
<td>Formfill Prompts for a replacement at each occurrence.</td>
</tr>
<tr>
<td>Case Sensitive</td>
<td>Yes Replaces the text using the same pattern of upper and lower case letters.</td>
</tr>
<tr>
<td>Replace</td>
<td>No Replaces the text with the exact text you enter.</td>
</tr>
<tr>
<td>Replace Count</td>
<td>Enter the number of times to replace the text for a global search. Leave this field blank to replace all occurrences.</td>
</tr>
</tbody>
</table>

3 When the form is as you require, press ESC e.

Uniplex searches through the document using these criteria.

You can also search and replace text using key commands, by pressing ESC l r and following the instructions.
Search and Replace

Repeat Search

You can repeat the last search without having to complete the Search and Replace form again:

- Select the following options from the command menu:
  
  Search → Next

  or

  Press ESC n

  Uniplex repeats the last search.

Quick Search

You can use a key command to search for text forwards from the current cursor position to quickly find a word or phrase without using the Search form or doing a replacement:

1. Press ESC f

   Uniplex prompts for the text to be found.

2. Enter the text to search for. Precede the text with a backslash (\) to be case-independent. Precede the text with an equals sign (=) to find the exact text you enter. Uniplex searches for the exact text you enter by default.

3. Press RETURN

   Uniplex searches the document for the text you enter. If Uniplex finds the text in the document it moves the cursor onto it.

4. To find the next occurrence of the text press ESC n.

   Press ESC n at any time to repeat the last search.
The Uniplex Word Processor includes a calculator. You can use it to perform simple calculations on numbers that you have entered into a document and place the total anywhere in the document.

As well as using the calculator to do calculations on individual numbers, you can also use it to add together a range of numbers at once.

*The limited precision and rounding of the simple word-processor calculate functions can yield varying results depending on machine type. For better precision, use the popup calculator (F12/5).*

**Calculate Individual Numbers**

1. Move the cursor onto the first number you want to use in the calculation.

2. Select the following option from the command menu:
   
   Tools ➔ Calculate ➔ Calculate_Numbers

   Uniplex displays the Calculate softkeys:

   F1=Add F2=Subtract F3=Multiply F4=Divide F5=Result F6=Cancel F7<

3. Press the softkey you require as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1=Add</td>
<td>Adds the current number to the current total.</td>
</tr>
<tr>
<td>F2=Subtract</td>
<td>Subtracts the current number from the current total.</td>
</tr>
<tr>
<td>F3=Multiply</td>
<td>Multiplies the current total by the current number.</td>
</tr>
</tbody>
</table>
### Calculator

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4=D</td>
<td>Divides the current total by the current number.</td>
</tr>
<tr>
<td>F5=R</td>
<td>Inserts the current total at the current cursor position.</td>
</tr>
<tr>
<td>F6=C</td>
<td>Clears the calculator total to zero.</td>
</tr>
<tr>
<td>F7</td>
<td>Returns you to the main softkey menu.</td>
</tr>
</tbody>
</table>

Uniplex performs the calculation and places the result in the calculator memory.

The Calculate softkeys remain on the screen until you press F7, so you can perform as many calculations as you require.

To place the final total in the document:

1. Move the cursor to the position at which you want to enter the total.
2. Press F5 from the Calculate softkey menu.

Uniplex inserts the contents of the current calculator memory at the current cursor position.

**Add a Range of Numbers**

In addition to using the calculator to make calculations on individual numbers you can also add together a range of numbers.

When you add a range of numbers, you mark the range you want to add, as if you were cutting out a block of text and then place the result in the document.

When you mark the range you want to add, it does not matter where the numbers are in the area you mark, or whether there are words...
or blank spaces between them. When Uniplex performs the calculation it only takes notice of the numbers.

For example, if you mark the following area as the range you want to add:

The number of world class Swiss Windsurfers now stands at 8. In West Germany there are 15 and in the United Kingdom there are 25.

However this in no way compares with the United States of America, where there are 112 Windsurfers of a world class standard.

Uniplex gives 160 as the result.

When you add an area Uniplex adds together all the numbers in the area you mark. If you enter negative numbers, for example -3, Uniplex recognizes them as being negative.

To add a range of numbers:

1. Move the cursor to the top left corner of the area you want to calculate.
2. Select the following options from the command menu:
   - Tools ➤ Calculate ➤ Add_Block
3. Move the cursor to the bottom right corner of the area you want to calculate and press RETURN.
4. Move the cursor to the position at which you want to enter the total and press RETURN.

   Uniplex adds together all the numbers in the area you mark and enters the total at the current cursor position.
You can enter footnotes to provide extra information or references separately from the main text. A footnote consists of two parts, the footnote marker, which marks text that the footnote references and the footnote text, which is the footnote itself:

The current destruction of the Brazilian rain forests has wide ranging repercussions for people all over the world. Unlike the famine in Ethiopia\(^1\) it is not a disaster that is only relevant to one or two countries. If a solution is not found soon then the effects will be felt world-wide.

\(^1\) Refers to the 1984-5 famine in this north-east African country.

When you create a footnote you can specify:

- Text
- Marker Position
- Marker Effect
- Position
- Numbering Style

**Marker**

Before you enter the footnote text you must decide where you want the footnote marker in the text.

*When you enter a footnote marker ensure that you are in insert mode or the footnote marker will overwrite existing text.*

To enter a footnote marker:

1. Move the cursor to the position at which you want to place the footnote marker.
2 Select the following options from the command menu:

   Layout → Page → Footnotes → Marker

or

   Press ESC ^

Uniplex places a footnote marker (^) at the cursor position.

◊ **Enter Text**

You enter the footnote text after entering the footnote marker:

1 Move the cursor to the first blank line before the marker.

2 Select the following options from the command menu:

   Layout → Page → Footnotes → Text

Uniplex inserts a footnote window at the current cursor position:

   Start Footnote

   <<End Footnote>>

3 Select the following options from the command menu:

   Layout → Page → Footnotes → Marker

or

   Press ESC ^

Uniplex enters a footnote marker in the footnote to correspond to the footnote marker in the text.
Footnotes

Alternatively, you can enter a footnote window without using the command menu. To do this:

1. Move the cursor to the first blank line before the footnote marker. Ensure the cursor is at the left of the screen.

2. Enter `.FS` on a new line to mark the footnote window start.

3. Open up as many blank lines as you require for the footnote window below this command by pressing `CTRL o`.

4. Enter `.FE` on a new line to mark the footnote window end.

4. Enter the footnote text. If you decide that you want the footnote to be larger or smaller than the window, simply open or delete extra lines as you require, using the usual Uniplex commands.

5. When you have entered the footnote text move the cursor out of the footnote window. On the screen the footnote looks like this:

```
Start Footnote
^ Refers to the 1984-5 famine in this north-east African country.
<--End Footnote-->
The current destruction of the Brazilian rain forests has wide ranging repercussions for people all over the world. Unlike the famine in Ethiopia it is not a disaster that is only relevant to one or two countries. If a solution is not found soon then the effects will be felt world-wide.
```

You can edit the footnote text at any time.
Delete Text

To delete the footnote text:

1. Move the cursor onto the start footnote command line.

2. Select the following options from the command menu:
   
   Edit → Edit-Print
   
   or
   
   Press . (period)
   
   Uniplex prompts you to confirm the deletion.

3. Select Yes to delete the command.
   
   or
   
   Select No to return to the document.

Numbering Style

When you enter footnotes in the document you must specify the numbering style for the footnote markers. Uniplex has the following numbering styles available:

<table>
<thead>
<tr>
<th>Character</th>
<th>Explanation</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Roman Numerals (Upper Case)</td>
<td>I, II, III, IV,...</td>
</tr>
<tr>
<td>r</td>
<td>Roman Numerals (Lower Case)</td>
<td>i, ii, iii, iv,...</td>
</tr>
<tr>
<td>A</td>
<td>English Alpha (Upper Case)</td>
<td>A, B, C, D,...</td>
</tr>
<tr>
<td>a</td>
<td>English Alpha (Lower Case)</td>
<td>a, b, c, d,...</td>
</tr>
<tr>
<td>N/n</td>
<td>Arabic Numerals</td>
<td>1, 2, 3, 4,...</td>
</tr>
<tr>
<td>T/t</td>
<td>Typographical Marks</td>
<td>*, +, %, &amp;,...,</td>
</tr>
</tbody>
</table>

Uniplex uses Typographical Marks if no style is specified.
Footnotes

To specify the footnote numbering style:

1. Press **ESC t** to move the cursor to the top of the document.
2. Select the following options from the command menu:

   Options ➔ Numbering

   Uniplex displays the Numbering Styles form:

<table>
<thead>
<tr>
<th>Numbering Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Number</td>
</tr>
<tr>
<td>Style</td>
</tr>
<tr>
<td>Start Numbering From</td>
</tr>
</tbody>
</table>

3. Complete this form by using the arrow keys to move between fields and the SPACEBAR to scroll to the option you require. Press any character key to display a pick and point list of the available options in each scrolling field:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of Number</strong></td>
<td>Scroll this field to <strong>Footnote Number</strong>.</td>
</tr>
<tr>
<td><strong>Style</strong></td>
<td>Scroll this field to the numbering style you require. See the beginning of this section for details of the available styles.</td>
</tr>
<tr>
<td><strong>Start Numbering From</strong></td>
<td>Enter # to keep the same number as in the previous footnote or enter + to increase the number of the previous footnote by one.</td>
</tr>
</tbody>
</table>
4 When the form is as you require press ESC e.

A footnote numbering command is entered on the current line.

You can also specify the footnote numbering style without using the command menu as follows:

1 Press ESC t to move the cursor to the top of the document.
2 Enter .NS #F style n on a new line and press RETURN

where style is the style character for the numbering style and n is the number of the first footnote.

To edit this command once you have entered it:

1 Move the cursor onto the same line as the command.
2 Select the following options from the command menu:
   Edit ➔ Edit-Print

   or

   Press . (period)

   Uniplex prompts for the new value for the command.
3 Enter the new value for the command and press RETURN.

   or

   Press CTRL x then RETURN, to delete the command value.

   To delete the entire command, move cursor onto the same line as the command then press CTRL x.
Footnotes

Marker Effects

Uniplex prints the footnote markers in normal font by default. You can add an effect to them so that they stand out from the rest of the text. For example, the footnotes print out as follows with the superscript effect:

The current destruction of the Brazilian rain forests has wide ranging repercussions for people all over the world. Unlike the famine in Ethiopia\(^1\) it is not a disaster that is only relevant to one or two countries. If a solution is not found soon then the effects will be felt world-wide.

\(^1\) Refers to the 1984-5 famine in this north-east African country.

To specify the footnote marker effect:

1. Move the cursor onto the footnote marker you want to effect.
2. Select the following options from the command menu:
   \[\text{Layout} \rightarrow \text{Effect} \rightarrow \text{Start}\]
   
or
   \[\text{Press } \text{ESC} <\]
   
   Uniplex displays a pick and point list of the available effects.
3. Select the effect you require.
4. Move the cursor one space to the right of the footnote marker.
5. Select the following options from the command menu:
   \[\text{Layout} \rightarrow \text{Effect} \rightarrow \text{End}\]
   
or

---

3-202
Press `ESC` >

Uniplex effects the footnote marker with the effect you specify.

✏ When you effect footnote markers, ensure that you effect the marker in the footnote text as well as in the standard text.

◊ Position

Uniplex prints footnotes at the bottom of the page on which they are entered by default. Alternatively, you can specify the page on which you want them to print such as the end of a section or document. This is done in two steps.

First, stop footnotes from printing:

1. Move the cursor to the top left edge of the page after which you want to stop footnotes from printing.

2. Select the following options from the command menu:

   Layout ➔ Page ➔ Footnotes ➔ Save

   or

   Enter .FTS on a new line.

   Uniplex saves all footnotes and does not print them.

Then, print the saved footnotes:

1. Move the cursor to the left edge of the line after the last text line of the page on which the footnotes are to be printed.

   ✏ There must be enough space left on this page to hold all footnotes, otherwise an extra page will be inserted into the document when printing.
Footnotes

2 Select the following options from the command menu:

Layout ➔ Page ➔ Footnotes ➔ Place

or

Enter .FTD on a new line.

Uniplex prints all the footnotes you have entered since the last Save Footnotes command at the bottom of this page.

*All of the saved footnotes will be numbered continuously using the value specified in the last Start Numbering From parameter.*

To delete either of these commands once you have entered them:

1 Move the cursor onto the same line as the command.

2 Select the following options from the command menu:

Edit ➔ Edit-Print

or

Press . (period)

Uniplex prompts you to confirm the deletion.

3 Select Yes to delete the command.

or

Select No to return to the document.
Non-printing Remarks

You can enter a non-printing remark if you want to put comments in the document that you do not want to print out, such as a note to remind yourself how to print a particular section. The remarks do not print so you do not have to worry about deleting them. For example:

A recent survey carried out by a reputable French Fashion Magazine posed the question:

Do you prefer driving French, German, or British cars?

Not surprisingly the majority (75%) said French. With German (15%) and British (10%) trailing behind.

Remark: Check these figures.

To enter a non-printing remark:

1. Move the cursor to the position at which you want to enter the remark. Ensure the cursor is at the left edge of the screen.

2. Select the following options from the command menu:

   Layout ➔ Comments

   Uniplex enters the word REMARK at the current cursor position:

   Remark

   and prompts for the remark.

3. Enter the remark and press RETURN.

   If you want to have a remark larger than one line, repeat the above process for each line of the remark.
Non-printing Remarks

To enter a remark without using the command menu:

1. Move the cursor to the position at which you want to enter the remark. Ensure that the cursor is at the left edge of the screen.

2. Enter `.RE` on a new line.

3. Enter the remark on the same line as the command and press RETURN.

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.

2. Select the following options from the command menu:

   - `Edit` ➔ `Edit-Print`

   or

   Press . (period)

   Uniplex prompts for the new value for the command.

3. Enter the new value for the command and press RETURN.

   or

   Press `CTRL x` then RETURN, to delete the command value.

   To delete the entire command, move cursor onto the same line as the command then press `CTRL x`.
Bookmarks

A Bookmark marks a particular place in the document so that you can return to it easily. Enter a bookmark at the current cursor position and save the document if you must interrupt an editing session. Go straight to the bookmark and continue working when you return. You can enter as many bookmarks as you require, each with a different number if you wish.

Enter a Bookmark

To enter a bookmark in the document:

1. Select the following options from the command menu:
   
   Goto ➔ Bookmark ➔ Create

   Uniplex prompts for a number for the bookmark.

2. Enter a number if you wish and press RETURN.

   Uniplex places a bookmark at the current cursor position:

   \textit{REMARK Bookmark1}

   \textbullet{} It is recommended that you number the bookmarks, then you can go directly to a specific bookmark at any time.

To delete this command once you have entered it:

1. Move the cursor onto the same line as the command.

2. Select the following options from the command menu:

   \textit{Edit ➔ Edit-Print}

   or

   Press . (period)
Bookmarks

3 Press **CTRL x** then RETURN to delete the command value.

or

Press RETURN to return to the document.

✎ To delete the entire command, move cursor onto the same line as the command then press **CTRL x**.

Return to a Bookmark

To return to a bookmark in the document:

1 Select the following options from the command menu:

   Goto ➔ Bookmark ➔ Find

   Uniplex prompts for the number of the bookmark to return to.

2 Enter the bookmark number and press RETURN.

   Uniplex moves the cursor to the bookmark you request.

   or

   Press RETURN

   Uniplex moves the cursor to the next bookmark in sequence.
Set Line Spacing

Uniplex uses single line spacing by default when printing. You can print a document with double or triple spacing. You can also specify a fractional line spacing, for example, 1.5.

*Only the first decimal place of line spacing is used.*

To set the line spacing:

1. Move the cursor to the point from where you want to change the line spacing. Ensure the cursor is at the left edge of the screen.

2. Select the following options from the command menu:

   Layout ➔ Page ➔ Layout

   Uniplex displays the page format form.

3. Move the cursor to the Line Spacing field.

4. Enter a line spacing value and press F1 or ESC e.

   *The text prints single-spaced by default with the least gap possible between each line, depending on the font size.*

   Uniplex enters a line spacing command in the document:

   ```plaintext
   Line Spacing : 2
   ```

To enter line spacing without using the command menu:

1. Move the cursor to the position to change the spacing.

2. Enter `.SP n` on a new line and press RETURN

   where `n` is the number of lines you require.
Set Line Spacing

Uniplex uses the specified line spacing at print time. Text always appears with single line spacing on the screen, although the line counter and page breaks take account of the current line spacing.

See the Printing chapter for more line spacing information.

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.

2. Select the following options from the command menu:

   Edit ➔ Edit-Print

   or

   Press . (period)

   Uniplex prompts for the new value for the command.

3. Enter the new value for the command and press RETURN.

   or

   Press CTRL x then RETURN, to delete the command value.

To delete the entire command, move cursor onto the same line as the command then press CTRL x.
Pre-styled Documents

The line spacing command behaves slightly differently from earlier versions of Uniplex if you are using Pre-styled documents. Previously, a line spacing command changed the line height to a fixed number of line spacing units. This unit was fixed by the type of printer and was totally independent of the font. Now the line spacing in Pre-styled documents is in proportion to the font size. For example, a two-line heading using a font size of 16 and single-line spacing may have appeared cramped together:

Summer Fair
August Bank Holiday

The same heading now prints as:

Summer Fair
August Bank Holiday

Only Pre-styled documents are affected by this enhancement; existing documents (without Pre-Styled headers) will continue to print as before.

Add the suffix a (absolute) to line spacing commands if you prefer to continue setting line spacing using fixed units. For example, to set an absolute line spacing of 1.2, enter .SP 1.2a. Uniplex prints using a fixed unit rather than the optimal value for the current font.
Keep Lines Together

Uniplex provides a number of facilities to automatically control how text splits across the pages of a document. You can specify that a certain number of lines be kept together, that a defined block of text remain intact, that a paragraph not be split, or that a page break occur at a specific place:

- **Line Count.** Text contained in the specified number of lines following this command will not be split across two pages.

- **Paragraph.** Text contained in the paragraph following this command will not be split across two pages.

- **Start/End Block.** Text between the Start Block and End Block commands will not be split across two pages.

- **Force Page.** A new page will begin with the line of text immediately following this command.

To force a section of text to remain continuous:

1. Move the cursor to the line immediately before the part of the document you do not want split.

2. Select the following options from the command menu:

   Layout ➔ Format ➔ Keep_together

Uniplex displays the Keep Together form:

<table>
<thead>
<tr>
<th>Keep Together</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
</tr>
<tr>
<td>Line Count</td>
</tr>
</tbody>
</table>

3-212
3 Complete this form by using the arrow keys to move between fields and the SPACEBAR to scroll to available options or press any character to display a pick and point list of the options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Select: Line Count, Paragraph, Start Block, End Block, or Force Page.</td>
</tr>
<tr>
<td>Line Count</td>
<td>Set the number of lines for the Line Count option.</td>
</tr>
</tbody>
</table>

4 When the form is as you require press **F1** or **Esc**.

Uniplex enters the command in the document. For example:

```
Start of block to keep on one printed page
```

If you selected Start Block, you should now:

5 Move the cursor to the line immediately after the part that you do not want to split.

6 Select the same options from the command menu:

```
Layout ➔ Format ➔ Keep_together
```

Uniplex will display the Keep Together form again.

7 Select the End Block command option.

8 Press **F1** or **Esc**.

Uniplex enters the command in the document. For example:

```
End of block to keep on one printed page
```

3-213
Keep Lines Together

To ensure at least a certain number of lines are available on the current page without using the command menu:

1. Move the cursor to the line immediately before the paragraph you do not want to split.
2. Enter `.PM n` on a new line and press RETURN
   where `n` is the number of lines desired.

To ensure a paragraph is not split across two pages without using the command menu:

1. Move the cursor to the line immediately before the paragraph you do not want to split.
2. Enter `.PM 0` on a new line and press RETURN
   where `0` is the number zero.

To ensure a section of the document is not split across two pages without using the command menu:

1. Move the cursor to the line immediately before the section you do not want to split.
2. Enter `.PM S` on a new line and press RETURN
3. Move the cursor to the line immediately after the section you do not want to split.
4. Enter `.PM E` on a new line and press RETURN.
To force a page break without using the command menu:

1. Move the cursor to the line immediately before the line on which you want the new page to begin.

2. Enter `.PA` on a new line and press RETURN.

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.

2. Select the following options from the command menu:
   - **Edit → Edit-Print**
   - Or
   - Press . (period)

   Uniplex will then redisplay the Keep Together form described above to allow you to change the command line.

3. Alter to the desired option and press **F1** or **Esc e**.
   - Or
   - Press **CTRL x** then RETURN, to delete the command value.

   ✷ To delete the entire command, move cursor onto the same line as the command then press **CTRL x**.

   ✷ The Word Processor reformats all pages at print time except for the page breaks set by `.PMx` or `.PA` commands.

   ✷ A `.PMS` block can also be ended by a new `.PM` command or a `.PA` command in addition to the `.PME` command. A new page must begin if the block is too large to fit onto a single page.

---

3-215
Change Ruler Pitch

The Ruler Pitch is a unique parameter in the Uniplex Word processor which defines how the ruler on the screen relates to the printed words on the page. Generally Uniplex automatically scales the document to the paper size and this parameter will be of no significance. However, you may wish to create a fixed page layout for a complex design. You can then use the ruler pitch to control the precise width of the lines or columns of text on the page. The ruler pitch can be set to a specific value or returned to the default:

- **Specific Value.** The Ruler Pitch value is the number of character positions on the ruler (dots and ruler characters) that represent one inch on the printed page. Divide the number of positions on the ruler by the Ruler Pitch to determine the size of the printed text line. A ruler with 70 character positions and a Ruler Pitch of 10 will produce a line 7" wide.

- **Default Value.** The system default for Ruler Pitch is 10; however, this will be overridden by a character pitch value in the print style, a print style that is set to scale the document to the page size, or a character width (DFHMI) value in the printer definition (Pcap file). The results may not be as expected because the Pcap definition will control in most cases.

Pcap entries compute the Ruler Pitch in Horizontal Motion Index (HMI) increments which represent the smallest amount the printer can increment horizontally (1/300" for PostScript and 1/120" for most other printers). This is an approximation so the line width will not be precise. See the detailed discussion in the Define Horizontal Head Movement section of Chapter 2: Configuring Printers in the Device Configuration Guide.

Assuming the system default of 10, when printing in portrait on U.S. 8.5" x 11" paper with margins of .75", a ruler with 70 character positions will format text to the 7" line width within the margins of that page. The system will use one of the default values unless a specific value has been previously set. You must reset the default with a .PTx command to clear a specific value.
**Ruler Pitch does not affect the size or spacing of printed text.**

To change the Ruler Pitch:

1. Move the cursor to the start of the text for which the Ruler Pitch is to be changed.

2. Enter a ruler if one is not already present, then return the cursor to the start of the text.

   *The Ruler Pitch command must be on the one line between a ruler and the start of the text to be affected or it will not work.*

3. Select the following options from the command menu:

   ```
   Layout → Page → Width
   ```

   Uniplex prompts for a Ruler Pitch value.

4. Enter the Ruler Pitch or enter x to return the Ruler Pitch to the default, and then press RETURN.

   Uniplex enters a Ruler Pitch command at the cursor position:

   ```
   Ruler Pitch Setting : 10
   ```

   or

   ```
   Ruler Pitch Setting : x
   ```

To edit this command once you have entered it:

1. Move the cursor onto the same line as the command.

2. Select the following options from the command menu:

   ```
   Edit → Edit-Print
   ```

   or
Change Ruler Pitch

Press . (period)

Uniplex prompts for the new value for the command.

3 Enter the new value for the command and press RETURN.

or

Press CTRL x then RETURN, to delete the command value.

✎ To delete the entire command, move cursor onto the same line as the command then press CTRL x.

---

To set the pitch at print time without using the command menu:

1 Move the cursor to the beginning of the text you want to change the text area width for.

2 Enter a ruler.

3 Enter .PTn immediately below the ruler and press RETURN where n is the pitch you require or x.

◆ Abandon Global Commands

You can abandon a global command that takes a long time to complete, such as a global search and replace or moving the cursor to the bottom of the document. This is particularly useful if you have given Uniplex the command by mistake. To abandon a global command press CTRL \.
Index

An index is an alphabetical listing of the key concepts in a document, showing the page number on which each occurs. It is usually placed at the end of the document and is especially useful as a guide to long documents. Creating an index takes three steps:

- **Plan.** The organization of the index must be planned carefully or it will not serve its required purpose.

- **Add Entries.** Each item to be indexed must be identified and properly marked in the document.

- **Generate.** The index entries in the document are used to produce the index file with page references.

**Plan**

Planning is the most important part of creating the index. If you do not plan the index correctly before you add the entries and generate it, it will not serve its required purpose. Remember these points:

- Determine the audience for the index and, by looking thoroughly at the information in the document, try to anticipate the type of information they might want to look up in the index.

- Determine the type of entries that the audience may want to look up and use as many subentries as appropriate. For example, if the document has a section on the planet Earth, do not only index it as *Earth*, but also as *World* and *Planet Earth*.

- Use a consistent form for nouns and verbs. For example, use the present tense for verbs and only singular nouns.

- Use a consistent case for all the entries as Uniplex sorts the entries by case. UPPER case letters are always placed before lower case letters. For example, use upper case for the first letter of all the entries and subentries.
Index

The following is an example of an index generated using inconsistent capitalization:

Europe
  France 3
  Germany 5
europe
  Belgium 5
  Hungary 8

The following is an example of an index generated using consistent wording and capitalization:

Europe
  Belgium 5
  France 3
  Germany 5
  Hungary 8

◊ Add Entries

You can add an index entry at any position in the document. The word you enter in the index entry does not have to be in the text. Make sure that the index entries are as close to the text they refer to as possible, to ensure that the page number for the index entry is accurate. You can make the following types of index entry:

- Multiple levels:
  America
    North
      Alaska 2
      Canada 11
    South
      Argentina 5
      Chile 15

- Inverse entries:
  Atlantic
    Ocean 57
  Ocean
    Atlantic 57
Print effects:

Mississippi
   River 57
River
   Mississippi 57

Multiple indexes, one index could contain key concepts and another might contain cross-references to external reports.

Different numbering styles and separators:

Africa
   Morocco 2-7
   Zimbabwe 2-4
Asia
   India 3-23 to 3-33
   Japan 3-9 to 3-15
Australasia
   New Zealand 6
   Tasmania 3

Primary Entry

To add a single level index entry:

1. Move to the text to which the index entry will refer.

2. Select the following options from the command menu:

   Tools ➔ Index/Contents ➔ Index

   Uniplex prompts for the index entry you want to make.

3. Enter the text for the index entry and press RETURN.

   Uniplex enters an index line in the document:
Index

 Secondary Entry

As well as having index entries that only contain one word you can have index entries with many subentries. To add an index entry with subentries:

1 Move to the text to which the index entry will refer.

2 Select the following options from the command menu:
   Tools ➔ Index/Contents ➔ Index

Uniplex prompts for the index entry you want to make.

3 Enter the text you require as the index entry and subentries and press RETURN. Use the following format:

   entry > subentry > subentry...

where entry is the first level index entry and subentry is the index subentry. You can enter as many subentries as you wish. Ensure that you separate each level of entry with a greater than sign (>). For example:

   River > Germany > Rhine

This entry appears as follows when you generate the index:

   River
     Germany
     Rhine 6

Inverse Entry

To save time and make indexing easier you can create two index references from one index entry, each being the inverse of the other. To add inverse index entries:

1 Move to the text to which the index entry will refer.
2 Select the following options from the command menu:

Tools ➔ Index/Contents ➔ Index

Uniplex prompts for the index entry you want to make.

3 Enter the text you require as the inverse index entries and press RETURN. Use the following format:

entry1>entry2

where entry1 is the first index entry and entry2 is the second index entry. For example:

River>Germany

This entry appears as follows when you generate the index:

Germany
River 6
River
Germany 6

Effects

When you add the index entries, you can add any effect to any part of any entry. For example, you can have the main entries in bold and the subentries in italics. To add an effect to an index entry:

1 Move to the text to which the index entry will refer.

2 Select the following options from the command menu:

Tools ➔ Index/Contents ➔ Index

Uniplex prompts for the index entry you want to make.
Index

3 Enter the text and effect you require and press RETURN. Use the following format:

\((@\text{effect}) \text{ entry}>(@\text{effect}) \text{ subentry})\ ...

where \text{effect} is the effect character for the effect you want to use \((i.e., \text{enter A for a bold effect}), \text{ entry} is the index entry, and \text{ subentry} is the subentry.

You must specify an effect character for each part of the entry. Entering one effect character at the beginning of the entry does not effect the whole entry. For example, if you want both the entry and subentry to be bold you enter:

\(\text{@A River>@A Germany}\)

If you want the entry in bold and the subentry in italics enter:

\(\text{@A River>@I Germany}\)

This entry appears as follows when you generate the index:

River

\(\text{Germany 6}\)

\diamond \text{Multiple Indexes}

You can create as many different indexes as you wish from the same document. Give each index entry a label to determine the index. For example, you could call one index English, one American, and one Canadian. You specify which entries you want Uniplex to use by giving it the relevant label when you generate the index. You can still generate the unlabeled entries separately from the labeled one if you label one set of entries and not another. To create multiple indexes from one document:

1 Move to the text to which the index entry will refer.
2 Select the following options from the command menu:

Tools ➤ Index/Contents ➤ Index

Uniplex prompts for the index entry you want to make.

3 Enter the text you require as the label as well as the entry and subentries and press RETURN. Use the following format:

\texttt{label<entry>subentry...}

where \texttt{label} is the name of the index, \texttt{entry} is the index entry, and \texttt{subentry} is the subentry. For example:

American<Elevator>Shaft

or

English<Lift>Shaft

When you generate the American index it appears as follows:

Elevator
  Shaft 6

When you generate the English index it appears as follows:

Lift
  Shaft 6

You can use all the available entry types such as effected entries and inverse entries when you create multiple indexes.
You specify a default numbering style for the index when you generate it. You can override this style by specifying a numbering style for individual entries when you enter them in the document using one of the following index entry numbering styles:

<table>
<thead>
<tr>
<th>Example Entry</th>
<th>Example Index</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| River>Germany !# | River         | Page number.  
               | Germany 6     |             |
| River>Germany !#S # | River         | Section, space,  
               | Germany 1 6  | and page number. |
| River>Germany !#S-# | River         | Section, hyphen (-), and page number.  
               | Germany 1-6   |             |
| River>Germany !#S.# | River         | Section, period (.), and page number.  
               | Germany 1.6   |             |
| River>Germany !Page # | River         | Page, then page  
               | Germany Page 6 | number.       |
| River>Germany !#B#S-# | River         | Section and page numbers for start  
               | Germany 1-6 to 1-8 | of block (#B) and  
               |               | end of block (#E). |
| River>Germany !#E#S-# | River         | Section, page,  
               | Germany 1-6 1.2 | and paragraph  
               |               | numbers.      |

You must have section or paragraph numbering set in the document when you use a section number or paragraph number. See **Numbering** for details.
The above styles are only examples of the possible index numbering styles. You can use the commands #, #S, #P, #B, and #E in any combination to produce an index numbering style. To specify a numbering style for an individual index entry:

1. Move to the text to which the index entry will refer.

2. Select the following options from the command menu:

   Tools ➔ Index/Contents ➔ Index

   Uniplex prompts for the index entry you want to make.

   To add index entries without using the command menu:

   1. Move to the left edge of the line to be indexed.

   2. Press CTRL o

      Uniplex opens up a line at the current cursor position.

   3. Enter the index entry preceded by .IX:

      .IX Rivers>Germany>Rhine

      You can enter all the types of index entry, such as inverse entries and effected entries, after the .IX command.

   4. Press RETURN.

      Uniplex enters an index line in the document.

3. Enter the text for the index entry followed by the numbering style and press RETURN. Use the following format:

   entry>subentry !style

---

3-227
Index

where entry is the index entry, subentry is the subentry, and style is the numbering style:

River＞Germany !#S-#

This entry appears as follows whether or not you specify this as the default numbering style:

River

     Germany 1-6

Edit an Entry

To edit any index entry:

1 Move the cursor onto the same line as the entry.

2 Select the following options from the command menu:

   Edit ➔ Edit-Print

   or

   Press . (period)

   Uniplex prompts for the new index entry.

3 Enter the new index entry and press RETURN.

   or

   Press CTRL x then RETURN, to delete the entry.

   To delete the entire index command, move cursor onto the same line as the command then press CTRL x.
Generate

You generate the index after making all the index entries. You can specify the following:

- The name of the index file. Use a name which refers to the document for which you are creating the index. For example, if the document is called *Ireland*, call the index *Ireland.index*.

- One of two layout options. Dot-separated, right-aligned:

  Ireland.................................................................1-6
  Luxembourg.........................................................1-10

  Ragged-right:

  Ireland 1-6
  Luxembourg 1-10

- Which index to generate. You can specify which index you want to create if the document contains entries for multiple indexes.

- The index width. You can generate the index so that Uniplex scales it to the size of the paper or you can specify the width in characters for the index.

- The amount of indent from the left margin.

- The amount of offset between each level of entry.

- The index reference numbering style. The available styles are:

<table>
<thead>
<tr>
<th>Style</th>
<th>Example</th>
<th>Style</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>1</td>
<td>#S.#</td>
<td>1.1</td>
</tr>
<tr>
<td>#S-#</td>
<td>1-1</td>
<td>Page #</td>
<td>Page 1</td>
</tr>
</tbody>
</table>
Index

To generate the index:

1. Save and exit from the document.
2. Select Build Index/Contents from the Word Processor menu.
   Uniplex prompts for the document to be indexed.
3. Enter the name of the document and press RETURN.
   Uniplex displays the Build Index/Contents form:

<table>
<thead>
<tr>
<th>ENTER DETAILS</th>
<th>INDEX GENERATION</th>
<th>Page 1/2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document to store index</td>
<td>[index.or.toc______________]</td>
<td></td>
</tr>
<tr>
<td>Index or Contents?</td>
<td>[Table of Contents________]</td>
<td></td>
</tr>
<tr>
<td>Index layout style</td>
<td>[Ragged-right references____]</td>
<td></td>
</tr>
<tr>
<td>Only use items labeled</td>
<td>[____________]</td>
<td></td>
</tr>
<tr>
<td>Index width</td>
<td>[0___] characters</td>
<td></td>
</tr>
<tr>
<td>Width of index indents</td>
<td>[3___] characters</td>
<td></td>
</tr>
<tr>
<td>Index offset</td>
<td>[3___] characters</td>
<td></td>
</tr>
<tr>
<td>Default reference format</td>
<td>[#________________________]</td>
<td></td>
</tr>
</tbody>
</table>

YOU MUST NOW SPECIFY EXACTLY HOW THE DOCUMENT YOU ARE INDEXING WAS PRINTED

| Name of document | [europe____________________] |
| Printer | [Laser: Portrait____________] |
| Style | [Quality____________________] |

(Use DOWNARROW to access additional printing options)
F1=Enter  F2=Redraw  F3>Edit  F4=Quit  F6>Record
4 Complete the form by using the arrow keys to move between fields and SPACEBAR to scroll to available options or press any character to display a pick and point list of the options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document to Store Index</td>
<td>Enter a name for the index document.</td>
</tr>
<tr>
<td>Index or Contents?</td>
<td>Select Index.</td>
</tr>
<tr>
<td>Index Layout Style</td>
<td>Select a layout style.</td>
</tr>
<tr>
<td>Only Use Items Labeled</td>
<td>Enter an entry label or leave blank if entries are not labeled.</td>
</tr>
<tr>
<td>Index Width</td>
<td>Enter a width in characters or leave as 0 to scale to the paper size.</td>
</tr>
<tr>
<td>Width of Index Indents</td>
<td>Enter a width in characters to indent the left index edge.</td>
</tr>
<tr>
<td>Index Offset</td>
<td>Enter the offset in characters between each level of entry.</td>
</tr>
<tr>
<td>Default Reference Format</td>
<td>Select a numbering style. Any style specified for individual entries will override this value.</td>
</tr>
</tbody>
</table>

Complete the last three fields as if you were printing the main document. This ensures that Uniplex enters the correct page references for all the entries. See the Printing chapter for more details of selecting a printer and a style.

5 When the form is complete press F1 or ESC e.

Uniplex generates the index using these criteria and places it in the file you specified.
Table of Contents

Table of Contents

A table of contents is a list in page number order of all the sections in the document. It lets a reader navigate the document easily to find a particular section. A table of contents is usually placed at the beginning of a document to provide an overview of the document structure and its basic content. It lists the section and subsection names in the order in which they occur. Creating a table of contents takes three steps:

- **Plan.** The organization of the table of contents must be planned carefully or it will not serve its required purpose.
- **Add Entries.** Each item to appear in the table of contents must be identified and properly marked in the document.
- **Generate.** The table of contents entries in the document are used to produce the table of contents file with page references.

**Plan**

Planning is the most important part of creating the table of contents. If you do not plan the table of contents correctly before you add the entries and generate it, it will not serve its required purpose. Remember these points:

- Determine how much detail you want the table of contents to contain. Do you want to include entries for every level of heading or just the main heading for each section?
- Ensure that you use exactly the same text in the table of contents entries as you have for the headings in the document.
- You can add table of contents entries that are not headings, for example, for a table or a diagram.
Add Entries

You should add a table of contents entry immediately below each heading. Ensure that the entry and heading text are an exact match. You can make the following types of table of contents entry:

- Multiple Levels:
  - The USA 1
    - East Coast 3
    - New York 5
    - New Jersey 8
    - West Coast 14
    - California 16
    - Alaska 20

- Print Effects:
  - The USA 1
    - East Coast 3
    - New York 5
    - New Jersey 8
    - West Coast 14
    - California 16
    - Alaska 20

- Two tables of contents from the same document. For example, one table of contents containing main headings only and another containing all levels of headings.

- Entries with different numbering styles and separators.
  - The USA 1-1 to 1-22
    - East Coast 1-3
    - New York 5

Primary Entry

To add a single level table of contents entry:

1. Move to the line below the heading to which the table of contents entry refers.

2. Select the following options from the command menu:

   Tools ➔ Index/Contents ➔ Contents

   Uniplex prompts for the table of contents entry.
Table of Contents

3 Enter the text for the entry and press RETURN.

Uniplex enters a table of contents line in the document:

Table of Contents: The United States of America

Secondary Entry

You can have table of contents entries with as many subentries as you require. To add a table of contents entry with subentries:

1 Move to the line below the heading to which the table of contents entry refers.

2 Select the following options from the command menu:

Tools ➔ Index/Contents ➔ Contents

Uniplex prompts for the table of contents entry.

3 Enter the text for the table of contents entry and subentries and press RETURN. Use the following format:

entry>subentry>subentry...

where entry is the first level table of contents entry and subentry is the table of contents subentry. You can enter as many subentries as you wish. Ensure that you separate each level of entry with a greater than sign (>). For example:

The USA-East Coast-New York

This entry is included with the other entries when you generate the table of contents:

The USA 1
East Coast 3
New York 5 ← The above example entry.
New Jersey 8
Effects

You can add any effect to any part of any entry when you add the table of contents entries. For example, you can have the main entries in bold and the subentries in italics. To add an effect:

1. Move to the line below the heading to which the table of contents entry refers.

2. Select the following options from the command menu:

   Tools ➞ Index/Contents ➞ Contents

   Uniplex prompts for the table of contents entry.

3. Enter the text and effect in this format and press RETURN:

   (@effect) entry>(@effect) subentry...

   where effect is the effect character for the effect you want to use (i.e., enter A for a bold effect), entry is the table of contents entry, and subentry is the subentry.

   You must specify an effect character for each part of the entry. Entering one effect character at the beginning of the entry does not affect the whole entry. For example, if you want both the entry and subentry to be bold you enter:

   @A The USA>@A East Coast

   If you want the entry in bold and the subentry in italics enter:

   @A The USA>@I East Coast

   The generated entry appears as follows:

   The USA
   East Coast 1-3
Table of Contents

* Multiple Tables of Contents

You can create multiple tables of contents by giving each entry a label (i.e., Detail and Summary). You then specify the label when you generate the table of contents. To create multiple tables of contents from one document:

1. Move to the line below the heading to which the table of contents entry refers.

2. Select the following options from the command menu:

   Tools ➔ Index/Contents ➔ Contents

   Uniplex prompts for the table of contents entry.

3. Enter the text for the label, the entry, and subentries and press RETURN. Use the following format:

   label<entry><subentry>

   where *label* is the table of contents name, *entry* is the table of contents entry, and *subentry* is the subentry. For example:

   *Detail<The USA>East Coast>New York*

   or

   *Summary>New York*

   The Detail table of contents appears as follows:

   The USA
   East Coast
   New York

   The Summary table of contents appears as follows:

   New York
Numbering Style

You specify a default numbering style for the table of contents when you generate it. You can override this style by specifying a numbering style for individual entries when you enter them in the document. You can specify one of the following table of contents entry numbering styles:

<table>
<thead>
<tr>
<th>Example Entry</th>
<th>Example T of C</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ireland&gt;Dublin !#</td>
<td>Ireland</td>
<td>Page number.</td>
</tr>
<tr>
<td></td>
<td>Dublin... 6</td>
<td></td>
</tr>
<tr>
<td>Ireland&gt;Dublin !#S #</td>
<td>Ireland</td>
<td>Section, space, and page number.</td>
</tr>
<tr>
<td></td>
<td>Dublin... 1 6</td>
<td></td>
</tr>
<tr>
<td>Ireland&gt;Dublin !#S-#</td>
<td>Ireland</td>
<td>Section, hyphen (-), and page number.</td>
</tr>
<tr>
<td></td>
<td>Dublin... 1-6</td>
<td></td>
</tr>
<tr>
<td>Ireland&gt;Dublin !#S.#</td>
<td>Ireland</td>
<td>Section, period (.), and page number.</td>
</tr>
<tr>
<td></td>
<td>Dublin... 1.6</td>
<td></td>
</tr>
<tr>
<td>Ireland&gt;Dublin !Page #</td>
<td>Ireland</td>
<td>Page, then page number.</td>
</tr>
<tr>
<td></td>
<td>Dublin... Page 6</td>
<td></td>
</tr>
<tr>
<td>Ireland&gt;Dublin !#S-# #P</td>
<td>Ireland</td>
<td>Section, page, and paragraph numbers.</td>
</tr>
<tr>
<td></td>
<td>Dublin... 1-6 1.2</td>
<td></td>
</tr>
</tbody>
</table>

You must have section or paragraph numbering set in the document when you use a section number or paragraph number. See Numbering for details.

The above styles are only examples of the possible table of contents numbering styles. You can use the commands #, #S, and #P in any combination to produce a table of contents numbering style. To specify a numbering style for an individual entry:

1. Move to the line below the heading to which the table of contents entry will refer.
Table of Contents

2 Select the following options from the command menu:

   Tools ➔ Index/Contents ➔ Contents

Uniplex prompts for the table of contents entry.

To add table of contents entries without using the command menu:

1 Move to the left edge of the line which references the table of contents entry.

2 Press CTRL o

Uniplex opens up a line at the current cursor position.

3 Enter the table of contents entry preceded by .IC:

   .IC The USA>East Coast> New York

You can enter all the types of table of contents entry, such as effected, after the .IC @A command.

4 Press RETURN.

Uniplex enters a table of contents line in the document.

3 Enter the text for the table of contents entry followed by the numbering style and press RETURN. Use the following format:

   entry>subentry !style

where entry is the table of contents entry, subentry is the subentry, and style is the numbering style:

   Ireland>Dublin !#S-#
This entry appears as follows whether or not you specify this as the default numbering style:

Ireland
Dublin 1-6

Edit an Entry

To edit any table of contents entry:

1. Move the cursor onto the same line as the entry.
2. Select the following options from the command menu:
   - Edit ➔ Edit-Print
   - Press . (period)
   - Uniplex prompts for the table of contents entry.
3. Enter the new entry and press RETURN.
   - or
   - Press CTRL x then RETURN, to delete the command value.

Generate

You can generate the table of contents after making all the table of contents entries. You can specify the following:

- The name of the table of contents file. Use a name which refers to the document for which you are creating the table of con-
Table of Contents

tents. For example, if the document is called Ireland, call the table of contents Ireland.toc.

- One of two layout options. Dot-separated, right-aligned:

  The USA.........................................................1-1
  East Coast....................................................1-3

  Ragged-right:

  The USA 1-2
  East Coast 1-6

- Which table of contents to generate. You can specify which table of contents you want to create if the document contains entries for multiple tables of contents.

- The table of contents width. You can generate the table of contents so that Uniplex scales it to the size of the paper or you can specify the width in characters for the table of contents.

- The amount of indent from the left margin.

- The amount of offset between each level of entry.

- The table of contents reference numbering style. The available styles are:

<table>
<thead>
<tr>
<th>Style</th>
<th>Example</th>
<th>Style</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>1</td>
<td>#S.#</td>
<td>1.1</td>
</tr>
<tr>
<td>#S-#</td>
<td>1-1</td>
<td>Page #</td>
<td>Page 1</td>
</tr>
</tbody>
</table>

To generate the table of contents:

1. Save and exit from the document.

2. Select Build Index/Contents from the Word Processor menu.
Uniplex prompts for the name of the document for which to create a table of contents.

3 Enter the name of the document and press RETURN.

Uniplex displays the Build Index/Contents form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document to Store Index</td>
<td>[index.or.toc_____________________]</td>
</tr>
<tr>
<td>Index or Contents?</td>
<td>[Table of Contents_____________________]</td>
</tr>
<tr>
<td>Index layout style</td>
<td>[Ragged-right references_____]</td>
</tr>
<tr>
<td>Only use items labeled</td>
<td>[_____________________]</td>
</tr>
<tr>
<td>Index width</td>
<td>[0_] characters</td>
</tr>
<tr>
<td>Width of index indents</td>
<td>[3_] characters</td>
</tr>
<tr>
<td>Index offset</td>
<td>[3_] characters</td>
</tr>
<tr>
<td>Default reference format</td>
<td>[#_____________________________]</td>
</tr>
</tbody>
</table>

You must now specify exactly how the document you are indexing was printed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of document</td>
<td>[europe_____________________]</td>
</tr>
<tr>
<td>Printer</td>
<td>[Laser: Portrait____________________]</td>
</tr>
<tr>
<td>Style</td>
<td>[Quality_____________________]</td>
</tr>
</tbody>
</table>

(Use DOWNARROW to access additional printing options)

F1=Enter  F2=Redraw  F3=Edit  F4=Quit  F6>Record

4 Complete the form by using the arrow keys to move between fields and SPACEBAR to scroll to available options or press any character to display a pick and point list of the options:

Field              Entry
------------------- ----------------------------------
Document to Store Index Enter a name for the table of contents document.
Index or Contents? Select Table of Contents.
## Table of Contents

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Layout Style</td>
<td>Select a layout style.</td>
</tr>
<tr>
<td>Only Use Items Labeled</td>
<td>Enter an entry label or leave blank if entries are not labeled.</td>
</tr>
<tr>
<td>Index Width</td>
<td>Enter a width in characters or leave as 0 to scale to the paper size.</td>
</tr>
<tr>
<td>Width of Index Indents</td>
<td>Enter a width in characters to indent the left table of contents edge.</td>
</tr>
<tr>
<td>Index Offset</td>
<td>Enter the amount of offset in characters between each level of entry.</td>
</tr>
<tr>
<td>Default Reference Format</td>
<td>Select a numbering style. Any numbering style specified for individual entries will override this value.</td>
</tr>
</tbody>
</table>

Complete the last three fields as if you were printing the main document. This ensures that Uniplex calculates the correct page references for all the entries. See the **Printing** chapter for more details of selecting a printer and a style.

5  When the form is complete press **F1** or **ESC e**

Uniplex generates the table of contents using these criteria and places it in the file you specified.
Clear Current Document

When you are editing a word processor document, you may decide you want to clear the whole document and start again, or you may want to edit a different document. You can clear the contents of the current document at any time to restart with a blank document or an existing document.

Uniplex leaves the current document as it was when last saved and places you in a new word processing screen. Uniplex deletes the current document if it was a new document. Clearing the current document is similar to quitting from it and either creating a new document (New) or editing a another document (Re-edit).

To clear the current document:

1. Select the following options from the command menu:
   
   File → New

   Uniplex prompts you to confirm whether or not you want to clear the current document.

2. Select Yes to clear the current document.

   or

   Select No to return to the current document.

   If you select Yes, Uniplex clears the current document and places the cursor at the top left of the screen, ready for you to begin editing with a blank document.
Clear Current Document

◊ Edit Another Document

To edit another document:

1. Select the following options from the command menu:

   File ➔ Re-edit

   Uniplex prompts you to confirm whether or not you want to edit another current document.

2. Select Yes to edit another document.

   or

   Select No to return to the current document.

   Uniplex prompts for the name of the document you want to edit.

3. Either:

   o Enter the name of the document you want to edit and press RETURN.

   o Leave the field blank and press RETURN to create a new document.

   If you selected Yes, Uniplex clears the current document and places you in the document you selected to edit.
Browse Non-Uniplex Documents

You can use the Uniplex Word Processor to read and edit your Uniplex documents. You can also use it to browse converted copies of non-Uniplex documents such as those created with Microsoft Word or WordPerfect. When you choose a non-Uniplex word processor document for editing, Uniplex prompts you to press RETURN to view a converted copy of the file. The following pop-up appears:

<table>
<thead>
<tr>
<th>Document Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Style</td>
</tr>
<tr>
<td>Printer Class</td>
</tr>
<tr>
<td>Set to Current Ruler</td>
</tr>
<tr>
<td>Remove Document Format</td>
</tr>
</tbody>
</table>

The Format field defaults to <Automatic Format Detection>. This indicates that Uniplex will attempt to detect the file’s format before converting a copy of it. Press F1 to begin the conversion. Alternatively, if you want to specifically set the file’s format before conversion, press any key to display a list of available file types, select the correct entry, and then press F1 to begin the conversion.

You can use the F6 softkey to request that Automatic Format Detection reset the format to the type it detects.

After conversion, Uniplex opens the converted copy in the Word Processor. You can carry out any of the usual Uniplex operations such as read, print, save and so on.

For details about converting files to or from other formats see the File Manager chapter.
Import/Export Non-Uniplex Documents

If you require, you can import a non-Uniplex document into a Uniplex word processing document. You can also export a Uniplex document to a non-Uniplex format document.

Importing a non-Uniplex document is the same as merging a Uniplex document into the current document, except that the document you import contains no Uniplex formatting commands, rulers, or effects.

Similarly, when you export a Uniplex document, Uniplex removes all the editing commands, rulers, and effects from the document and places it in a non-Uniplex document.

Importing and exporting documents is useful if you use another text editor as well as Uniplex, as it enables you to edit a document in any text editor without corrupting the information contained in it.

To import a non-Uniplex document:

1. Move the cursor to the position at which you want to import the document.

2. Select the following options from the command menu:

   File ➔ Import

   Uniplex displays the Import suboptions.

3. Select the Insert-ASCII option to insert the imported document between the text.

   or

   Select the Overlay-ASCII option to overlay the imported document on top of the current text.
Import/Export Non-Uniplex Documents

Uniplex prompts for the name of the document to import.

4 Enter the name of the document to import and press RETURN.

If the document is not in the current folder, enter the full path-name, for example:

/usr/users/krb/indian

Uniplex imports the document at the current cursor position.

Export to a Non-Uniplex Document

To export the current document to a non-Uniplex document:

1 Select the following options from the command menu:

    File ➔ Xport ➔ ASCII

    Uniplex prompts for a name for the exported document.

2 Enter a name for the exported document and press RETURN.

    Uniplex exports a copy of the current document to a
    non-Uniplex document with the name you specified.

✎ The non-Uniplex document contains no formatting com-
    mands, rulers, or effects.
Operating Modes

When using Uniplex, you can change certain aspects of the way Uniplex works by changing the *operating modes*. When you change the operating modes, the new settings stay current until you change them again or until you finish the current editing session.

*If you want to save the operating modes permanently you can specify this when you set them.*

The following sections give details of the operating modes available to you. See *Set Operating Modes* for details of how to change each of these parameters.

**Set Insert Mode**

When you enter text in the document you usually enter it in *overtype* mode. This means that any text you enter overwrites existing text in the document. However, you can switch into *insert* mode at any time. Existing text is then automatically pushed to the right as you enter new text. Uniplex displays *INSERT* on the top status line when you are in insert mode. You use the Operating Modes form to turn insert mode **on** or **off**. See *Set Operating Modes* for details.

**Use Hard Returns**

When you press RETURN at the end of a line or paragraph Uniplex usually just moves to the next line on the screen. However, you can use *hard returns* to mark the line breaks permanently so they are not reformatted at print time. Hard returns are useful for a list that does not have blank lines between entries. They are entered every time you press the RETURN key at the end of a line and usually appear as a tilde on the screen:

```
The European Oceanographic Institute˜
Pacific House˜
Atlantic Boulevard˜
Brussels˜
BELGIUM˜
```
Uniplex displays ` on the status line when running in hard return mode. Use the Operating Modes form to use hard returns (yes) or not use hard returns (no). See Set Operating Modes for details.

◊ Change Position Marker

At the right edge of the top status line Uniplex displays the position marker. This tells you the position of the cursor on the current page. The position marker can show one of three things:

- Line and Column (22:25)
- Line Only (22)
- Neither

You use the Operating Modes form to specify which position marker you require: Line & Column, Line, or Off. See Set Operating Modes for details.

◊ Hyphenate Text

When you reformat all or part of the document, you can add hyphens to words at the right edge of each line. To do this you set the hyphenation operating mode. You can hyphenate the text in two ways, automatically or manually.

Automatic Hyphenation

While in automatic hyphenation mode, whenever you reformat part of the document, Uniplex checks the dictionary for suitable hyphenation points in words at the right margin of each paragraph and automatically hyphenates them if appropriate.

For example, if the word European is at the right-hand edge of the paragraph, after reformating the paragraph in automatic hyphenation mode Uniplex hyphenates the word as Euro-pan and splits it over two lines.
Operating Modes

If the word is not in the dictionary, or does not have any suitable hyphenation points, Uniplex does not hyphenate it. See Dictionary Management for details on adding new words to the dictionary.

When you are in automatic hyphenation mode Uniplex displays AUTO- on the top status line.

Manual Hyphenation

While in manual hyphenation mode, whenever you reformat part of the document, Uniplex displays the end of the current line on the top status line with the cursor at the rightmost hyphenation point:

"-" to hyphenate or RETURN to skip: tourists, the majority are European

You have the following options:

<table>
<thead>
<tr>
<th>Press</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>RETURN</td>
<td>Skip the current word.</td>
</tr>
<tr>
<td>-</td>
<td>Accept the current hyphenation point. Uniplex hyphenates the word and checks for further hyphenation points.</td>
</tr>
<tr>
<td>cursor left or cursor right</td>
<td>Move the hyphenation point to a different position in the word. To accept the new hyphenation position press hyphen (-). Uniplex hyphenates the word and checks for further hyphenation points.</td>
</tr>
</tbody>
</table>

When you are in manual hyphenation mode Uniplex displays HYPHEN on the top status line. You use the Operating Modes form to specify which hyphenation mode you require: Automatic, Manual, or Off. See Set Operating Modes for details.
Reformat Text Automatically

Uniplex does not usually reformat text as you enter it until you ask it to. However, you can use Automatic Reformat mode to reformat the text as you enter it to match the current ruler.

In Automatic Reformat mode when the cursor reaches the right edge of the screen and wraps down to the next line, or you press RETURN at the end of a line, Uniplex automatically reformats the line to match the current ruler.

This is particularly useful if you are using a justified ruler as Uniplex justifies each line as you type it and gives you a straight edge at each margin. However, when editing existing text under a justified ruler, you will need to explicitly issue a format command such as, \texttt{CTRL f p}, for the text to be reformatted.

\textit{Automatic Reformatting does not work in multiple columns when in insert mode or when editing existing text.}

When you are in Automatic Reformat mode Uniplex displays \texttt{JUSTIFY} on the top status line.

You use the Operating Modes form to specify whether you want Automatic Reformat mode on (\texttt{Yes}) or off (\texttt{No}). See \textit{Set Operating Modes} for details.

Use Tab Mode

When you press RETURN, by default, Uniplex moves the cursor to the left edge of the screen. If you use rulers with indented left margins, you can turn on \texttt{Tab mode}, so when you press RETURN Uniplex moves the cursor to the current left margin rather than the left edge of the screen.

When you are in Tab mode Uniplex displays \texttt{TAB} on the top status line. You use the Operating Modes form to specify whether you want Tab mode on (\texttt{Yes}) or off (\texttt{No}). See \textit{Set Operating Modes} for details.
Operating Modes

Set Auto Save

When editing a document using Uniplex you can save the document automatically at regular intervals using autosaving. You can specify to autosave the document after a specified number of characters and/or a specified number of minutes.

When Uniplex autosaves a copy of the document, it saves it to a temporary file, in the trashcan directory with the name, WP.AUTOnnnnnnn. You can use this file to recover work in the event of a system crash. Uniplex automatically removes the file at the end of each editing session.

When you set Autosave using Uniplex, it overrides any defaults set by the System Administrator for the current session.

You use the Operating Modes form to specify which form of autosaving you require. You specify whether you want Uniplex to autosave after you have entered a specific number of characters (chars) and/or after a specific number of minutes (Time). See Set Operating Modes for details.

If you specify to autosave the document after a specific number of minutes, Uniplex only saves the document if you have changed it since the previous save.

Recover Auto Saved Document

If your system crashes, you can recover the document you were last working on, if you have autosave set, by using the File Manager to restore files from the Trashcan.

To recover an autosaved document still in the Trashcan:

1. Open the File Manager.
2. Choose View ➔ Open Folder...
Operating Modes

3 In the **Select folder to open** field, choose **Trashcan** and press **F1 (Esc e)**.

File Manager displays the contents of the Trashcan.

4 Select the file(s) to restore and then use:

    *File ➔ Action ➔ Move* to move them back.

You can now edit the recovered document as you require. For more detail, see *Restore Files from the Trashcan* in the **File Manager** chapter.

⚠️ *The autosaved document you recover may not be a completely up-to-date version of the document you were editing as it is a copy of the document at the last autosave.*

Display Command Hints

When you perform tasks using Uniplex, you can use either the command menu or key commands. Although the command menu is easier to learn, using key commands can be much quicker for the experienced user.

To help you learn the key commands Uniplex displays *command hints* on the status line, containing the equivalent key command, whenever you perform certain command menu tasks, for example:

```
HINT - to set Insert mode on/off enter :  ESC i
```

If you want, you can stop Uniplex from displaying command hints on the screen. You use the Operating Modes form to specify whether you want Uniplex to display command hints on the screen (**Yes**) or not (**No**). See *Set Operating Modes* for details.
Operating Modes

◊ Set Command Menu Access Character

To access the command menu with the last option you selected highlighted, set this option with whichever character you wish to use. For example, you can use \ (backslash), or ^ (carat).

If you specify a command menu access character you can only enter that character in a document by pressing the key twice.

You use the Operating Modes form to specify which character you want to use to access the command menu, if any. See Set Operating Modes for details.

◊ Set Cursor Wrapping

By default, Uniplex only wraps the cursor onto the next line when you reach the right hand margin while entering text (word wrap). You can set cursor wrapping so the cursor wraps to the next or previous line whenever it reaches a left or right margin. Uniplex wraps the cursor down to the next line, beneath the left margin character for that column, when it reaches the right margin of a column. Uniplex wraps the cursor up to the last character of the previous line, in that column, when the cursor reaches the left margin.

You can only land on rulers or formatting commands by using the up and down cursor keys when cursor wrapping is turned on. You use the Operating Modes form to turn cursor wrapping On or Off. See Set Operating Modes for details.

◊ Align Multiple Columns

You can ensure that when you edit text in one of multiple columns, text below the column stays aligned. See Multiple Column/Align Text, earlier in this chapter, for more details. You use the Operating Modes form to turn multiple column alignment on (Yes) or off (No). See Set Operating Modes for details.
Generate Style Information

When a new document is created within the Word Processor you can choose to record some of the information about the Style, the Printer and the Default Ruler that you use to print within the document. This enables someone other than the documents creator to print the document in the way that you intended it to be presented.

This option can be turned on (Yes) or off (No) using the Operating Modes form as described in Set Operating Modes.

Set Operating Modes

This section describes how to set the operating modes. You can either set them for the current editing session only or permanently by making the appropriate entry in the Operating Modes form.

<table>
<thead>
<tr>
<th>Working Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Mode</td>
</tr>
<tr>
<td>Hard returns</td>
</tr>
<tr>
<td>Column Count</td>
</tr>
<tr>
<td>Hyphenation</td>
</tr>
<tr>
<td>Automatic Reformat</td>
</tr>
<tr>
<td>Tab Mode</td>
</tr>
<tr>
<td>Autosave : Chars</td>
</tr>
<tr>
<td>Autosave : Minutes</td>
</tr>
<tr>
<td>Command hints</td>
</tr>
<tr>
<td>Character to enter MENUS</td>
</tr>
<tr>
<td>Cursor Wrap</td>
</tr>
<tr>
<td>Blank line to align columns</td>
</tr>
<tr>
<td>Generate Style Information</td>
</tr>
<tr>
<td>Save Options &amp; Rulers</td>
</tr>
</tbody>
</table>
Operating Modes

To set the operating modes:

1. Select the following options from the command menu:

   Options ➔ Modes

   Uniplex displays the current operating modes.

2. Complete the form as follows. Use the arrow keys to move between fields and the SPACEBAR to scroll to the options you require. Press any character key to display a pick and point list of the options available in each field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Mode</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>Off</td>
</tr>
<tr>
<td>Hard Returns</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Column Count</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Line</td>
</tr>
<tr>
<td></td>
<td>Line &amp; Column</td>
</tr>
<tr>
<td>Hyphenation</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Automatic</td>
</tr>
<tr>
<td></td>
<td>Manual</td>
</tr>
<tr>
<td>Automatic Reformat</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
</tbody>
</table>

Insert mode on.
Insert mode off.
Hard returns on.
Hard returns off.
Position marker off.
Line position marker on.
Line and column markers on.
Hyphenation off.
Automatic hyphenation on.
Manual hyphenation on.
Automatic reformat on.
Automatic reformat off.
### Operating Modes

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry/Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autosave:</td>
<td></td>
</tr>
<tr>
<td>Chars</td>
<td>Enter the number of characters after which you want the document to autosave.</td>
</tr>
<tr>
<td>Autosave:</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Enter the number of minutes after which you want the document to autosave.</td>
</tr>
<tr>
<td>Command Hints</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Command hints on.</td>
</tr>
<tr>
<td>No</td>
<td>Command hints off.</td>
</tr>
<tr>
<td>Character to Enter MENUS</td>
<td></td>
</tr>
<tr>
<td>Blank Line to Align Columns</td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>Multiple columns not aligned after a blank line.</td>
</tr>
<tr>
<td>Yes</td>
<td>Multiple columns are aligned after a blank line.</td>
</tr>
<tr>
<td>Generate Style Information</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>The first two lines of new documents will contain a record of the creator’s</td>
</tr>
<tr>
<td></td>
<td>default style, printer, and ruler.</td>
</tr>
<tr>
<td>No</td>
<td>New documents will be empty.</td>
</tr>
<tr>
<td>Save Options and Rulers</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Saves the current working options and rulers permanently.</td>
</tr>
<tr>
<td>No</td>
<td>Saves the options/rulers for the editing session only.</td>
</tr>
</tbody>
</table>
Operating Modes

3  When the form is as you require press ESC e.

Uniplex makes the operating mode settings in the form current. If you have specified to save the options and rulers permanently they will stay current until you save them again, even if you quit from Uniplex. Otherwise Uniplex saves the current options and rulers for the current editing session only.

Changing the **Save Options and Rulers** field to **Yes** and then saving the Working Options form does a one-time permanent save of those parameters. You must return to the form, ensure this field is set to **Yes**, and then save the form again if you want to make further permanent changes to the rulers or options.
Windows

Windows let you view different portions of the document at the same time, one part in the upper half of the screen and another part in the lower half of the screen. For example, you can view a summary that appears at the beginning of the document in one window and scroll through the rest of the document in another window to ensure that all the information is covered.

Open a Window

Opening a window in a document means that the screen splits in two, allowing you to view two separate portions of the same document. You can switch easily between the windows and work with either. Before you open a window the screen looks like this:

```
UNIPLEX   TAB   PL66  #1  1:1


Print Style and Printer: Fixed-pitch, printer 1

In a recent interview, Olympic Marathon runner Andy Stevens admitted that, during his run around the coastline of Great Britain he wore out fifty-five pairs of running shoes.
```
Windows

When you have opened the window the screen looks like this:

```
UNIPLEXTAB[1]PL66 #1 1:1

-.-.T.-----T.-----T.-----T.-----T.-----T.-----R
Print Style and Printer: Fixed-pitch, printer 1
<=>End Pre-styled Document Format=>
In a recent interview, Olympic Marathon runner Andy Stevens admitted that, during his run around the coastline of Great Britain he wore out fifty-five pairs of running shoes.

-.-.T.-----T.-----T.-----T.-----T.-----T.-----R
Print Style and Printer: Fixed-pitch, printer 1
<=>End Pre-styled Document Format=>
In a recent interview, Olympic Marathon runner Andy Stevens admitted that, during his run around the coastline of Great Britain he wore out fifty-five pairs of running shoes.
```

You can move around the document in one window or the other independently. For example, if you scroll through the document while working in the lower portion of the screen, the text in the upper portion stays static. When you are in the top window Uniplex displays [1] on the status line and when you are in the bottom window Uniplex displays [2].

Select these options from the command menu to open a window:

- Options ➞ Windows ➞ Open
- or
- Press ESC y o

Uniplex splits the screen into two equal portions and leaves the cursor in the upper portion of the screen.
Switch between Windows

When you are working with two windows, you can move the cursor from one window to another. This is known as switching between windows. Select the following options from the command menu:

Options ➔ Windows ➔ Switch

or

Press ESC y s

Uniplex moves the cursor to the last position it occupied in the previous window.

Close a Window

You can resume work on a full screen at any time. Select the following options from the command menu to close a window:

Options ➔ Windows ➔ Close

or

Press ESC y c

Uniplex displays the portion of the document on which you were working in a full screen.
When you edit a document you may decide you want a particular piece of text to be in a specific font. A font is made up of a typeface, an effect, and a point size. The following table explains these terms:

<table>
<thead>
<tr>
<th>Term</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typeface</td>
<td>A particular design of printing type. For example:</td>
</tr>
<tr>
<td></td>
<td>courier or helvetica</td>
</tr>
<tr>
<td>Effect</td>
<td>An effect of a particular typeface. For example:</td>
</tr>
<tr>
<td></td>
<td>bold or italic</td>
</tr>
<tr>
<td>Point size</td>
<td>The size of characters. For example:</td>
</tr>
<tr>
<td></td>
<td>14 point</td>
</tr>
<tr>
<td></td>
<td>10 point</td>
</tr>
<tr>
<td></td>
<td>8 point</td>
</tr>
</tbody>
</table>

You can specify a font containing any mixture of these three characteristics for any text in the document. Uniplex finds a best fit if a characteristic is not available. For example, if you specify 12 point text, but your printer can only print in 8 point or 10 point, Uniplex prints the text in 10 point as this is the nearest point size. Uniplex matches characteristics in priority of point size, effect, and then typeface. For example, if you specify 12 Point Bold Helvetica and your printer only has the following fonts available:

10 Point Bold Helvetica
12 Point Italic Helvetica
12 Point Bold Courier

Uniplex prints the text in 12 Point Bold Courier.
Select Font

To use a different font:

1. Move the cursor to the line immediately above the first line of text you want to affect.

2. Select the following options from the command menu:

   Layout ➔ Set_Font ➔ Font-start

   Uniplex displays the Select Font form:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typeface</td>
<td>[Helvetica]</td>
</tr>
<tr>
<td>Effect</td>
<td>[NORMAL]</td>
</tr>
<tr>
<td>Point Size</td>
<td>[10]</td>
</tr>
</tbody>
</table>

3. Complete the form by using the arrow keys to move between fields and the SPACEBAR to select the option you require. Press any character key to display a pick and point list of the available options in each field:

   Field  Entry
   --------
   Typeface  Select the typeface.
   Effect    NORMAL  Prints text in normal style.
              BOLD     Prints text in **bold**.
              ITALIC   Prints text in *italic*.
              BOLD ITALIC  Prints text in **bold italic**.
   Point Size Enter the point size in the range 2 to 128 with up to one decimal place.
4 When the form is complete press ESC e.

The Select Font pop-up shows the values of a preceding .FN line if you are entering a new change font command from the command menu.

Uniplex enters a change font command at the current cursor position. For example:

Font: Bold, Helvetica, 12

All text following this command is printed in this font, or a best fit, unless you change it.

You can use a different font without using the command menu:

1 Move the cursor to the far left of the line immediately above the first line of text you want to affect.

2 Enter .FN style,typeface,point-size and press RETURN.

A change font command appears at the cursor position.

Style, typeface, and point size are variable entries, but the comma separators are mandatory. You can specify a new point size without changing the current style or typeface:

.FN ,,point size

Change the print style and point size but not the typeface:

.FN style,,point size
Edit Font

To edit a change font command:

1. Move the cursor onto the line of the change font command and press . (period). One of the following happens:

   - The pop-up redisplays if the values in the command match any values available from the Select Font pop-up:

<table>
<thead>
<tr>
<th>Select Font</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typeface</td>
</tr>
<tr>
<td>Effect</td>
</tr>
<tr>
<td>Point Size</td>
</tr>
</tbody>
</table>

   - An edit field appears if the values in the command do not match any values available from the Select Font pop-up:

   ```
   Set font: [ITALIC,TimesRoman,10___________]
   ```

   Edit the values as usual or press F5 to display a list of predefined font names and choose one from this list. See Predefined Font Names for more details.

2. To change any of the values, in the **Typeface**, **Effect**, and **Point Size** fields, choose the values you require.

3. Press F1 (Esc e) when finished.

Predefined Font Names

Uniplex supplies a number of predefined fonts that can be used with any supported printer. Each font has a font definition entry in the configuration file which specifies the features of predefined fonts that can be used by a specific printer. The following table shows the
Fonts

standard font names supplied with Uniplex; the System Administrator may have defined additional font names for you.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX-NORMAL</td>
<td>Prints normal text in fixed pitch.</td>
</tr>
<tr>
<td>PS-NORMAL</td>
<td>Prints normal text proportionally spaced.</td>
</tr>
<tr>
<td>NORMAL</td>
<td>Prints in either FX-NORMAL or PS-NORMAL, depending on which is used as the default font.</td>
</tr>
<tr>
<td>FX-SMALL</td>
<td>Prints in a small fixed-pitch font.</td>
</tr>
<tr>
<td>PS-SMALL</td>
<td>Prints in a small proportionally-spaced font.</td>
</tr>
<tr>
<td>SMALL</td>
<td>Prints in a small font in either fixed pitch or proportional spacing per the printer configuration.</td>
</tr>
<tr>
<td>ITALIC</td>
<td>Prints in an italic font.</td>
</tr>
<tr>
<td>BOLD</td>
<td>Prints in a bold font.</td>
</tr>
<tr>
<td>LARGE</td>
<td>Prints in a large font.</td>
</tr>
</tbody>
</table>

\* If your printer does not have one of these fonts, the System Administrator may have specified a similar font for you. \*

Reset Font

If you have changed the font for a particular piece of the document, you can easily reset the default font at the end of that section:

1. Move the cursor to the line immediately above the first line of text you want to affect.

2. Select the following options from the command menu:

   Layout → Set_Font → Reset-Font

   Uniplex enters a change font command to the default font.
Mail Merge

If you want to send the same letter to a number of people, but do not want to type in each letter and address individually, you can use Mail Merge.

When you use Mail Merge you can create a file containing the addresses of all the people you want to send the letter to, an address file, and create a standard letter to send to them. You can then run Mail Merge and Uniplex merges each address in the address file with the standard letter.

You can have as many standard letters and address files as you like and you can merge any address file with any standard letter.

If you only want to do a one off Mail Merge, or you do not want to send the letter to many people, you can run an Interactive Mail Merge. When you run an Interactive Mail Merge you do not use an address file, but simply enter the information when you run the Mail Merge.

Running a Mail Merge is a three stage process:

- First you create the address file and enter in all the addresses of the people you want to send the letter to.

  \(\text{If you run an Interactive Mail Merge you do not need to create an address file.}\)

- Secondly you create a standard letter containing the text of the letter you want to send. In the standard letter you also specify the position of the information you enter in the address file.

- Finally you run the Mail Merge to merge the addresses and standard letter together.

  If you are running an Interactive Mail Merge it is at this point that you enter the name and address information.
Mail Merge

Access the Mail Merge Menu

To access all the Mail Merge functions you first need to access the Mail Merge menu. Select the Mail Merge option from the Word Processor menu. Uniplex displays the Mail Merge menu:

```
MAILSHOT

MAILSHOT UTILITIES

1 - Create Standard Letter  P - Printing
2 - Create Address File      C - Change Folder
3 - Add Address to File     F - File Manager
4 - Run Mailshot

GENERAL

5 - Edit a Document         H - Help
    Q - Quit

F1=Enter  F2=Redraw  F4=Quit               F8>More

3-268
```
Create an Address File

An address file is a file which contains information about the people you want to send the Mail Merge letter to. You can create as many address files as you like which you can then merge with any standard letter.

If you want to run an Interactive Mail Merge you do not need to create an address file. See the section Run an Interactive Mail Merge for details. To create an address file:

1. Select the Create Address File option from the Mail Merge menu.

Uniplex displays the Address Form:

```
ENTER DETAILS  CREATE ADDRESS

Enter address file name [_______________________]

First name: [____________________]
Full name: [_____________________________________
Title: [_____________________________________
Company name: [_____________________________________
Address: [_____________________________________
[_____________________________________
[_____________________________________
[_____________________________________
[_____________________________________
[_____________________________________
```
Mail Merge

2. Complete the form as follows. Use the arrow keys to move between the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Address File Name</td>
<td>Enter the name for the address file.</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter the person’s first name. For example, David</td>
</tr>
<tr>
<td>Full Name</td>
<td>Enter the person’s full name. For example, Mr. D. Green</td>
</tr>
<tr>
<td>Title</td>
<td>Enter the person’s title. For example, Managing Director</td>
</tr>
<tr>
<td>Company Name</td>
<td>Enter the person’s company name. For example, World Domination Enterprises</td>
</tr>
<tr>
<td>Address</td>
<td>Enter the person’s full address. For example: Global House 153–157 Europe Street DALLAS Texas 75614 USA</td>
</tr>
</tbody>
</table>

3. When the form is as you require press **F1** or **ESC e**

Uniplex adds the information to the address file and displays the Address Form again.
4 Complete the form for each person you want to include in the address file.

5 When you have entered all the addresses you require, press ESC q

Uniplex creates the address file and includes the information you have entered.

If you make a mistake while entering the addresses you can edit it using the word processor. Simply select the Edit a Document option from the Mail Merge menu.

Add Addresses to an Address File

You can add additional addresses after creating an address file:

1 Select Add Address to File from the Mail Merge menu.

Uniplex prompts for the name of an address file.

2 Enter the name of the address file to be changed.

Uniplex displays the Add Address form.

3 Add the new addresses as described in the previous section.

Create a Standard Letter

A standard letter contains the text part of the Mail Merge. It can be as long or short as you require. When you create a standard letter you specify where in the letter you want Uniplex to enter the information from the address file. You can also specify which information you want Uniplex to enter. Uniplex places you inside the usual word processing editor.
Mail Merge

The following information is present:

.Vname
.Vformal
.Vtitle
.Vcompany
.Vadd1
.Vadd2
.Vadd3
.Vadd4
.Vadd5

_Dformal
_Dtitle
_Dcompany
_Dadd1
_Dadd2
_Dadd3
_Dadd4
_Dadd5

Dear _Nname,

Each of these fields refers to an entry in the Address File. The commands that begin with .V explain these entries to Uniplex, you cannot change these entries or their position.

The commands that begin _D or _N show the position at which the relevant entries from the Address File are printed. You can change the position of these entries as you require.

For example, if you do not want the company name included in the address delete the line _Dcompany.
You can also effect these entries like any other text. The following table relates the commands to Address File entries:

<table>
<thead>
<tr>
<th>Command</th>
<th>Address File Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Nname</td>
<td>First name</td>
</tr>
<tr>
<td>_Dformal</td>
<td>Full name</td>
</tr>
<tr>
<td>_Dtitle</td>
<td>Title</td>
</tr>
<tr>
<td>_Dcompany</td>
<td>Company name</td>
</tr>
<tr>
<td>_Dadd1</td>
<td>Address line 1</td>
</tr>
<tr>
<td>_Dadd2</td>
<td>Address line 2</td>
</tr>
<tr>
<td>_Dadd3</td>
<td>Address line 3</td>
</tr>
<tr>
<td>_Dadd4</td>
<td>Address line 4</td>
</tr>
<tr>
<td>_Dadd5</td>
<td>Address line 5</td>
</tr>
</tbody>
</table>

To create a standard letter:

1. Select the Standard Letter option from the Mail Merge menu.

   Uniplex prompts for a name for the Standard Letter.

2. Enter the name you require and press RETURN.

   Uniplex places you inside a standard word processor document with the necessary Address File commands already entered.

3. Enter the text you require as the letter and rearrange the Address File entries as necessary.

4. When the letter is as you require press **ESC e**.

   Uniplex saves the standard letter.
Mail Merge

◊ **Format a Standard Letter**

The following sections explain how the information within each address file entry should be formatted.

◊ **Left Align a Mail Merge Entry**

Ensure that information is left-aligned within an address file entry:

Global House  
153–157 Europe Street  
DALLAS  
Texas 75614  
USA

Precede the entry with _L to left align an entry; for example:

_Lcompany

◊ **Right Align a Mail Merge Entry**

Ensure that information is right-aligned within an address file entry:

Global House  
153–157 Europe Street  
DALLAS  
Texas 75614  
USA

Precede the entry with _R to right align an entry; for example:

_Radd1
Suppress Blank Lines and Spaces

Not all Mail Merge entries may contain data. For example, some addresses have two lines while others have three. Variables with no data leave blank lines and spaces in a document unless formatted otherwise. You can ensure these entries do not leave blank lines and spaces in the document.

Precede the entry with _D to ensure that Mail Merge entries leave no blank lines; for example:

_Dadd3

This directive will delete the current line if the variable contains no data, even if there is fixed text or other data on the same line.

Precede the entry with _S to ensure that Mail Merge entries leave no blank spaces; for example:

_Stitle

This directive replaces the variable with value+softspace or null if the variable contains no data.

Suppress Following Spaces

If you put two Mail Merge entries next to each other in the standard letter, for example, _Nadd1_Nadd2, you can ensure that there is no space between the entries. For example:

DALLASTexas

Precede the entry with _N to ensure that Mail Merge entries have no following spaces; for example:

_Nadd1_Nadd2
Mail Merge

◊ **Truncate Mail Merge Entries**

In certain situations it is important that the length of the information does not exceed the length of the entry. For example, if the address has to be visible in a window envelope. You can ensure that such entries are truncated at the right hand edge of the field.

Precede the entry with \_T to ensure that Mail Merge entries are truncated; for example:

\_Tadd1

◊ **Other Mail Merge Entries**

Uniplex allows combinations of formatting flags as well as variables without leading flags. These are used as follows:

o **Combined Flags.** Any number of formatting flags may be combined with a single variable. The only restrictions are that \_L, \_R, \_N, and \_S may not be combined (only one of those four flags per string) and \_D cannot be used with \_S. For example:

\_DLcompany

This directive will left align and maintain field width (\_L), but will delete the line (\_D) if there is no variable data (company).

o **Variables without Flags.** A variable may be used without a formatting flag. Simply precede the variable name with an underscore, for example:

\_company

The variable will be treated as if the \_N flag were present.
Run a Mail Merge

After creating an Address File and a Standard Letter you merge the two together by running a Mail Merge:

1. Select the Run Mail Merge option from the Mail Merge menu.
   Uniplex prompts for the standard letter name you want to use.

2. Enter the name of the standard letter and press RETURN.
   Uniplex displays the Mail Merge Selection form:

<table>
<thead>
<tr>
<th>ENTER DETAILS</th>
<th>MAILSHOT SELECTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard letter filename:</td>
<td>[japan.let___________]</td>
</tr>
<tr>
<td>Address file: (blank for interactive)</td>
<td>[Mailshot.addr__________]</td>
</tr>
<tr>
<td>Merged result in:</td>
<td>[Mailshot.doc___________]</td>
</tr>
<tr>
<td>[Create new result file_]</td>
<td></td>
</tr>
<tr>
<td>First address to merge:</td>
<td>[1____]</td>
</tr>
<tr>
<td>Last address to merge:</td>
<td>[9999_]</td>
</tr>
<tr>
<td>Page breaks between letters:</td>
<td>[YES]</td>
</tr>
</tbody>
</table>

3. Complete the form by using the arrow keys to move between fields and the SPACEBAR to scroll to available options:
<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Letter</td>
<td>Enter the name of the standard letter to use in the Mail Merge.</td>
</tr>
<tr>
<td>Filename</td>
<td></td>
</tr>
<tr>
<td>Address File</td>
<td>Enter the name of the address file to use in the Mail Merge. Blank this field to run an Interactive Mail Merge. See the following section.</td>
</tr>
<tr>
<td>Merged Result In</td>
<td>Enter the name of the document in which to store the result of the Mail Merge. Leave the second field as:</td>
</tr>
<tr>
<td></td>
<td>Create new result file</td>
</tr>
<tr>
<td></td>
<td>to create a new document with this name. Scroll the second field to:</td>
</tr>
<tr>
<td></td>
<td>Add to result file</td>
</tr>
<tr>
<td></td>
<td>to add the result of the Mail Merge to the end of this document.</td>
</tr>
<tr>
<td>First Address to</td>
<td>Enter the number of the address in the address file at which to start running the Mail Merge. Leave this field as 1 to use all the addresses in the address file.</td>
</tr>
<tr>
<td>Merge</td>
<td></td>
</tr>
<tr>
<td>Last Address to</td>
<td>Enter the number of the address in the address file at which to stop running the Mail Merge. Leave this field as 9999 to use all the addresses in the address file.</td>
</tr>
<tr>
<td>Merge</td>
<td></td>
</tr>
<tr>
<td>Page Breaks between</td>
<td>Yes  New page for each letter</td>
</tr>
<tr>
<td>Letters</td>
<td>No   Continuous letters.</td>
</tr>
</tbody>
</table>
4  When the form is as you require press F1 or ESC e

Uniplex merges the standard letter and address file you specify in the document you specify.

Run an Interactive Mail Merge

If you are only mailing to a few people or you want to send a single letter, you can run an Interactive Mail Merge. You do not need to create an address file, but simply enter each address into the standard letter when you run the Mail Merge:

1  Select the Run Mail Merge option from the Mail Merge menu.

Uniplex displays the Mail Merge Selection form.

2  Complete the form by using the arrow keys to move between fields and the SPACEBAR to scroll to available options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Letter Filename</td>
<td>Enter the name of the standard letter to use in the Mail Merge.</td>
</tr>
<tr>
<td>Address File</td>
<td>Blank out this field.</td>
</tr>
<tr>
<td>Merged Result In</td>
<td>Enter the name of the document in which to store the result of the Mail Merge.</td>
</tr>
<tr>
<td>First Address to Merge</td>
<td>Leave this field as 1.</td>
</tr>
<tr>
<td>Last Address to Merge</td>
<td>Leave this field as 9999.</td>
</tr>
<tr>
<td>Page Breaks between Letters</td>
<td>Yes  New page for each letter.  No  Continuous letters.</td>
</tr>
</tbody>
</table>

3  When the form is as you require press F1 or ESC e
Mail Merge

Uniplex displays the standard letter and prompts you for each piece of information you need to enter. For example:

```
Enter new characters or RETURN to delete

formal:

-- UNIPLEX MAIL MERGE -- washington.let
```

4 Enter each piece of information as asked and press RETURN.
   * Use the BACKSPACE key to make editing changes.

5 When you reach the end of the letter:
   Press RETURN to continue with the Mail Merge.
   or
   Press * RETURN to end the Mail Merge.

When you end the Mail Merge, Uniplex merges the standard letter and address file you specify in the document you specify.
◊ **Edit a Mail Merge Document**

You can view the results of the Mail Merge by editing the document in which the merged results were placed:

1. Select the Edit a Document option from the Mail Merge menu.
   
   Uniplex prompts for the name of the document to edit.

2. Enter the Mail Merge document name and press RETURN.
   
   Uniplex displays the Mail Merge document on the screen. You can now edit it as necessary.
Access
   Command Menu 3-34
   Help 3-6
   Mail Merge Menu 3-268
   Word Processor 3-4
Add Text 3-43
Address File
   Add Address 3-271
   Mail Merge 3-269
Align
   Columns 3-108
   Margin 3-95
   Numbers 3-98
   Alter (see Edit)
Area
   (see Box)
   Shade 3-162
Arithmetic (see Calculate)
Arrow Keys 3-40
Auto Save 3-252
   Recover Document 3-252
Automatic Format Detection 3-245
Block Cut Text 3-146
Bold Text 3-167
Bookmark 3-207
   Create 3-39
   Enter 3-207
   Find 3-39
   Return To 3-208
Box
   Delete 3-161
   Draw 3-159, 3-160
   Format Text 3-110
   Shade 3-162
Break Page 3-44
Browse Non-Uniplex Document 3-245
Calculate
   Numbers 3-193
   Range 3-194
   Capitals (see Case)
Case Convert
   Block 3-120
   Text 3-119
Center
   Around a Point 3-98
   Line 3-116
   Text 3-96
Change
   Bar 3-83
   Font Command 3-265
   Line Spacing
   Pre-styled Documents 3-211
   Ruler (see Edit)
Character Delete 3-52
Check
   Effect 3-171
   Spelling 3-58
Clear Document 3-243
Clipboard
   Select 3-153
   View Contents 3-154
Column 3-106
   Align Numbers 3-98
   Align Text 3-107
   Enter 3-107
Column and Row Counter 3-249
Command
   Abandon Global 3-218
   Hints 3-253
   Menu
   Access 3-34
   Access Character 3-254
   Cursor Wrap 3-254
   Select Option 3-35
Merge
   Print Time 3-156
   Result 3-157
   Printer 3-82
   Repeat 3-172
   Undo 3-57
Comment (see Remark)
Conditional Page Break 3-212
Print to Screen 3-84
Word Processor

Contents (see Table of Contents)
Convert Text 3-119
  Block 3-120
  Lower Case 3-119
  Upper Case 3-119
Copy
  Document 3-77
  Text 3-147
Correct Spelling 3-62
Create
  Document 3-29
  Supplementary Dictionary 3-70
  Temporary Margin 3-105
Cursor
  Keys 3-40
  Move 3-37
  Set Wrapping 3-257
  Wrap 3-43
Cut
  Append 3-151
  Blank 3-151
  Leave 3-151
  Remove 3-151
  Text 3-151
    Block 3-146
    Serial 3-146
  Write 3-151
Cut and Paste 3-146
DEL(ete) Key 3-52
Delete
  Blank Lines 3-54
  Box 3-161
  Character 3-52
  Footer 3-126
  Header 3-126
  Line 3-53
  Sentence 3-55
  Text 3-52
    Block 3-56
      Left of Cursor 3-55
      Right of Cursor 3-54
  Word 3-53
Dictionary
  Add Spelling Word 3-60

Dictionary (continued)
Language 3-58
  Change 3-64
  Set Hyphenation Breaks 3-73
  Supplementary 3-58
  Change 3-66
  Create 3-70
  Update 3-71
Direction Arrows 3-40
Display
  Print to Screen 3-84
Document
  Browse Non-Uniplex 3-245
  Clear 3-243
  Copy 3-77
  Create 3-29
  Edit 3-36
    Another 3-244
  Exit 3-76
  Format
    Edit Details 3-79
    Turn Off 3-82
    Update Details 3-81
Merge
  Editing 3-155
  Print Time 3-156
  Offset 3-157
Move Within 3-38
Name 3-74
Non-Uniplex
  Export 3-246
  Import 3-246
  Pre-styled
    Description 3-78
    Print 3-82
    Preview Mode 3-84
    Quit 3-76
Sentence 3-55
  Reformat 3-114
  Save 3-74, 3-75, 3-76
  Spell Check 3-62
  Double Ruler 3-112
Draw
  Box 3-159, 3-160
  Line 3-164
  Mode 3-164
Duplicate-Hard

INDEX

Word Processor

Duplicate (see Copy)

Edit
  Document 3-36
  Another 3-244
  Format Details 3-79
  Font Command 3-265
  Ruler 3-100

Effect
  Check 3-171
  Index 3-223
  Options 3-166
  Table of Contents 3-235
  Text 3-166, 3-167
  Text Block 3-169
  Turn Off 3-170
  Word 3-168

Elbow Text 3-153

Emphasize (see Effect)

End
  Line 3-44
  Page 3-44
  Paragraph 3-44

Erase (see Delete)

Exit Document 3-76

Exit and Save 3-76

Export
  Non-Uniplex Document 3-246

File (see Document)

Fill (see Shade)

Find (see Search)

Find Synonym 3-180

Find Text
  Print to Screen 3-87

Font
  Change 3-265
  Point Size 3-262
  Predefined Names 3-265
  Reset 3-266
  Select 3-263
  Selection 3-265
  Style 3-262
  Typeface 3-262
  Use 3-262

Footer 3-123
  Delete 3-126
  Margin 3-128
  Set 3-124
  Footnote 3-196
  Marker
    Effects 3-202
    Enter 3-196
  Numbering Style 3-199
  Position 3-203
  Text
    Delete 3-199
    Enter 3-197

Format
  (see also Reformat)
  Boxed Text 3-110
  Columnar Text 3-109
  Text 3-93

Formfill
  Replace 3-189

Generate
  Index 3-229
  Table of Contents 3-239

Global
  Abandon Command 3-218
  Replace 3-188

Glossary 3-182

Add Entry 3-183
  Create 3-183
  Insert Entry
  Print Time 3-185
  While Editing 3-184

Goto
  Print to Screen 3-87

Graphic
  Merge 3-158

Hang Paragraph

Hard
  Character 3-122

3-285
Word Processor

Hard (continued)
- Return 3-44, 3-248
- Space 3-122
- Tab 3-122
- Header 3-123
- Delete 3-126
- Margin 3-127
- Set 3-124
- Help Access 3-6
- Hints
  - Display on Screen 3-253

Hyphenation
- Automatic 3-249
- Dictionary 3-73
- Manual 3-250
- Set Breaks 3-73
- Supplementary Dictionary 3-73

Import
- Non-Uniplex Document 3-246

Indent First Line

Paragraph 3-97

Index 3-219

Entry
- Add 3-220
- Edit 3-228
- Effect 3-223
- Inverse 3-222
- Secondary 3-222
- Generate 3-229
- Multiple 3-224
- Numbering Style 3-226
- Plan 3-219
- Information Lines 3-30

Insert
- (see Add)
- (see also Paste)
- Blank
  - Line 3-48
  - Lines 3-49
- Mode 3-49
- Operating Mode 3-248
- Space 3-47
- Text 3-47, 3-152
- Integrate (see Merge)

Interactive Replace 3-188
- Italicize Text 3-167
- Join Lines 3-118
- Justify Margin 3-95
- Language Dictionary 3-58
- Change 3-64
- Leave (see Quit)
- Letter (see Document)
- Line
  - Blank
  - Delete 3-54
  - Insert 3-48, 3-49
  - Center 3-116
  - Delete 3-53
  - Draw 3-164
  - End 3-44
  - Join 3-118
  - Right Align 3-116
  - Spacing 3-209
  - Pre-styled Document 3-211
  - Split 3-117
  - Locate (see Search)

Mail Merge 3-267
- Access Menu 3-268
- Address File
  - Add Address 3-271
  - Create 3-269
  - Edit 3-281
  - Run 3-277
  - Run Interactive 3-279
- Standard Letter
  - Create 3-271
  - Format 3-274

Margin
- Align 3-95
- Center 3-96
- Hang First Line 3-97
- Hang First Word 3-96
- Indent First Line 3-97
- Justify 3-95
- Ragged 3-94
- Temporary Left 3-105
Memo-Paragraph

INDEX

Word Processor

Memo (see Document)
Merge
Command
Print Time 3-156
Result 3-157
Document
Editing 3-155
Print Time 3-156
Offset 3-157
Graphics 3-158
Mode
(see also Operating Mode)
Document Preview 3-84
Draw 3-164
Insert 3-49
Overtypen 3-49
Tab 3-251
Modify (see Edit)
Move
Cursor 3-37
Text 3-149
To Bookmark 3-39
To Page 3-39
Within
Document 3-38
Page 3-40
Paragraph 3-39
Screen 3-42
Sentence 3-38
Multiple Column (see Column)
Name Document 3-74
Number 3-130
Align Column 3-98
Calculate 3-193
Footnote 3-199
Force Page 3-137
Force Paragraph 3-143
Page 3-134
Paragraph 3-138
Section 3-131
Style 3-130
Index 3-226
Table of Contents 3-237

On-line Help 3-6
Operating Mode 3-248
Align Multiple Columns 3-254
Auto Save 3-252
Command
Hints 3-253
Menu Access 3-254
Cursor Wrap 3-254, 3-257
Hard Returns 3-248
Hyphenation
Automatic 3-249
Manual 3-250
Insert Mode 3-248
Position Marker 3-249
Reformat Text 3-251
Save Permanently 3-257
Set 3-255
Style Information 3-255, 3-257
Tab Mode 3-251
Overlay Text 3-153
Overtypen Mode 3-49
Page
Break 3-44
Conditional Break 3-212
End 3-44
Length 3-144
Move To 3-39
Move Within 3-40
Number 3-134
Force 3-137
Paragraph
End 3-44
Hang
First Line 3-97
First Word 3-96
Hyphenate
Automatically 3-249
Manually 3-250
Indent First Line 3-97
Keep Together 3-212
Move Within 3-39
Number 3-138
Force 3-143
Reformat 3-113

3-287
INDEX

Paste
Paste-Screen

Word Processor

Paste
Elbow 3-153
Insert 3-153
Overlay 3-153
Text 3-152
Pitch
Change Ruler 3-216
Point Size 3-262
Position Marker
Operating Mode 3-249
Pre-styled Document
Description 3-78
Format Details 3-81
Edit 3-79
Line Spacing 3-211
Print 3-82
Predefined Font Names 3-265
Preview Mode 3-84
Print
Document 3-78
Format 3-82
Pre-styled 3-82
Preview Mode 3-84
Save Information 3-78
To Screen 3-84
Print to Screen
Find 3-87
Goto 3-87
Move 3-86
Printer Command 3-82
Send 3-82
Quit Document 3-76
Read Non-Uniplex Document 3-245
Redraw Screen 3-57
Reformat 3-113, 3-251
(see also Format)
Columnar Text 3-109
Document 3-114
Paragraph 3-113
Start 3-114
Stop 3-114
Text 3-113
Automatically 3-251
Refresh (see Redraw)
Remark 3-205
Remove (see Delete)
Repeat
Command 3-172
Search 3-192
Replace
Formfill 3-189
Global 3-188
Interactive 3-188
Options 3-188
Search 3-189
Report (see Document)
Return
Hard 3-44
Revise (see Edit)
Right Align Line 3-116
Ruler 3-93
Characters 3-93
Column 3-107
Customize 3-100
Double 3-112
Initial 3-78
List 3-99
Pitch Change 3-216
Pre-styled Document 3-78
Preset 3-99
Save
Permanent 3-104
Temporary 3-103
Use 3-99
Save
Document 3-74, 3-75, 3-76
Automatically 3-252
Exit 3-76
Printer Information 3-78
Rule
Permanent 3-104
Temporary 3-103
Scratchpad (see Clipboard)
Screen
Explanation 3-30
Move Within 3-42
Print To 3-84
Screen-Undo

INDEX

Word Processor

Screen (continued)
  Redraw 3-57
  Split 3-259
Scroll Text 3-42
Search
  Procedures 3-189
  Quick 3-192
  Repeat 3-192
  Specify Case 3-187
  Text 3-189
Section Number 3-131
Send Printer Command 3-82
Sentence
  Delete 3-55
  Move Within 3-38
  Serial Cut 3-146
  Shade Area 3-162
  Softkey Menu 3-32
  Space
    Hard 3-122
    Insert 3-47
  Spelling 3-58
    Change
      Language Dictionary 3-64
      Supplementary Dictionary 3-66
  Check
    Document 3-62
    Remainder 3-63
    Text Block 3-63
Dictionary
  Add Word 3-60
  Language 3-58
  Supplementary 3-58
Options 3-59
  Quit 3-60
  Replace Word 3-59
  Restart 3-68
  Skip Word 3-59
  Stop 3-68
Split
  Line 3-117
  Screen 3-259
Standard Letter 3-271, 3-274
Status Line 3-30
Store (see Save)

Style 3-262
  Number 3-130
  Supplementary Dictionary 3-58
    Change 3-66
    Create 3-70
    Set Hyphenation Breaks 3-73
    Update 3-71
    Synonym 3-180
Tab
  Hard 3-122
  Mode 3-251
Table of Contents 3-232
  Add Entries 3-233
  Entry
    Edit 3-239
    Effect 3-235
    Primary 3-233
    Secondary 3-234
    Generate 3-239
    Multiple 3-236
    Numbering Style 3-237
    Plan 3-232
Text
  Add 3-43
  Area 3-32
  Change Width 3-216
  Delete 3-52
    Block 3-56
    Left of Cursor 3-55
    Right of Cursor 3-54
  Effect 3-166
  Enter 3-43
  Format 3-93
  Insert 3-47
  Reformat 3-113
  Scroll 3-42
  Thesaurus 3-177
  Tutorial (see Worked Example)
  Typeface 3-262
  Underline Text 3-167
  Undo Command 3-57
Word Processor

Update
   Document Format Details  3-81
   Supplementary Dictionary  3-71

Width
   Change Text Area  3-216
Window  3-259
   Close  3-261
   Open  3-259
   Switch  3-261
Word
   Delete  3-53
   Wrap  3-43
Work (see Document)
Worked Example  3-9
Chapter 4
Sketch Pad
# Sketch Pad

## Overview
- Example ........................................................................................................... 4-2
- Access the Sketch Pad .................................................................................. 4-3
- Access Help .................................................................................................... 4-3

## Use the Sketch Pad
- The Screen ........................................................................................................ 4-4
- Move around the Screen ................................................................................ 4-6
- Modes of Operation ....................................................................................... 4-7
- Change Stylus .................................................................................................. 4-8
- Draw Boxes ....................................................................................................... 4-9
- Use Text ............................................................................................................ 4-10
  - Text Effects .................................................................................................. 4-10
- Text and Graphics Priorities .......................................................................... 4-12
- Edit a Sketch .................................................................................................... 4-13
- Edit Lines .......................................................................................................... 4-13
- Arrange Sketches on the Screen ..................................................................... 4-13
- Cut and Paste a Sketch .................................................................................. 4-15
- Save a Sketch .................................................................................................. 4-16

## Index
- ......................................................................................................................... 4-17
Overview

Sketch Pad works in a similar way to a normal drawing pad. You can use Sketch Pad to make simple sketches, or to draw complex diagrams.

You can use Sketch Pad to:

- Draw Flow Charts
- Illustrate Concepts
- Design Plans

With Sketch Pad you can:

- Draw Outline or Solid Boxes
- Add Text to Sketches
- Use 10 Line and Shading Styles
- Transfer Sketches to Other Uniplex Applications
- Print Sketches
- Mail Sketches

An example of a drawing made with Sketch Pad is shown on the next page.
Overview

Example

Company Structure

Company President

Sales  Production  Finance

Floorplan

Bedroom 1  Bathroom  Master Bedroom

Bedroom 2  Hallway

Bedroom 3
Access the Sketch Pad

You can access Sketch Pad from the Main menu or any Uniplex application.

To access Sketch Pad from the Main menu:

1. Pick and point the Sketch Pad option.

Uniplex displays the Sketch Pad screen.

To access Sketch Pad from any Uniplex application:

1. Press **ESC xd** or F9.

   Uniplex displays the popup Desk Options.

2. Pick and point the Next Page option.

3. Pick and point the Sketch Pad option.

   Uniplex displays the Sketch Pad.

Access Help

You can access on-line help at any time while you are using the Sketch Pad. To do this:

1. Press **ESC h** while you are working with the Sketch Pad.

2. Pick and point the help topic you require.

   Uniplex displays one, or several, screens of help about the topic you specified.

To return to your task, press **ESC q**.
Use the Sketch Pad

The Screen

Sketch Pad uses an area 100 lines long and 160 columns wide. You cannot see the whole Sketch Pad at one time. The screen acts like a window showing a portion of the Sketch Pad.

You can move around easily to use and view the whole area. See the section Move Around the Screen.

The Sketch Pad screen appears as follows:
The screen displays the following information:

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line/Column Counter</strong></td>
<td>The pair of numbers in the top right of the screen indicate the line and column position if the cursor. This is useful when you are using a large area of the Sketch Pad. For example, if you are in the twentieth column and the eighth line, the counter reads 8:20.</td>
</tr>
<tr>
<td><strong>Text/Graphics Priority</strong></td>
<td>To the left of the Line/Column counter a message indicates whether text or graphics take priority. See the section Text and Graphics Priorities later in this chapter.</td>
</tr>
<tr>
<td><strong>Modes</strong></td>
<td>Towards the center of the top line, the current mode of the program is highlighted. Sketch Pad works in draw, move, or delete mode. See the section Modes of Operation later in this chapter.</td>
</tr>
<tr>
<td><strong>Stylus</strong></td>
<td>The stylus that you are currently working with is displayed in the top left corner of the screen. The default stylus is a regular thin line.</td>
</tr>
<tr>
<td><strong>Type Effect</strong></td>
<td>If you have set any text effect, Uniplex displays its name here.</td>
</tr>
<tr>
<td><strong>Softkeys</strong></td>
<td>A softkey menu is displayed at the bottom of the screen. This lets you use the different facilities of Sketch Pad.</td>
</tr>
</tbody>
</table>
Use the Sketch Pad

Move around the Screen

If you are working with a large area of the Sketch Pad, you can only see a portion of it at a time on the screen.

You can use the cursor keys, and other Sketch Pad commands to move around the screen and view different portions of it as follows:

<table>
<thead>
<tr>
<th>Task</th>
<th>Key Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up a line.</td>
<td>CTRL y</td>
</tr>
<tr>
<td>Down a line.</td>
<td>CTRL v</td>
</tr>
<tr>
<td>One character up.</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>One character down.</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>One character left.</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>One character right.</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Up a page.</td>
<td>ESC ESC Up Arrow</td>
</tr>
<tr>
<td>Down a page.</td>
<td>ESC ESC Down Arrow</td>
</tr>
<tr>
<td>Left a page.</td>
<td>ESC ESC Left Arrow</td>
</tr>
<tr>
<td>Right a page.</td>
<td>ESC ESC Right Arrow</td>
</tr>
<tr>
<td>To top of pad.</td>
<td>ESC t</td>
</tr>
<tr>
<td>To bottom of pad.</td>
<td>ESC b</td>
</tr>
<tr>
<td>To start of previous word.</td>
<td>CTRL p</td>
</tr>
<tr>
<td>To end of next word.</td>
<td>CTRL n</td>
</tr>
</tbody>
</table>

Use the column/row counter in the top right corner of the screen to keep track of where you are on the screen.
Modes of Operation

You can use the Sketch Pad in three different ways or modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move</td>
<td>Moves the cursor only.</td>
</tr>
<tr>
<td>Draw</td>
<td>Draws on the screen.</td>
</tr>
<tr>
<td>Erase</td>
<td>Erases graphics.</td>
</tr>
</tbody>
</table>

To change mode, press the softkey labeled MODE +. Alternatively, you can use the following commands:

Press **ESC op+** to change to the next mode
Press **ESC op-** to change to the previous mode

✎ To get to the mode you want to use, you may need to press the Mode + softkey, or ESC op+ twice in succession.

The current mode is highlighted at the top of the screen.

You can use all four cursor keys to either move, draw or erase.

When you are in *draw* mode, moving the cursor draws a line on the screen.

When you are in *move* mode, the cursor moves around the screen without affecting existing graphics or text.

When you are in *erase* mode, the cursor deletes any existing graphics.

✎ It is recommended that you use Move mode whenever you use any of Sketch Pad’s special facilities, for example formatting or drawing boxes.
Use the Sketch Pad

Change Stylus

Sketch Pad lets you draw using 10 different types of line, or stylus.

By default, Sketch Pad draws with a regular thin line.

Sketch Pad displays the current stylus in the top left corner of the screen.

To change the Stylus, press the Stylus+ or Stylus- softkeys. Alternatively, you can use the following commands:

Press ESC <-> to scroll forwards through the choices.

Press ESC <-> to scroll backwards.

When the stylus that you want to use is displayed in the top corner of the screen, you can start to use it.

The styles that are available depend on the way both your terminal and your printer have been configured. Talk to your System Administrator about this.

Here are some examples of the types of lines you can use:

You can use these lines to draw outlines of boxes as well as to shade solid boxes.

If you are using a character terminal that is not able to display colors you will see a suitable representation. This is normally a non-alphabetic character displayed in reverse video (e.g., ==== $$$$$ %%%% +++++). The printed output will depend on the graphics capabilities of your printer.
**Draw Boxes**

As well as drawing directly on the screen using the cursor keys, Sketch Pad has special facilities which let you draw outlines of boxes, or solid boxes.

To draw a box:

1. Make sure that you are in Move mode.
2. Move to the top left corner of the area you want to box.
3. Press the Box softkey, and follow the instructions on the screen to mark the beginning of the area you want to box. Alternatively, press `ESC` (.
4. Move to the bottom right corner of the area you want to box.
5. If you are using softkeys, follow the instructions on the screen to mark the bottom corner of the area. Alternatively, press `ESC `).
6. Use the softkeys to produce a filled box, using the current stylus. Follow the instructions at the bottom of the screen. Alternatively, you can use the following commands:

   * draws an outline box around the area you have indicated
   c- blanks out the area you have indicated
   cs draws a solid box

You can use the different types of lines to fill in boxes. You can create different effects as in these examples:

![Available effects depend on both your terminal and your printer configuration.](image)
Use the Sketch Pad

Use Text

You can add text to any part of the diagram. In addition, you can superimpose text over lines or superimpose lines over text.

You can add text while Sketch Pad is in any of its three modes.

Enter text as if you were using the word processor.

You can use text within boxes, or as labels:

Text inside a box

Text outside a box

Text Effects

You can use the same text effects as are set up for your version of the word processor. For example, you can use **bold** and *underline*.

To switch a print effect on:

- Press `ESC < character`

  where `character` defines a particular print effect.

  For example `ESC <A` prints in **bold**.
Use the Sketch Pad

You can use any of the following print effects:

<table>
<thead>
<tr>
<th>Effect Letter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Bold font</td>
</tr>
<tr>
<td>B</td>
<td>Bold font</td>
</tr>
<tr>
<td>C</td>
<td>Underline all</td>
</tr>
<tr>
<td>D</td>
<td>Underline Text</td>
</tr>
<tr>
<td>E</td>
<td>Bold &amp; Underline</td>
</tr>
<tr>
<td>G</td>
<td>Small font</td>
</tr>
<tr>
<td>H</td>
<td>Large font</td>
</tr>
<tr>
<td>I</td>
<td>Italic font</td>
</tr>
<tr>
<td>J</td>
<td>Superscript</td>
</tr>
<tr>
<td>K</td>
<td>Subscript</td>
</tr>
<tr>
<td>M</td>
<td>Double underline</td>
</tr>
<tr>
<td>N</td>
<td>Double underline text</td>
</tr>
<tr>
<td>O</td>
<td>Ps-Small font</td>
</tr>
<tr>
<td>P</td>
<td>PS-Normal font</td>
</tr>
<tr>
<td>Q</td>
<td>FX-Small font</td>
</tr>
<tr>
<td>R</td>
<td>FX-Normal font</td>
</tr>
<tr>
<td>S</td>
<td>Normal font</td>
</tr>
<tr>
<td>T</td>
<td>Shaded overstrike</td>
</tr>
<tr>
<td>U</td>
<td>Strikeout slash</td>
</tr>
<tr>
<td>V</td>
<td>Strikeout dash</td>
</tr>
<tr>
<td>X</td>
<td>Index leader effect</td>
</tr>
<tr>
<td>I</td>
<td>Graphics font</td>
</tr>
</tbody>
</table>

To switch a print effect off:

- Press **ESC >**
Use the Sketch Pad

Text and Graphics Priorities

With Sketch Pad you can put text and graphics in the same space. For example you can enter some text on a solid box. You must indicate to Sketch Pad which has priority; text or graphics.

When text has priority, you can see the text displayed. When graphics has priority, you cannot see the text, only the solid box. Both are stored by Sketch Pad. The priority governs what you can see.

To change the priority:

- Press ESC <!

  The current priority status is displayed at the top of the screen.

The text/graphics priority affects the following operations:

- **Displaying**
  - If text and graphics occupy the same space, only one can be displayed on your terminal.
    - To display text, set the priority to text.
    - To display graphics, set the priority to graphics.

- **Printing**
  - If text and graphics occupy the same space, only one can be printed. Set the priority you want before you save the file.

- **Formatting**
  - When you arrange diagrams on the screen, you need to set text and graphics priorities according to the effect you want to achieve. See the section Arrange Sketches on the Screen for more details.
**Edit a Sketch**

Sketch Pad has editing facilities which let you make changes to your sketches. You can insert and delete lines, vertically and horizontally as follows:

<table>
<thead>
<tr>
<th>Task</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete character to left.</td>
<td>DEL/RUBOUT</td>
</tr>
<tr>
<td>Delete current character.</td>
<td>CTRL c</td>
</tr>
<tr>
<td>Delete a line.</td>
<td>CTRL x</td>
</tr>
<tr>
<td>Insert a line.</td>
<td>CTRL o</td>
</tr>
<tr>
<td>Insert a space.</td>
<td>CTRL e</td>
</tr>
</tbody>
</table>

**Edit Lines**

You can insert or delete lines horizontally or vertically. Press the Edit softkey, then follow the prompts on the screen.

With horizontal lines you can:

- Insert or delete a line above or below the current cursor position

With vertical lines you can:

- Insert or delete a line to the right or left of the current cursor position.

**Arrange Sketches on the Screen**

Sketch Pad lets you format sketches. You can:

- Format Graphics and Text
- Align Text or Graphics to the Left
- Align Text or Graphics to the Right
- Center Text or Graphics
Use the Sketch Pad

You need to select the area within which you want the sketch to be formatted. To do this:

1. Make sure you are in Move mode.

2. Move the cursor to the left edge of the area you want to format. You can either move the cursor with the arrow keys, or you can press \texttt{CTRL p}.

   If you press \texttt{CTRL p}:
   
   If text has priority the cursor moves to the start of the previous word. If graphics have priority, the cursor moves to the start of the previous graphics block on that line.

3. Press the Format softkey.

4. Move the cursor to the right edge of the area you want to format. You can move the cursor with the arrow keys, or by pressing \texttt{CTRL n}.

   If you press \texttt{CTRL n}, Text/Graphics priorities work in the same way as described in the last paragraph. If text has priority, the cursor moves to the end of the next word. If graphics has priority, the cursor moves to the end of the next graphics block on that line.

Now that you have selected the area within which you want to format your work, you can use the softkeys to center your graphics or text, or align your work to the right or left. Follow the instructions at the bottom of the screen or use these commands:

<table>
<thead>
<tr>
<th>Task</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center graphics/text.</td>
<td>\texttt{CTRL f c} (or \texttt{ESC c})</td>
</tr>
<tr>
<td>Align graphics/text to left.</td>
<td>\texttt{CTRL f p}</td>
</tr>
<tr>
<td>Align graphics/text to right.</td>
<td>\texttt{CTRL f r}</td>
</tr>
</tbody>
</table>
Cut and Paste a Sketch

You can cut and paste a sketch. You can move a sketch to another portion of the Sketch Pad, or transfer it to another Uniplex application.

To move a sketch to another area of the Sketch Pad:

1. Press the Block softkey, then follow the instructions at the bottom of the screen to mark the beginning of the sketch. Alternatively, press ESC (.

2. Move to the end of the area that you want to use.

3. Follow the instructions at the bottom of the screen to mark the end of the block. Alternatively, press ESC )r.

4. Move to the area of the Sketch Pad where you want the sketch to be placed.

5. Press the Paste softkey to paste in the sketch. Alternatively, press ESC *o.

To transfer a sketch to another Uniplex application:

1. Press the Block softkey, then follow the instructions at the bottom of the screen to mark the beginning of the sketch. Alternatively, press ESC (.

2. Move the cursor to the end of the area.

3. Follow the instructions on the screen to write the block to another file, or attach the block to another file.

   Alternatively, press ESC )w to write the block to another file or press ESC )a to attach the block to another file.
Use the Sketch Pad

Sketch Pad prompts for the name of the file. Enter either the name of a new file, or a file which already exists, if you are attaching a file.

◊ Save a Sketch

You can store work you do with Sketch Pad in the same way as any other Uniplex file:

<table>
<thead>
<tr>
<th>Task</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save and exit.</td>
<td>ESC e</td>
</tr>
<tr>
<td>Save and continue work.</td>
<td>ESC w</td>
</tr>
<tr>
<td>Quit without saving.</td>
<td>ESC q</td>
</tr>
<tr>
<td>Save to named file.</td>
<td>ESC s x</td>
</tr>
<tr>
<td>Read a file.</td>
<td>ESC m o</td>
</tr>
</tbody>
</table>

4-16
Access
  Help 4-3
  Sketch Pad 4-3
Add Text 4-10
Align
  Left 4-14
  Right 4-14
Arrange (see Format)
Bold Text 4-10
Box Draw 4-9
Center Graphics/Text 4-14
Change
  Priority 4-12
  Stylus 4-8
Cut and Paste Sketch 4-15
Delete Mode 4-7
Draw
  Box 4-9
  Mode 4-7
Edit
  Line 4-13
  Sketch 4-13
Effect Text 4-10
Erase Mode 4-7
Format Sketch 4-13
Graphics and Text Priority 4-12
Help (see On-line Help)
Italic Text 4-10
Left Align 4-14
Line Edit 4-13
Mode
  Change 4-7
  Draw 4-7
  Erase 4-7
  Move 4-7
Move
  Around Screen 4-6
  Mode 4-7
On-line Help 4-3
Paste Sketch 4-15
Priority
  Change 4-12
  Text and Graphics 4-12
Right Align 4-14
Save Sketch 4-16
Screen 4-4
  Move Around 4-6
  Stylus Change 4-6
Text
  Add 4-10
  Effect 4-10
  Text and Graphics Priority 4-12
  Transfer Sketch 4-15
Underline Text 4-10